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Precautions on the CAM Care

� Do not place your device in a wet place. Moisture and water may
cause the device to malfunction.

� To avoid electric shock, do not touch your device or power cable
with wet hands.

� Do not use the flash close to another’s eyes. The flash emits a
strong light that may cause damage similar to direct 
sunlight on one’s eyesight. Particular care should be observed if
photographing infants, when the flash should be no less 
than 3 feet from your subject.

� If the device is not working properly, please consult your nearest
dealer or authorized Samsung service facility.
Disassembling the device yourself may cause irrecoverable
damage which will be difficult to repair.

� Clean the device with a dry, soft cloth. Use a soft cloth moistened
with a mild detergent solution for removing stains. 
Do not use any type of solvent, especially benzene, as they may
seriously damage the finish.

� Keep your device away from rain and saltwater. After using, clean
the device. Saltwater may cause the parts to corrode.

✤ Please note the following precautions for use:
✤ Please keep this device in a safe place. 

The device contains a lens that can be damaged by shock. 
Keep away from the reach of the children.

Avisos y precauciones de seguridad

Precauciones sobre el cuidado de la CAM

� No coloque el dispositivo en lugares con humedad. La humedad y
el agua pueden provocar una avería en el dispositivo.

� Para evitar descarga eléctrica, no toque el dispositivo ni el cable
de alimentación con las manos mojadas.

� No utilice el flash cerca de los ojos. El flash emite una potente luz
que puede provocar daños semejantes a la emisión de luz solar
directa sobre los ojos. Especial cuidado debe prestarse al
fotografiar a los niños cuando el flash se encuentre a una distancia
menor de un metro del sujeto.

� Si el dispositivo no está funcionando correctamente, póngase en
contacto con el distribuidor más cercano o con el servicio técnico
autorizado de Samsung.
El desmontaje del dispositivo puede provocar daños irreparables
que pueden resultar difíciles de reparar.

� Limpie el dispositivo con un paño seco y suave. Utilice un paño
suave humedecido con una solución de detergente suave para
eliminar manchas.
No utilice ningún tipo de disolvente, especialmente benceno, ya
que podría dañar seriamente el acabado.

� Mantenga el dispositivo alejado de la lluvia y el agua marina.
Después de utilizarlo, límpielo. El agua marina puede provocar la
corrosión de los componentes.

✤ Tenga en cuenta las siguientes precauciones de uso:
✤ Mantenga este dispositivo en un lugar seguro. 

El dispositivo contiene un lente que puede dañarse al recibir golpes.
Manténgalo fuera del alcance de los niños.
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1. A sudden rise in atmospheric temperature may cause
condensation to form inside the CAM.

For Example:
✤ Entering or leaving a heated place on a cold day might cause

condensation inside the product.
✤ To prevent condensation, place the product in a carrying case or

a plastic bag before exposing it to a sudden change of 
temperature.

✤ Television programs, movie video tapes, DVD titles, films and
other program materials may be copyrighted. 
Unauthorized recording of copyrighted materials may infringe on
the rights of the Copyright owners and is contrary to copyright laws.

✤ All the trade names and registered trademarks mentioned in this
manual or other documentation provided with your 
Samsung product are trademarks or registered trademarks of
their respective holders.

Notes Regarding the CAM

Notes Regarding COPYRIGHT

Notes Regarding Moisture Condensation

1. Do not leave the CAM exposed to high temperature 
(above 60°C or 140°F).
For example, in a parked closed car in summer or exposed to
direct sunlight.

2. Do not let the CAM get wet. 
Keep the CAM away from rain, salt water, or any other form
of moisture. 
The CAM will be damaged if immersed in water or subjected to
high levels of moisture.

Avisos y precauciones de seguridad

1. Una subida repentina de la temperatura puede producir
condensación en el interior de la CAM.

Por ejemplo:
✤ Entrar o salir de un lugar caluroso en días de frío podría causar

condensación dentro del aparato.
✤ Para evitar condensación, coloque el aparato en su funda de

transporte o en una bolsa de plástico antes de exponerlo a un
cambio repentino de temperatura.

✤ Es probable que los programas de televisión, las cintas de video de
películas, los DVD, las películas y otros materiales audiovisuales
tengan registrados sus derechos de reproducción.
La grabación no autorizada de material con derechos de
reproducción puede infringir los derechos de los propietarios con
Copyright y es contraria a las leyes de propiedad intelectual.

✤ Todos los nombres de marcas y marcas comerciales registradas
mencionados en este manual o el resto de documentación facilitada
con el producto Samsung son marcas comerciales o marcas
registradas de sus respectivos propietarios.

Notas referentes a la CAM

Notas referentes a los DERECHOS DE REPRODUCCIÓN

Notas referentes a la condensación de humedad

1. No deje la CAM expuesta a temperaturas altas 
(más de 60° C o 140° F).
Por ejemplo, en un coche estacionado y cerrado en verano o
expuesta directamente a la luz del sol.

2. No permita que la CAM se moje.
Mantenga la CAM alejada de la lluvia, del agua marina o de
cualquier otro tipo de humedad.
La CAM se dañará si se sumerge en agua o se expone a altos
niveles de humedad.
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Notes Regarding the Battery Pack
✤ It is recommended to use original battery pack that is available at

SAMSUNG service center.
✤ Make sure the battery pack is fully charged before starting to record.
✤ To preserve battery power, keep the CAM turned off when you are

not operating it.
✤ If your device is left in STBY mode without being operated for

more than 5 minutes, it will automatically turn itself off to protect
against unnecessary battery discharge.

✤ Make sure that the battery pack is attached firmly in place.
✤ The new battery pack provided with the product is not charged.

Before using the battery pack, you need to fully charge it.
✤ Do not drop the battery pack. Dropping the battery pack may

damage it.
✤ Fully discharging a Lithium Polymer battery damages the internal

cells. The battery pack may be prone to leakage when fully
discharged.

✤ To avoid damage to the battery pack, make sure to remove the
battery when no charge remains.

✤ Clean the terminal to remove foreign substance before inserting
the battery pack.

Notes Regarding a Trademark
✤ The logos regarding DivX, DivX Licensed are the trademark of

DivX, Network, Inc and can be used after contracting license.

✳ When the battery reaches the end of its life, please contact your
local dealer.
Batteries must be disposed of as chemical waste.

✳ Be careful not to drop the battery pack when you release it from
the CAM.

Avisos y precauciones de seguridad

Notas referentes a la batería
✤ Se recomienda utilizar la batería original que está disponible en el centro

de servicio técnico de SAMSUNG.
✤ Asegúrese de que la batería esté completamente cargada antes de

empezar a grabar.
✤ Para ahorrar energía de la batería mantenga la CAM apagada cuando no

la esté usando.
✤ Si el dispositivo se deja en modalidad STBY sin que funcione por más de 

5 minutos, se apagará automáticamente para evitar una descarga
innecesaria de la batería.

✤ Asegúrese de que la batería esté colocada correctamente en su sitio.
✤ La nueva batería que se suministra con el producto no está cargada.

Antes de utilizar la batería es necesario cargarla por completo.
✤ No deje caer la batería. Si se llegara a caer, podría estropearse.
✤ Descargar completamente la batería de polímero de litio daña las células

internas. La batería puede ser más propensa a fugas cuando se deja
totalmente descargada.

✤ Para evitar daños en la batería, asegúrese de quitar la batería cuando no
le quede ninguna carga.

✤ Limpie el terminal para eliminar sustancias extrañas antes de insertar la batería.

Notas referentes a la marca comercial
✤ Los logotipos referentes a DivX, DivX Licensed son la marca

comercial de DivX, Network, Inc y se puede utilizar mediante
contratación de licencia.

✳ Cuando se termine la vida útil de la batería, póngase en contacto
con su proveedor habitual.
Debe deshacerse de las baterías del mismo modo que hace con
los residuos químicos.

✳ Tenga cuidado de no dejar caer la batería al separarla de la
CAM.
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1. The LCD monitor has been manufactured using the high
precision technology. However, there may be tiny dots 
(red, blue or green in color) that appear on the LCD monitor.
These dots are normal and do not affect the recorded picture in
any way.

2. When you use the LCD monitor under direct sunlight or outdoors,
it may be difficult to see the picture clearly. 

3. Direct sunlight can damage the LCD monitor.

✤ Do not film with the camera lens pointing directly at the sun.
Direct sunlight can damage the CCD (Charge Coupled Device,
the imaging sensor).

Note Regarding the Lens

Notes Regarding the LCD Display

✤ Do not attempt to service the CAM yourself.
✤ Opening or removing covers may expose you to dangerous

voltage or other hazards.
✤ Refer all servicing to qualified service personnel.

Precautions Regarding Service

Precautions Regarding Replacement Parts
✤ When replacement parts are required, be sure the service

technician has used replacement parts specified by the
manufacturer and having the same characteristics as the original
part.

✤ Unauthorized substitutions may result in fire, electric shock or
other hazards.

Avisos y precauciones de seguridad

1. Para la fabricación de la pantalla LCD se ha empleado tecnología
de alta precisión. Sin embargo, pueden aparecer en él puntitos
rojos, azules o verdes. Esta situación es normal y no afecta en
modo alguno a la grabación.

2. Si se emplea la pantalla LCD bajo la acción directa del sol o en
exteriores, es probable que resulte difícil ver la imagen con
claridad.

3. La acción directa del sol puede estropear la pantalla LCD.

✤ No grabe con el objetivo de la cámara dirigido directamente hacia el sol.
La acción de la luz directa del sol podría estropear el CCD (el dispositivo
acoplado por carga, el sensor de imágenes).

Nota referentes al objetivo

Notas referentes a la pantalla LCD

✤ No intente reparar la CAM por sí mismo.
✤ La apertura o retirada de cubiertas puede exponerle a serios

voltajes u otros peligros.
✤ Confíe las reparaciones a personal técnico calificado.

Precauciones referentes al servicio

Precauciones referentes a las piezas de repuesto
✤ Cuando se necesiten piezas de repuesto, asegúrese de que el

técnico utiliza piezas especificadas por el fabricante y que
tengan las mismas características que la pieza original.

✤ Los repuestos no autorizados pueden producir incendios,
descargas eléctricas u otros peligros.
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� Integrated Digital CAM/DSC operation
An integrated digital imaging device that easily converts between a Digital
CAM and a Digital Still Camera with comfortable and easy recording.

� High Resolution Image Quality (Digital Still Camera)
Employing 680K CCD Pixel, a maximum resolution of 800x600 is available.

� 100x Digital Zoom
Allows the user to magnify an image up to 100x its original size.

� Colorful TFT LCD
A high-resolution(210K) colorful TFT LCD gives you clean, sharp images as
well as the ability to review your recorded files immediately.

� Electronic Image Stabilizer (EIS)
With the CAM, you can reduce unstable images by avoiding natural shaking
movements.

� Various Digital Effects
The DSE (Digital Special Effects) allows you to give the film a special look
by adding various special effects.

� USB Interface for Data Transfer
You can transfer still images and video files or any other files to a PC using
the USB interface.  

� PC Cam for multi-entertaining 
You can use this the CAM as a PC camera for video chatting, video
conference and other PC camera applications. 

� Voice Record / Playback with vast memory
You can record voice and store it in the internal memory, Memory Stick and
Memory Stick Pro(Option) and play back the recorded voice.

� Plus Advantage, MP3
With the CAM, you can play back MP3 files stored in the internal 
memory, Memory Stick and Memory Stick Pro(Option).

� A Sports CAM equipped with External Camera Module
Equipped with External Camera Module, enjoying sports activity can be
directly recorded when connected to the main Miniket unit.

� Weatherproof (External Camera Module only)
The External Camera Module is weatherproof according to IP42 standard.
IP-Protection Level
4- The External Camera is protected against contact from solid objects over

1mm in diameter.
2- The External Camera is protected against water sprayed from a vertical

position above the center of camera top (Power LED facing up) at 15
degree angles.

Features

ENGLISH

Getting to Know Your CAM
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� Funcionamiento de la CAM/DSC digital integrada
Dispositivo de imagen digital integrada que convierte fácilmente una CAM
digital en una cámara fotográfica digital con una grabación cómoda y sencilla.

� Calidad de imagen de alta resolución (Cámara fotográfica digital)
Con el CCD Pixel de 680K, puede obtener una resolución máxima de
800x600.

� Zoom digital 100x
Permite al usuario ampliar la imagen hasta 100 veces su tamaño original.

� LCD TFT en color
El sistema de color de alta resolución TFT de la pantalla LCD (210 K)
proporciona imágenes claras y nítidas a la vez que permite ver los
archivos grabados inmediatamente.

� Estabilizador electrónico de la imagen (EIS)
Con la CAM, puede reducir las imágenes inestables evitando movimientos
temblorosos naturales.

� Efectos digitales diversos
Gracias al sistema DSE (Efectos especiales digitales) se puede dar a la
grabación un aire especial al permitir añadir diversos efectos especiales.

� Interfaz USB para transferencia de datos
Puede transferir imágenes fijas y archivo de video o cualquier otro tipo de
archivo a una PC utilizando la interfaz USB.

� PC Cam para multientretenimiento
Puede utilizar esta CAM como una cámara de PC para chat con video,
videoconferencia y otras aplicaciones de cámara en PC.

� Grabación de voz/Reproducción con una amplia memoria
Puede grabar voz y almacenarla en la memoria interna, en el Memory
Stick y en el Memory Stick Pro (opcional) y reproducir la voz grabada.

� Más ventajas, MP3
Con la CAM, puede reproducir los archivos MP3 almacenados en la
memoria interna, en el Memory Stick y en el Memory Stick Pro (Opcional).

� Una CAM deportiva equipada con un módulo de cámara externa.
Equipada con un módulo externo de cámara, es posible grabar
directamente la práctica de actividades deportivas al conectarse a la
unidad Miniket principal.

� Resistente al agua (sólo el módulo de cámara externa)
El módulo externo de cámara es impermeable y está en conformidad con
el estándar IP42.
Nivel de protección IP
4- La cámara externa está protegida frente a contacto de objetos sólidos

de más de 1 mm de diámetro.
2- La cámara externa está protegida contra agua pulverizada desde una

posición vertical por encima del centro de la parte superior de la cámara
(LED de encendido hacia arriba)) con un ángulo de 15 grados.

Características

Introducción a la CAM
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1. Lithium Polymer
Battery pack 

2. AC Power Adapter
3. Audio/Video Cable
4. USB Cable
5. Cradle
6. Earphones
7. Hand Strap 
8. Carrying Case
9. Instruction 

Book/Quick Guide
10. Software CD
11. Lens Cover
12. External Camera 

Module
13. Rubber Mount
14. Short Mount Band
15. Long Mount Band
16. Extension Cable
17. Alkaline Batteries   

(AAA x 2)
18. Velcro Strap
19. Extended life   

Battery Pack
(Option)

✤ Make sure that the following basic accessories are supplied
with your CAM.

Accessories Supplied with the CAM

Introducción a la CAM

1. Batería de polímero
de litio

2. Adaptador de CA
3. Cable de audio/video
4. Cable USB
5. Soporte
6. Audífonos
7. Empuñadura
8. Funda de transporte
9. Manual de

instrucciones 
/ Manual de consulta
rápida

10. CD de software
11. Tapa del objetivo
12. Módulo de cámara 

externa.
13. Montura de goma
14. Banda de montura

corta
15. Banda de montura

larga
16. Cable de extensión
17. Baterías alcalinas 

(2  baterías tamaño
AAA)

18. Correa de velcro
19. Extended life Battery

Pack (Option)

✤ Asegúrese de que los siguientes accesorios básicos le hayan
sido entregados junto con la CAM.

Accesorios incluidos con la CAM

3. Audio/Video Cable2. AC Power Adapter1. Lithium Polymer Battery pack

5. Cradle 6. Earphones

4. USB Cable

11. Lens Cover

18. Velcro Strap 19. Extended life Battery Pack
(Option)

10. Software CD 12. External Camera Module

13. Rubber Mount 14. Short Mount Band 15. Long Mount Band 16. Extension Cable

17. Alkaline Batteries (AAA x 2)

8. Carrying Case

9. Instruction Book/Quick Guide

7. Hand Strap 
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Rear & Left View

1. Built-in MIC
2. LCD display
3. DISPLAY button
4. MP3/External Camera  Hold

switch
5. Built-in Speaker
6. Back/Multi-Play Mode

button
7. [� ]switch

(Zoom out/RPS switch)

8. OK button (Play/Pause)
9. [� ]switch

(Zoom in/ FPS switch)
10. Record /Stop button
11. Record/Power /Charging

indicator
12. Power switch/Mode

Selector
13. Menu button
14. Memory Stick Slot

ENGLISH
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Location of Controls

1. Built-in MIC
7. Back(  ) / Left / Multi-Play Mode button

8. switch (Zoom out (W) / Rewind (   ) switch)

9. OK button(Play, Pause)

11. Record/Stop button

12. Power / Charging indicator

13. OFF switch / Mode Selector

14. Menu button

15. Memory Stick Slot

2. LCD Monitor

4. LCD(DISPLAY) button

5. MP3 LOCK switch

6. Built-in Speaker

1. Built-in MIC
6. Back/Multi-Play Mode button

7. [� ]switch (Zoom out/ RPS switch)

8. OK button (Play/Pause)

9. [� ]switch (Zoom in/ FPS switch)
10. Record/Stop button

11. Record/Power/Charging indicator

12. Power switch / Mode Selector

13. Menu button

14. Memory Stick Slot

2. LCD display

3. DISPLAY button

4. MP3/External Camera  Hold switch

5. Built-in Speaker

1. Micrófono incorporado
2. Pantalla LCD
3. Botón DISPLAY
4. Interruptor Hold de cámara

externa/MP3
5. Altavoz incorporado
6. Botón Atrás/Modalidad

Multi-Play
7. Interruptor [� ](Alejar

zoom/Interruptor RPS)

8. Botón OK
(Reproducir/Pausa)

9. Interruptor [� ] (Acercar
zoom/Interruptor RPS)

10. Botón Record/Stop
11. Indicador de

grabación/encendido/carga
12. Interruptor Power/Selector

de modalidad
13. Botón Menu
14. Ranura de Memory Stick

Vistas posterior y lateral izquierda

Ubicación de los controles 
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/MF

Right & Bottom View

1. Lens

2. Light

3. Earphones and AV

Input/Output Jack

4. Battery insertion part

5. Battery eject button

6. Volume +, - / MF 

(Manual Focus) button

7. Tripod Receptacle

8. Cradle Receptacle

9. Strap Hook

1. Lens

2. Light

4. Battery insertion part

5. Battery eject button

3. Earphones and 
AV Input/Output Jack

6. Volume +, - / MF(Manual Focus) button

Hanging Lens Cover on the CAM

7. Tripod Receptacle

8. Cradle Receptacle

9. Strap Hook

1.  Objetivo

2.  Luz

3.  Clavija de audífonos y de

salida de AV

4.  Pieza de inserción de la

batería

5.  Botón de expulsión de la

batería

6. Botón Volumen +, - / MF 
(Enfoque manual)

7. Orificio para el trípode

8. Conexión para cradle/

estación

9. Enganche de la correa

Ubicación de los controles 

Vistas lateral derecha e inferior
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External Camera Module View Vista del módulo de cámara externa.

1. Power button

2. Power LED

3. Lens

4. MIC

5. Tripod Receptacle

6. Battery Cover

7. BATT.OPEN Switch

8. Record Start/Stop button

9. Record LED Lamp

10. Clip

11.  AV Jack

1. Botón de encendido

2. Indicador de alimentación

3. Objetivo

4. Micrófono

5. Orificio para el trípode

6. Cubierta de la batería

7. BATT.OPEN Switch

8. Botón Record Start/Stop

9. Indicador luminoso de
grabación

10. Pinza

11.  Conexión CA

1. Power button

3. Lens

6. Battery Cover

5. Tripod Receptacle

8. Record Start/Stop button

10. Clip

11. AV Jack

9. Record LED Lamp

4. MIC

2. Power LED

7. BATT.OPEN Switch
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OSD (On Screen Display in Video Record Mode
/Video Play Mode)
Video Record Mode
1. Mode indicator
2. EIS indicator
3. Program AE indicator
4. White Balance indicator
5. BLC indicator
6. Focus indicator
7. Counter (Elapsed time /Remaining time)
8. Record / Standby indicator
9. Record / Standby text
10. Effect indicator
11. Zoom in / Zoom out indicator
12. Battery life indicator
13. Memory type indicator
14. Image quality/size indicator
15. Warning and note indicator

Video Play Mode
1. Mode indicator
2. Current display indicator
3. Lock indicator
4. Battery life indicator
5. Memory type indicator  
6. Image counter(Current image)

Video Play Mode
7. Warning and note indicator
8. Counter (Elapsed time / Recorded time)
9. Operation indicator (Play/Pause/RPS/FPS)
10. Volume indicator

✤  Functions will be retained when the CAM is turned off.

Note

Video Record Mode

Video Record

BLC

00:16 / 24:32

SF   /   720

STBY Sepia

1

3
2

4

5

6

7 8 9 10

11

12

131415

Video Play Mode

Video Play 100-00561

2

4

3

56

Video Play Mode

00:16 / 10:50

Video Play 100-0056

7

8 9

10

Ubicación de los controles: Pantalla LCD

OSD (Presentación en pantalla en modalidad <Video
Record> (Grabar video)/<Video Play> (Reproducir video)) 

Modalidad <Video Record> (Grabar video)
1. Indicador de modalidad
2. Indicador de EIS
3. Indicador de Program AE
4. Indicador de White Balance
5. Indicador de BLC
6. Indicador de enfoque
7. Contador 

(Tiempo transcurrido/Tiempo restante)
8. Indicador de grabación/espera
9. Texto de grabación/espera
10. Indicador de efecto
11. Indicador de acercamiento/alejamiento de zoom
12. Indicador de duración de la batería
13. Indicador de tipo de memoria
14. Indicador de calidad/tamaño de imagen
15. Indicador de advertencia y nota
Modalidad <Video Play> (Reproducir video)
1. Indicador de modalidad
2. Indicador de visualización actual
3. Indicador de bloqueo
4. Indicador de duración de la batería
5. Indicador de tipo de memoria
6. Contador de imágenes (imagen actual)
Modalidad <Video Play> (Reproducir video)
7. Indicador de advertencia y nota
8. Contador (Tiempo transcurrido/Tiempo grabado)
9. Indicador de operación

(Reproducir/Pausa/RPS/FPS)
10. Indicador de volumen

✤ Las funciones se conservarán cuando se
apague la CAM.

Nota
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OSD (On Screen Display in Photo Capture Mode
/Photo View Mode)
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Location of Controls: LCD Display

Photo Capture Mode
1. Mode indicator
2.    EIS indicator
3.    Program AE indicator
4.    White balance indicator 
5.    BLC indicator 
6.    Focus indicator 
7.    Zoom in/out indicator
8.    Battery life indicator
9.    Memory type indicator
10.  Image size indicator
11.  Warning and note indicator
12.  Light indicator

Photo View Mode
1.    Mode indicator 
2.    Current display indicator 
3.    Number of print 

Photo View Mode
4.    Printer indicator 
5.    Lock indicator 
6.    Image counter (Current image)

✤ Functions will be retained when the CAM is
turned off.

Note

Photo Capture Mode

Sepia

800Photo Capture

BLC

1

3
2

4

5

6

7

8

9101112

Photo View Mode

Photo View 100-00221

2
3

Photo View Mode

Photo View 100-0025

2 Copies

6

4 5

Ubicación de los controles: Pantalla LCD

OSD (Presentación en pantalla en modalidad <Photo
Capture> (Tomar foto)/<Photo View> (Ver foto)) 

Modalidad <Photo Capture> (Tomar foto)
1.    Indicador de modalidad
2.    Indicador de EIS
3.    Indicador de Program AE
4.    Indicador de White Balance
5.    Indicador de BLC
6.    Indicador de enfoque
7.    Indicador de acercamiento/ alejamiento de

zoom
8.    Indicador de duración de la batería
9.    Indicador de tipo de memoria
10.  Indicador de tamaño de imagen
11.  Indicador de advertencia y nota
12.  Indicador de luz

Modalidad <Photo View> (Ver foto)
1.    Indicador de modalidad
2.    Indicador de visualización actual
3.    Número de impresión 

Modalidad <Photo View> (Ver foto)
4.    Indicador de impresora
5.    Indicador de bloqueo
6.    Contador de imágenes (imagen actual)

✤ Las funciones se conservarán cuando se
apague la CAM.

Nota
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OSD (On Screen Display in MP3 Play Mode
/Voice Record /Play Mode)

MP3 Play Mode
1.    Mode indicator 
2.    File number / File name / File format      
3.    File size 
4.    Sampling Rate / Bit Rate      
5.    Progress Bar 
6.    Elapsed time / Full time
7.    Operation indicator   
8.    Volume indicator
9.    Battery life indicator
10.  Memory type indicator
11.  Repeat all / one indicator

Voice Record Mode
1.    Mode indicator
2.    File number / Date and Time
3.    Sampling Rate / Bit Rate
4.    Elapsed time / Full time
5.    Operation indicator    
6.    Record / Standby text

Voice Play Mode
7.    Progress Bar
8.    Lock indicator
9.    Volume indicator

✤ Functions will be retained when the CAM
is turned off.

Note

MP3 Play Mode

MP3 Play

2.  I believe I can fly.mp3
3.6 Mbytes

Stereo 44.1KHz 128Kbps

00:34 / 03:46

1

2

3

4

5

6

Voice Record Mode

Voice Record

2  2005/01/01  12:51:04 AM
Stereo  8KHz  128Kbps

00:00:12 / 00:05:12 REC

1011 9

Voice Play Mode

Voice Play

2  2005/01/01  12:51:04 AM
5.0Mbytes
Stereo  8KHz  128Kbps

00:00:12 / 00:05:12

7

9

8

7

5 6

8

1

2

3

4

Ubicación de los controles: Pantalla LCD

OSD (Presentación en pantalla en modalidad <MP3 Play>
(Reproducir MP3)/<Voice Record/Play> (Grabar voz/Reproducir)) 

Modalidad <MP3 Play> (Reproducir MP3)
1.    Indicador de modalidad
2.    Número de archivo/Nombre de archivo/

Formato de archivo      
3.    Tamaño de archivo
4.    Velocidad de muestreo/Velocidad de bits    
5.    Barra de progreso
6.    Tiempo transcurrido/Tiempo total
7.    Indicador de operación
8.    Indicador de volumen
9.    Indicador de duración de la batería
10.  Indicador de tipo de memoria
11.  Indicador de repetir todo/uno

Modalidad <Voice Recorder> 
(Grabador de voz)
1.    Indicador de modalidad
2.    Número de archivo/Fecha y hora
3.    Velocidad de muestreo/Velocidad de bits
4.    Tiempo transcurrido/Tiempo total
5.    Indicador de operación
6.    Texto de grabación/espera

Modalidad <Voice Play> (Reproducir voz)
7.    Barra de progreso
8.    Indicador de bloqueo
9.    Indicador de volumen

✤ Las funciones se conservarán cuando se
apague la CAM.

Nota
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Battery (Pack) Installation / Ejection
It is recommended you purchase one or more additional battery packs to allow
continuous use of your CAM.

Slide the battery pack into the groove until it clicks.

To insert the battery pack

Pull the [Battery Eject ] button to eject the battery pack.

To eject the battery pack

✤ Clean the terminals to remove foreign substances
before inserting the battery pack.

✤ If the CAM will not be in use for a while, remove
the battery pack from the CAM.

Notes

✤ Properly dispose of the expired batteries. Contact your local government or
community disposal service for disposal practices in your area. Keep them
away from small children.

✤ Do not mix old and new batteries. When replacing the batteries, replace
them both.

✤ If the External Camera Module will not be in use for a while, remove the
batteries.

✤ Do not insert a foreign material or electric conducting material in the battery
compartment. It can cause device failure.

✤ Do not open the battery cover with an excessive force. The connected cable
may become disconnected.

Notes

<Insert>

<Eject>

1. Open the battery compartment door after setting the door
open switch to <BATT.OPEN >.

2. Install two AAA size batteries. Make sure to match the “+” and 
“-” ends of the batteries with the diagram inside the compartment.

3. Close the battery compartment door, and then set the door
open switch to the opposite side of <BATT.OPEN >.

To insert the batteries for External Camera Module

✤ Deshágase de las baterías vencidas de forma adecuada. Póngase en
contacto con el servicio de basuras de su zona para obtener información
sobre la normativa de resíduos. Mantenga las baterías fuera del alcance de
los niños.

✤ No mezcle las baterías usadas con las nuevas. Cuando cambie las baterías,
reemplace las dos.

✤ Si no utiliza el modulo de cámara externa durante un tiempo, conviene
extraer las baterías.

✤ No introduzca un material extraño o conductor de la electricidad en el
compartimiento de las baterías. Puede provocar problemas en el dispositivo.

✤ No abra la cubierta de las baterías con una fuerza excesiva. Puede que se
desconecte el cable de conexión.

Notas

1. Open the battery compartment door after setting the door
open switch to <BATT.OPEN >.

2. Instale dos baterías del tamaño AAA. Compruebe que los
extremos “+” y “-” de las baterías coinciden con el diagrama
indicado en el compartimiento.

3. Close the battery compartment door, and then set the door
open switch to the opposite side of <BATT.OPEN >.

Para instalar las baterías en el módulo de cámara exterior

1

2

3

SB-P90A (900mAh) 

SB-P180A (1800mAh) (option)

Battery SB-P90A (900mAh) 

SB-P180A (1800mAh) (opcional)

Batería

Uso de la batería

Instalación y extracción de las baterías
Se recomienda adquirir una o más baterías para poder utilizar la CAM de forma
continua.

Deslice la batería en la ranura hasta que emita un chasquido.

Para insertar la batería

Tire del botón [Battery Eject] para expulsar la batería.

Para expulsar la batería

✤ Limpie el terminal para eliminar sustancias
extrañas antes de insertar la batería.

✤ Si no va a utilizar la CAM durante un tiempo, retire
la batería de la CAM.

Notas

00876D SCX105 US+ESP~037  4/28/05 10:47 AM  Page 20



ENGLISH ENGLISH

How to Use the Battery Pack

2121

ESPAÑOL

Maintain the Battery Pack
✤ The battery pack should be recharged in an environment of

between 32°F(0°C) and 104°F(40°C).
✤ The battery pack should never be charged in a room temperature

that is below 32°F(0°C).
✤ The life and capacity of the battery pack will be reduced if it is

used in temperatures below 32°F(0°C) or left in temperatures 
above 104°F(40°C) for a long period. 

✤ Do not put the battery pack near any heat sources (fire or flames,
for example).

✤ Do not disassemble, process, press or heat the Battery Pack.
✤ Do not allow the + and - terminals of the battery pack to be short-

circuited. It may cause leakage, heat generation,
induce fire and overheating.

✤ It is recommended to use original battery pack that is available at
SAMSUNG service center.

Uso de la batería

Mantenimiento de la batería
✤ La batería debe recargarse a una temperatura ambiente de entre

0°C (32ºF) y 40°C (104°F).
✤ La batería nunca debe cargarse cuando la temperatura ambiente

es de menos de 0°C (32°F).
✤ La vida útil y la capacidad de la batería se verán reducidas si se

utiliza en ambientes con temperaturas inferiores a 0°C (32°F) o si
se deja por largos periodos expuesta a temperaturas superiores
a los 40°C (104°F).

✤ No ponga la batería cerca de una fuente de calor (fuego o
llamas, por ejemplo).

✤ No desmonte la batería ni la someta a manipulaciones, a
presiones ni al calor.

✤ No permita que se produzca un cortocircuito entre los polos + y –
de la batería. Podrían producirse pérdidas o recalentamiento, lo
cual podría ocasionar un incendio.

✤ Se recomienda utilizar la batería original que está disponible en
el centro de servicio técnico de SAMSUNG.
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✤ Prepare an extra battery if you use the CAM outdoors.
✤ Contact a Samsung retailer to purchase a new battery pack.
✤ If you zoom in or out, the recording time becomes shorter.
✤ ‘Continuous Recording Time’ indicates the time that you neither

use zooming function nor play video files and record the video file
continuously when the EIS(      ) function is off.

✤ When you eject the battery pack from the CAM, hold the battery
pack to prevent it dropping to the floor.

If you close the LCD screen, it switches off automatically.
The continuous recording times given in the table below are
approximations. Actual recording time depends on usage.

Continuous recording time based on battery type

Continuous Recording Time
LCD ON Backlight OFF

SB-P90A (900mAh) 

SB-P180A (1800mAh) (option)

Approx. 60 min.

Approx. 120 min.

Approx. 80 min.

Approx. 160 min.

Battery 
Time

Warning

Notes

Uso de la batería

✤ Prepare una batería adicional si utiliza la CAM en el exterior.
✤ Póngase en contacto con un distribuidor de Samsung para

adquirir una nueva batería.
✤ Al acercar y alejar el zoom, se acorta el tiempo de grabación.
✤ <Continuous Recording Time> (Tiempo de grabación continua)

indica el tiempo que no utiliza la función del zoom, ni reproduce
archivos de video ni graba un archivo de video de forma continua
cuando la función EIS (      ) está desactivada.

✤ Cuando expulse la batería de la CAM, sujétela para evitar que se
caiga al suelo.

Si cierra la pantalla LCD, se apaga automáticamente.
Los tiempos de grabación continuada que se facilitan en la tabla
siguiente son aproximados. El tiempo real de grabación depende
del uso de la videocámara.

Tiempo de grabación continua basándose en el tipo de batería

Advertencia

Notas

Tiempo de grabación continua
LCD ENCENDIDA Luz de fondo apagada

SB-P90A (900mAh)

SB-P180A (1800mAh) (opcional)

Aprox. 60 min.

Aprox. 120 min.

Aprox. 80 min.

Aprox. 160 min.

Batería 
Tiempo
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Battery Level Display

The Battery Level Display shows the amount of battery power
remaining in the Battery Pack.

Tips for Battery Identification

Charging time based on battery type

If the battery has been fully charged, the charge
indicator is green. 
If you are charging the battery, the color of the
charge indicator is orange. 
The charge indicator flickers if the battery is abnormal.

Battery Level
Indicator

Fully charged

40~60% used

60~80% used

80~95% used

Exhausted(flickers)
The device will soon turn off. 

Change the Battery Pack 
as soon as possible.

(flickers)
The device will be forced to

turn off after 5 seconds.

State

-

-

-

-

-

“Battery Low”

Message

Video Play 100-0056

00:16 / 00:32

SB-P90A (900mAh) 

SB-P180A (1800mAh) (option)

Approx. 6 hr. 30 min

Approx. 13 hr.

Approx. 1 hr. 40 min

Approx. 3 hr. 20 min

Capacity Power On Power Off

Indicador de nivel 
de la batería

Completamente cargada

40-60% utilizada

60-80% utilizada

80-95% utilizada

Agotada (parpadea). 
El dispositivo se apagará

enseguida. Cambie la batería a
la mayor brevedad posible. 

(Parpadea). El dispositivo se 
apagará de forma forzada
transcurridos 5 segundos.

Estado

-

-

-

-

-

<Battery Low> 
(Batería baja)

Mensaje

Charge indicator 

Uso de la batería
Indicador de carga de la batería

El indicador de la carga de la batería muestra la cantidad de energía
restante.

Consejos para la identificación de la batería

Si la batería está completamente cargada, el
indicador de carga aparece de color verde.
Si está cargando la batería, el indicador de
carga aparece de color naranja.
El indicador de carga parpadea si la batería
muestra alguna anormalidad.

Tiempo de carga dependiendo del tipo de batería

SB-P90A (900mAh)
SB-P180A (1800mAh) (opcional)

Aprox. 6 h. 30 min.
Aprox. 13 h.

Aprox. 1 h. 40 min.
Aprox. 3 h. 20 min.

Capacidad Encendida Apagada
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Charging the Battery Pack

1. Slide [Mode Selector] up to turn the

CAM off.

2. Attach the Battery Pack to the CAM.

3. Fix the CAM into the cradle.

4. Connect the AC power adapter to the

DC In jack on the cradle.

� You can detach the AC adapter by
pressing the buttons on the sides of the
adapter cable plug while pulling it out.

5. Insert the AC power adapter into the

outlet.

✤ You can also charge the battery pack
when you use the CAM by connecting the
AC power adapter to the CAM directly.

✤ It is recommended you fully charge the
battery pack before use.

✤ You should only charge the battery in 
an environment between 32°F and 104°F.

Warning

Note

Charging through the cradle

Charging directly to the CAM

Uso de la batería

Carga de la batería

✤ También puede cargar la batería cuando
utilice la CAM conectando directamente
el adaptador de CA a la CAM.

✤ Se recomienda cargar totalmente la
batería antes de utilizarla.

✤ Debe cargar la batería únicamente en
un ambiente entre 0°C y 40°C.

Advertencia

Nota

1. Deslice el [Selector de modalidad]
hacia arriba para apagar la CAM.

2. Conecte la batería a la CAM.
3. Coloque la CAM en el soporte.
4. Conecte el adaptador de CA a la

toma de entrada de CC del soporte.
� Puede desconectar el adaptador de

CA pulsando los botones situados en
los laterales del enchufe del cable
del adaptador mientras tira hacia
fuera.

5. Inserte el adaptador de CA en la
toma de la pared.

00876D SCX105 US+ESP~037  4/28/05 10:47 AM  Page 24



Introducción

Color del indicador LED

Uso de la función de reinicio de hardware

El color del indicador LED varía dependiendo del estado de alimentación o de carga.

Si la unidad no funciona correctamente, utilice esta función
para devolver la CAM a su estado original por omisión.

Cuando el adaptador de CA está enchufado

Cuando el adaptador de CA está desenchufado

1. Retire la batería y el adaptador de CA.
2. Gire la pantalla LCD para colocarla hacia el frente.
3. Presione el botón [Display].

✤ Si reinicia la CAM, se inicializan todas las funciones
ajustadas.

Nota

ENGLISH ENGLISH
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The Color of the LED

Using Hardware Reset Function

The color of the LED varies depending on the power or charge. 

If the unit is not performing correctly, use this function
to set the CAM back to its original, default state.

When the AC Adapter is plugged in

LED Color

Red

Green

Orange

Green

Orange Blink

Power

Voice / Video Record

On

Off

Off

-

Charging state

-

-

Charging

Fully charged

Error

LED Color

Green

Red

Power

On

Voice / Video Record

Charging state

-

-

Color de LED

Rojo

Verde

Naranja

Verde

Naranja intermitente

Alimentación

Grabación de voz/video

Encendido

Apagado

Apagado

-

Grabación de voz/video

-

-

Cargando

Completamente cargada

Error

Color de LED

Verde

Rojo

Alimentación

Encendido

Grabación de voz/video

Estado de carga
-
-

When the AC Adapter is unplugged

1. Remove the battery pack and the AC adapter.
2. Turn the LCD monitor so it faces front.
3. Press the [Display] button.

✤ If you reset the CAM, all functions you set are
initialized.

Note
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Before You Start Operating the CAM
Before using the CAM, refer to this page for easy operation. 
The Memory Stick is an optional accessory and not included.

1. Install the battery pack and insert the Memory Stick into the
Memory Stick slot. (Refer to page 34)

2. Charge the battery pack by fixing the CAM into the cradle and
connecting the power cable to the cradle. (Refer to page 24)

3. Slide the [Mode Selector] down to turn on the CAM and slide it down
again.
� You can select Video mode or Previous mode as the start-up

mode in System Settings. (Refer to page 96)
� Video mode : The CAM starts up in Video Mode.
� Previous Mode : The CAM starts up in the mode you used last.

4. Slide the [� /� ] switch to select the desired mode and press the [OK]
button. 

5. Press the [OK] button to take pictures, record, hear music or record
voice. Press the [Menu] button to view the menu.

6. When you finished, slide [Mode Selector] up to turn the CAM off.  

Antes de utilizar la CAM, consulte esta página para facilitar su funcionamiento.
El Memory Stick es un accesorio adicional y no se incluye.

1. Instale la batería e inserte el Memory Stick en la ranura del Memory
Stick. (Consulte la página 34).

2. Cargue la batería fijando la CAM en el soporte y conectando el cable
de alimentación en el soporte. (Consulte la página 24).

3. Deslice hacia abajo el [Selector de modalidad] para encender la CAM
y deslícelo hacia abajo de nuevo.
� Puede seleccionar la modalidad Video o la modalidad anterior como la

modalidad de inicio en <System Settings> (Config. del sistema).
(Consulte la página 96).

� Modalidad video: La CAM se inicia en la modalidad de video.
� Modalidad anterior: La CAM se inicia en la última modalidad utilizada.

4. Deslice el interruptor [� /� ] hasta seleccionar la modalidad que
desea y presione el botón [OK].

5. Presione el botón [OK] para tomar imágenes, grabar, escuchar música
o grabar voz.
Presione el botón [Menu] para ver el menú.

6. Al terminar, mueva el [Selector de modalidad] hacia arriba para
apagar la CAM.  

For example: If you want to select Photo Mode

1. Video: You can record and
play video files.

2. Photo: You can take and
view photo files.

3. MP3: You can download and
listen to music.

4. Voice Recorder: 
You can record and playback
the voice.

5. File Browser: You can delete,
lock, copy the file and view the file information.

6. System Settings: 
You can set the LCD monitor brightness/color, date/time, system and
memory. 

7. Back: The screen moves to previous menu in the selected mode.

Introducción

Antes de empezar a utilizar la CAM

Por ejemplo: Para seleccionar la modalidad <Photo> (Foto)

1. <Video> : puede grabar y
reproducir archivos de
video.

2. <Photo> (Foto): puede
tomar fotos y ver archivos
de fotos.

3. <MP3>: puede descargar y
escuchar música.

4. <Voice Recorder>
(Grabador de voz): puede
grabar y escuchar la voz.

5. <File Browser> (Explorador de archivos): puede borrar, bloquear, copiar
el archivo y ver la información del mismo.

6. <System Setting> (Config. del sistema): 
puede definir el brillo y color de la pantalla LCD, la fecha y hora, el
sistema y la memoria.

7. <Back> (Volver): la pantalla regresa al menú anterior en la modalidad
seleccionada.

Mode Selection

MP3

Voice Recorder

File Browser

Video

Photo

1
2

3

4

5

Mode Selection

MP3

Voice Recorder

File Browser

System Settings

Back

6

7
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Using the Function Button
The Function button is used to make a selection, move the cursor,
select the functions and exit from the menu.

Using the Function button

The Use of [Back] and [Menu] button

Zoom out (�)

Zoom in (�)

Multi-Play screen

Change from Record/
Capture to Play/View

RPS ( )

FPS (      )

Multi-Play 
screen

Play/Pause

Select up

Select down

Return to 
previous menu

Confirm 
selecting

Button
Recording /

Picture taking
Playing /
Viewing

Selecting
Select up

Function
Button

Select 
menu

Return to
previous menu

Select 
down

Select
menu

Alejar zoom (�)

Acercar zoom (�)

Pantalla Multi-Play

Cambia de <Record / Capture>
(Grabar/Tomar) a <Play /
View>(Reproducir/Ver).

RPS ( )

FPS (      )

Pantalla
Multi-Play

Reproducir
/Pausa

Seleccionar
arriba

Seleccionar
abajo

Volver a menú
anterior

Confirmar
selección

Botón
Grabación/Toma

de imágenes
Reproducción/
Visualización

Selección

Move to Video Play/
Photo View

Move to <Settings>

Move to Video Record/
Photo Capture

Move to <File Options>

Button Video Record /
Photo Capture Video Play / Photo View

(Press for about 
2 seconds)

Uso del botón [Back] y [Menu]

Cambiar a <Video Play> 
(Reproducir video)/

<Photo View> (Ver foto)

Cambiar a <Settings>
(Ajustes)

Cambiar a <Video Record>
(Grabar video)/

<Photo Capture> (Tomar foto)

Cambiar a <File Options>
(Opciones de archivo)

Botón
<Video Record> (Grabar
video) /<Photo Capture>

(Tomar foto)
Video Play <Reproducir

video>/Photo View |<Ver foto>

(Presionar por 
unos 2 segundos)

✤ If there is no file stored when you press the [OK] button
in Video Record/Photo Capture mode, nothing occurs. 

✤ Refer to page 41 for further details about the function
button.

Notes

Introducción

✤ Si no hay ningún archivo al presionar el botón [OK]
en <Video Record> (Grabar video)/<Photo Capture>
(Tomar foto), no se produce ningún cambio.

✤ Consulte la página 41 para obtener información
adicional sobre el botón de funciones.

Notas

Utilización del botón de funciones
El botón de funciones se utiliza para realizar una selección, mover el
cursor, seleccionar las funciones y salir del menú.

Utilización del botón de funciones
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Using the Display Button
You can use various functions by pressing the [Display] button.

1. Open the LCD monitor.
2. Slide the [Mode Selector] down to turn on the

CAM. 
� The video screen appears.
� You can select Video mode or Previous mode

as the start-up mode in System Settings.
(Refer to page 96)

3. Press the [Display] button.

Back

Up

Select

Down

Open/Close
Menu

Off

Close Mode
Selection

Select Mode

Select Mode Help

Back

Prev./Rew

Play

Next/FF

Menu

Off

Mode
Selection

Play Help

Play Help

Play Mode

Zoom Out

Play Last

Zoom In

Menu

Record

Off

Record/Capture Help

Mode
Selection

Record/Capture Help 

Cancel

Up

Next

Down

Menu

Off

Mode
Selection

Time/Date Dialog Help

Time/Date Dialog Help    

✤ Once: The display indicators
turn off.

✤ Twice: The back light turns off.

✤ 3 times: It returns to the initial
screen.

✤ Hold down the button for 2 
seconds: The [Help] screen
according to each mode appears.

If you press the [Display]
button

Introducción

Utilización del botón Display
Puede utilizar diversas funciones pulsando el botón [Display].

1. Abra la pantalla LCD.
2. Deslice hacia abajo el [Selector de

modalidad] para encender la CAM.
� Aparece la pantalla de video.
� Puede seleccionar la modalidad Video o la

modalidad anterior como la modalidad de
inicio en <System Settings> (Config. del
sistema). (Consulte la página 96).

3. Presione el botón [Display].

✤ Una vez: se apagan los
indicadores de pantalla.

✤ Dos veces: se apaga la luz de
fondo.

✤ 3 veces: vuelve a la pantalla
inicial.

✤ Mantenga pulsado el botón por 
2 segundos: aparece la pantalla
de ayuda de la modalidad      
correspondiente.

Si pulsa el botón [Display].
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Adjusting the LCD Monitor
The CAM is equipped with a color Liquid Crystal Display monitor,
which enables you to view directly what you are recording or playing
back. Depending on the conditions under which you are using the
CAM (indoors or outdoors for example), you can adjust the LCD
Brightness or Color.

Esta CAM dispone de una pantalla de cristal líquido (LCD) en color
que permite ver lo que se está grabando o reproducir imágenes
grabadas directamente. Según las condiciones de grabación (por
ejemplo, exteriores o interiores), es posible ajustar el brillo y el color
de la pantalla LCD.

1. Slide the [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select System
Settings and press the [OK] button.

3. Slide the [ � /� ] switch to select <Display>
and press the [OK] button.

4. Slide the [ � /� ] switch to select <LCD
Brightness> or <LCD Color> and press the
[OK] button.

5. Slide the [ � /� ] switch to select desired
brightness or color and press the [OK] button.
� Refer to pages 88~89 for details.

✤ If you select [Back] in the menu, the previous menu
appears.

✤ If it is too bright, adjust the LCD Brightness. 

Notes

Introducción

Ajuste de la pantalla LCD

✤ Si selecciona <Back> (Volver) en el menú, aparece el
menú anterior.

✤ Si tiene demasiado brillo, ajuste el brillo de la pantalla
LCD.

Notas

1. Deslice hacia abajo el [Selector de modalidad] para
encender la CAM y deslícelo hacia abajo de nuevo.
� Aparece la pantalla <Mode Selection> (Selección

de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
System Settings (Config. del sistema) y presione
el botón [OK].

3. Deslice el interruptor [ � /� ] hasta seleccionar
<Display> (Pantalla) y presione el botón [OK].

4. Deslice el interruptor [ � /� ] hasta seleccionar
<LCD Brightness> (Brillo de LCD) y presione el
botón [OK].

5. Deslice el interruptor [ � /� ] hasta seleccionar el
brillo o color que desea y presione el botón [OK].
� Consulte la página 88 y 89 para obtener más

detalles.

2

3

4

5

Mode Selection

MP3

Voice Recorder

File Browser

System Settings

Back

System Settings

Date / Time

System

Display

Memory

Back

Settings: Display

Back

LCD Color 50%

LCD Brightness 20%

Settings: Display

Back

LCD Brightness 20 %

LCD Color 60 %
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Structure of the Folders and Files
The video files and photo files are stored in internal memory, Memory
Stick or Memory Stick Pro as below.

✤ Refer to page 34 for details about
Memory Stick.

✤ You can store general data in files
and folders of the CAM.

✤ The number of the file is up to 9,999
and folder is up to 999.

✤ DCAM✽✽✽✽.JPG : Photo file
SMOV✽✽✽✽.AVI : Video file
SWAV✽✽✽✽.WAV : Voice file
✽✽✽✽✽✽✽✽.MP3 : MP3 file

✤ MISC: DPOF files are stored.
✤ For proper operation, do not change

any file or folder names except those
labelled ‘Free’.

✤ You can change files or folders
named ‘Free’.

✤ Video files that you have not made
with the CAM may not be able to be
played.

✤ Free folder means the folder is
untitled.

Notes

✤ Do not turn the power off while
recording, playing, erasing a file or
formatting the Memory Stick.

✤ Please turn the power off before you
insert or eject the Memory Stick to
avoid losing data.

✤ Save important files separately.

Warning

Introducción

Estructura de carpetas y archivos 
Los archivos de video y de fotos se almacenan en la memoria
interna, en el Memory Stick o en el Memory Stick Pro como se
muestra a continuación.

✤ Consulte la página 34 para obtener
información sobre el Memory Stick.

✤ Puede almacenar datos generales en
archivos y en las carpetas de la CAM.

✤ La numeración de archivos llega a
9.999 y de carpetas a 999.

✤ DCAM✽✽✽✽.JPG: archivo de foto
SMOV✽✽✽✽.AVI: archivo de video
SWAV✽✽✽✽.WAV: archivo de voz
✽✽✽✽✽✽✽✽.MP3: archivo de MP3

✤ MISC: se almacenan los archivos DPOF.
✤ Para un funcionamiento correcto, no

cambia ningún nombre de archivo ni
de carpeta a excepción de los que
tengan la etiqueta ‘Free’.

✤ Puede cambiar los archivos y
carpetas denominados ‘Free’.

✤ Es posible que no pueda reproducir
los archivos de video que no haya
captado con la CAM.

✤ La carpeta ‘Free’ significa que la
carpeta no tiene título.

Notas

✤ No apague la videocámara mientras
esté grabando, reproduciendo,
borrando archivos o formateando el
Memory Stick.

✤ Apague la CAM antes de insertar o
extraer el Memory Stick para evitar
pérdida de datos.

✤ Guarde los archivos importantes aparte.

Advertencia
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Recording Time and Capacity

Media

Internal 

Memory

Memory 

Stick 

Memory 

Stick Pro

Capacity

512MB(SC-X105L)

1GB(SC-X110L)

32MB

64MB

128MB

256MB

512MB

1GB

Super Fine

352

approx. 21min.

approx. 44min.

X

X

X

approx. 10min.

approx. 20min.

approx. 42min.

720

approx. 10min.

approx. 22min.

X

X

X

approx. 5min.

approx. 10min.

approx. 21min.

Fine

352

approx. 32min.

approx. 66min.

approx. 2min. 

approx. 4min. 

approx. 8min. 

approx. 15min.

approx. 31min.

approx. 63min.

720

approx. 16min.

approx. 33min.

X

X

X

approx. 7min.

approx. 15min.

approx. 31min.

Normal

352

approx. 65min.

approx. 132mi.

approx. 4min.

approx. 8min.

approx. 16min.

approx. 30min.

approx. 62min.

approx.126min.

720

approx. 32min.

approx. 66min.

approx. 2min.

approx. 4min.

approx. 8min.

approx. 15min.

approx. 31min.

approx. 63min.

Video Record Time

Tiempo y capacidad de grabación 

Introducción

✤ 352 y 720 son resoluciones de video.
✤ El nivel de compresión se modifica automáticamente dependiendo de

las imágenes grabadas. El tiempo y la capacidad máxima de grabación
se pueden cambiar en <Video Record> (Grabar video).

✤ Es posible que no pueda grabar o reproducir archivos de video
normales si utiliza el Memory Stick por encima de una capacidad de 1
GB.

✤ Puede grabar archivos de video con tamaños de 720/Normal,
352/Normal y 352/Fino en el Memory Stick, pero no se garantiza su
calidad.

✤ Si graba archivos de video con la calidad Normal (352/720) en la
memoria interna, en el Memory Stick o en el Memory Stick Pro, el
tiempo de grabación se prolonga, pero es posible que el video tenga
una calidad inferior a otros niveles.

✤ El tiempo y la capacidad de grabación pueden variar si se genera un
sector defectuoso al grabar archivos de video en el Memory Stick y en
el Memory Stick Pro.

Advertencia

Soportes

Memoria

interna

Memory

Stick

Memory

Stick Pro

Capacidad

512 MB (SC-X105L)

1 GB (SC-X110L)

32 MB

64 MB

128 MB

256 MB

512 MB

1 GB

<Super Fine>
Superfino

352

Aprox. 21 min.

Aprox. 44 min.

X

X

X

Aprox. 10 min.

Aprox. 20 min.

Aprox. 42 min.

720

Aprox. 10 min.

Aprox. 22 min.

X

X

X

Aprox. 5 min.

Aprox. 10 min.

Aprox. 21 min.

<Fine>
Fino

352

Aprox. 32 min.

Aprox. 66 min.

Aprox. 2 min.

Aprox. 4 min.

Aprox. 8 min.

Aprox. 15 min.

Aprox. 31 min.

Aprox. 63 min.

720

Aprox. 16 min.

Aprox. 33 min.

X

X

X

Aprox. 7 min.

Aprox. 15 min.

Aprox. 31 min.

<Normal>

352

Aprox. 65 min.

Aprox. 132 min.

Aprox. 4 min.

Aprox. 8 min.

Aprox. 16 min.

Aprox. 30 min.

Aprox. 62 min.

Aprox. 126 min.

720

Aprox. 32 min.

Aprox. 66 min.

Aprox. 2 min.

Aprox. 4 min.

Aprox. 8 min.

Aprox. 15 min.

Aprox. 31 min.

Aprox. 63 min.

Tiempo de grabación de video

✤ 352 and 720 are video resolutions.
✤ The compressibility is changed automatically depending on the

recorded images. The maximum recording time and capacity can be
changed in ‘Video Record’. 

✤ You may be not able to record or play normal video files if you use a
Memory Stick with over 1GB capacity.

✤ You can record video files at the 720/Normal, 352/Normal and
352/Fine sizes in the Memory Stick but the quality is not guaranteed.

✤ If you record video files at the of Normal(352/720) quality in the
internal memory, Memory Stick or Memory Stick Pro, the recording
time becomes longer but the video may have lower quality than other
levels.

✤ The recording time and capacity may vary if a bad sector(section) is
generated when you record video files in the Memory Stick and
Memory Stick Pro.

Warning
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Getting Started
Number of Photos that can be taken

✤ 800 x 600 and 640 x 480 are video resolutions.
✤ The recording time and capacity is an approximation.
✤ You can format the Memory Stick on the CAM. (Refer to page 101)
✤ Do not format the Memory Stick or Memory Stick Pro on the PC.
✤ The recording time and the number of images shown are maximum figures

based on using one function. 
In actual use, using more than one function will reduce the capacity of each.

✤ If you set the light on, the number of photos that can be taken will be reduced.
✤ If you format the Memory Stick or Memory Stick Pro, use the Memory Stick

Formatter in the supplied software CD.

Notes

Media

Internal Memory

Memory Stick

Memory Stick
Pro

Capacity

512MB
1GB

32MB
64MB

128MB
256MB
512MB

1GB

Quality

640✕480
approx. 8258
approx. 16129 
approx. 516 
approx. 1032
approx. 2064 
approx. 4129 
approx. 8258 
approx. 16129 

Voice Record Time

800✕600
approx. 5019 
approx. 9803
approx. 313
approx. 627 
approx. 1254 
approx. 2509 
approx. 5019 
approx. 9803

Time

approx. 8hr.
approx. 18hr.
approx. 33min.
approx. 1hr.
approx. 2hr.
approx. 4hr.
approx. 8hr.
approx. 17hr.

Capacity

512MB
1GB

32MB
64MB
128MB
256MB
512MB

1GB

Media

Internal Memory

Memory Stick

Memory Stick Pro

Soportes

Memoria interna

Memory Stick

Memory Stick Pro

Capacidad

512 MB
1 GB

32 MB
64 MB
128 MB
256 MB
512 MB

1 GB

Calidad

640✕480
Aprox. 8258
Aprox. 16129
Aprox. 516 
Aprox. 1032
Aprox. 2064
Aprox. 4129 
Aprox. 8258 
Aprox. 16129 

800✕600
Aprox. 5019
Aprox. 9803
Aprox. 313
Aprox. 627
Aprox. 1254
Aprox. 2509 
Aprox. 5019 
Aprox. 9803

Tiempo

Aprox. 8 h.
Aprox. 18 h.
Aprox. 33 min.
Aprox. 1 h.
Aprox. 2 h.
Aprox. 4 h.
Aprox. 8 h.
Aprox. 17 h.

Capacidad

512 MB
1 GB

32 MB
64 MB
128 MB
256 MB
512 MB

1 GB

Soportes

Memoria interna

Memory Stick

Memory Stick Pro

Introducción

✤ 800 x 600 y 640 x 480 son resoluciones de video.
✤ El tiempo y capacidad de grabación es una aproximación.
✤ Puede formatear el Memory Stick en la CAM. (Consulte la página 101).
✤ No formatee el Memory Stick ni al Memory Stick Pro en la PC.
✤ El tiempo de grabación y el número de imágenes que se muestra son las

cifras más altas basándose en el uso de una función.
En uso real, el uso de más de una función reducirá la capacidad.

✤ Si enciende la luz, se reducirá el número de fotos que pueden tomarse.
✤ Si formatea el Memory Stick o el Memory Stick Pro, utilice el Memory Stick

Formatter que se suministra en el CD del software.

Notas

Número de fotos que pueden tomarse

Tiempo de grabación de voz
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Puede seleccionar el tipo de memoria: memoria interna o memoria      
externa (Memory Stick, Memory Stick Pro).
El Memory Stick es un accesorio adicional.
Los archivos de video y de fotos se guardan por
omisión en la memoria interna.
Para almacenar en un Memory Stick, debe
seleccionarse <External> (Externa).
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Selecting the Memory Type
You can select the memory type - internal memory or external
memory(Memory Stick, Memory Stick Pro). 
The Memory Stick is an optional accessory.
The video file and the photo files are stored in internal
memory by default.
To store on a Memory Stick, ‘External’ must be selected.

1. Insert the Memory Stick. (Refer to page 34)

2. Slide the [Mode Selector] down to turn on 
the CAM and slide it down again.

� The Mode Selection screen appears. 

3. Slide the [ � /� ] switch to select System 
Settings and press the [OK] button.

4. Slide the [ � /� ] switch to select <Memory> 
and press the [OK] button. 

5. Slide the [ � /� ] switch to select <Storage 
Type> and press the [OK] button.

6. Slide the [ � /� ] switch to select desired 
type and press the [OK] button.

� You can select external or internal memory.

✤ If you insert the Memory Stick or Memory Stick Pro, the
memory type selection screen appears automatically.

Note

Introducción

✤ Si inserta el Memory Stick o el Memory Stick Pro,
aparece automáticamente la pantalla de selección del
tipo de memoria.

Nota

Selección del tipo de memoria

1. Inserte el Memory Stick (Consulte la página 34).

2. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo de
nuevo.
� Aparece la pantalla <Mode Selection> (Selección

de modalidad).

3. Deslice el interruptor [ � /� ] hasta seleccionar
System Settings (Config. del sistema) y presione
el botón [OK].

4. Deslice el interruptor [ � /� ] hasta seleccionar
<Memory> (Memoria) y presione el botón [OK].

5. Deslice el interruptor [ � /� ] hasta seleccionar
<Storage Type> (Tipo de almac.) y presione el
botón [OK].

6. Deslice el interruptor [ � /� ] hasta seleccionar
el tipo que desea y presione el botón [OK].
� Puede seleccionar la memoria interna o la externa.

3

4

5

6

Mode Selection

MP3

Voice Recorder

File Browser

System Settings

Back

System Settings

Date / Time

System

Display

Memory

Back

Memory Space

Back

Format Internal

357MB/493MB

Settings: Memory

Storage Type Internal

Back

Format Internal

Settings: Memory

Storage Type External

Memory Space 357MB/493MB
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Using the Memory Stick (Optional Accessory)

1. Open the LCD monitor.
2. Open the Memory Stick slot lid.
3. Insert the Memory Stick into the slot until it softly clicks.
4. Close the slot lid.
Caution: This screen will appear if the Memory Stick is inserted with

the power on.
� If you select <OK>, the memory type changes 

to ‘External’ and if you select <Cancel>, files 
are stored in internal memory.

� If you insert a locked Memory Stick, the [     ] icon 
is displayed next to the memory type indicator. 

Ejecting a Memory Stick

1. Open the LCD monitor.
2. Open the Memory Stick slot lid.
3. Slightly push the Memory Stick inwards to pop it out.
4. Pull the Memory Stick out of the slot and close the lid.

Notes

✤ Do not apply excessive force when you insert / eject the Memory
Stick.

✤ Do not turn the power off while recording, playing, erasing files
or formatting the Memory Stick.

✤ Please turn the power off before you insert or eject the Memory
Stick to avoid losing data.

✤ Do not place the Memory Stick near a strong electro-magnetic
device.

✤ Do not allow metal substances to come in contact with the
terminals on the Memory Stick.

✤ Do not bend the Memory Stick.
✤ After pulling the memory stick out from the CAM, keep it in a soft

case to prevent static shock.
✤ The data stored on the stick may be changed or lost as a result

of misuse, static electricity, electric noise or repair. Save
important files separately.

✤ Samsung is not responsible for data loss due to misuse.

✤ Memory Stick and            are trademarks of
Sony Corporation.

✤ All other product names mentioned herein may
be the trademarks or registered trademarks of
their respective companies. “TM” will not be
mentioned in every instance in this manual.

Inserting a Memory Stick

Introducción 

Utilización del Memory Stick (Accesorios opcionales)
Inserción de un Memory Stick.

1. Abra la pantalla LCD.
2. Abra la tapa de la ranura del Memory Stick.
3. Inserte el Memory Stick en la ranura hasta que emita un

chasquido suave.
4. Cierre la tapa de la ranura.
Precaución: esta pantalla aparecerá si el Memory Stick se inserta

con la CAM encendida.
� Si selecciona [OK], el tipo de memoria cambia a

<External> (Externa) y si selecciona <Cancel>
(Cancelar), los archivos se almacenan en la
memoria interna.

� Si inserta un Memory Stick bloqueado, aparece el
icono [     ] al lado del indicador del tipo de memoria.

Extracción del Memory Stick
1. Abra la pantalla LCD.
2. Abra la tapa de la ranura del Memory Stick.
3. Presione ligeramente el Memory Stick hacia dentro para

que salte.
4. Saque el Memory Stick de la ranura y cierre la tapa.

Notas

✤ No aplique excesiva fuerza al insertar o expulsar el Memory Stick.
✤ No apague la CAM  mientras esté grabando, reproduciendo,

borrando archivos o formateando el Memory Stick.
✤ Apague la CAM antes de insertar o extraer el Memory Stick

para evitar pérdida de datos.
✤ No coloque el Memory Stick cerca de un dispositivo electro-

magnético potente.
✤ Impida que los terminales del Memory Stick entren en

contacto con objetos metálicos.
✤ No doble el Memory Stick.
✤ Después de sacar el Memory Stick de la CAM, guárdela en

una funda blanda para evitar descargas estáticas.
✤ Los datos almacenados en la Memory Stick se pueden

estropear o perder a causa de un uso incorrecto, de la
electricidad estática o del ruido eléctrico. Guarde los archivos
importantes aparte.

✤ Samsung no se hace responsable de los datos perdidos a
causa del uso incorrecto.

✤ Memory Stick y              son marcas
registradas de Sony Corporation.

✤ Todos los demás productos mencionados
son marcas comerciales o marcas
registradas de sus respectivas empresas.
“TM” no se mencionará en todos los casos
en este manual.

BLC

Video Record

00:16 / 24:32

SF   /   720

OK

Cancel

External memory inserted. 
Do you want to change 
memory to external?

HOLD

HOLD

The Memory Stick View

Terminals
Write-protect
Switch

00876D SCX105 US+ESP~037  4/28/05 10:47 AM  Page 34



3535

Getting Started

Mode and Menu Selection
You can select the mode and menu as follows. There are 2 ways of
selecting menu. Select the way you prefer.

1. Slide the [Mode Selector] down to turn on the CAM and slide
it down again.

2. Slide the [ � /� ] switch to select a desired mode and press
the [OK] button.

Mode Selection

1. Press the [Menu] button after selecting the desired mode.
2. Slide the [ � /� ] switch to select a desired menu and press

the [OK] button.

Menu Selection

SPECIAL OPERATION

1. Press the [Menu] button for 2 seconds.
� The set up menu screen of the selected

mode (Video, Photo etc.) appears.

Introducción

Selección de modalidad y menú
Puede seleccionar la modalidad y el menú de la siguiente forma.
Existen 2 formas de seleccionar el menú. Seleccione la forma que
prefiera.

1. Deslice hacia abajo el [Selector de modalidad] para encender
la CAM y deslícelo hacia abajo de nuevo.

2. Deslice el interruptor [ � /� ] hasta seleccionar la modalidad
que desea y presione el botón [OK].

Selección de modalidad

1. Presione el botón [Menu] después de seleccionar la
modalidad deseada.

2. Deslice el interruptor [ � /� ] hasta seleccionar el menú que
desea y presione el botón [OK].

Selección de menú

OPERACIÓN ESPECIAL

1. Presione el botón [Menu] por 2 segundos.
� Aparece la pantalla del menú de

configuración de la modalidad seleccionada
(<Video> (Video), <Photo> (Foto), etc.).

ENGLISH ESPAÑOL
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Recording..............................................................................37
Recording............................................................................37
Zooming In and Out............................................................38
Setting the Video In ............................................................39

Playing...................................................................................40
Playing on the LCD Monitor ...............................................40

Selecting File Options .........................................................42
Deleting Video files.............................................................42
Locking Video files..............................................................43
Copying Video files.............................................................44
Setting the PB Option.........................................................45

Setting Various Functions ..................................................46
Setting the Video file Size ..................................................46
Setting the Video file Quality ..............................................47
Setting the Focus................................................................48
Setting the EIS....................................................................49
Setting the White Balance..................................................50
Setting the Program AE......................................................51
Setting the BLC ..................................................................52
Setting the Effect ................................................................53
Setting the Digital Zoom.....................................................54

✤ You can set the time and date in System Settings. Refer to pages 90~91.

Note

Video Mode11
ENGLISH

Modalidad de video

Grabación .................................................................................37
Grabación...............................................................................37
Acercamiento y alejamiento de las imágenes.......................38
Ajuste de la función Video In <Entrada de video>................39

Reproducción ..........................................................................40
Reproducción en la pantalla LCD..........................................40

Selección de opciones de archivo........................................42
Eliminación de archivos de video ..........................................42
Bloqueo de archivos de video ...............................................43
Copia de archivos de video ...................................................44
Ajuste de la opción PB...........................................................45

Ajustes de diversas funciones ..............................................46
Ajuste del tamaño del archivo de video.................................46
Ajuste de la calidad del archivo de video ..............................47
Ajuste del enfoque .................................................................48
Ajuste de EIS..........................................................................49
Ajuste del balance de blanco.................................................50
Ajuste del Programa AE.........................................................51
Ajuste de BLC ........................................................................52
Ajuste del efecto.....................................................................53
Ajuste del zoom digital ...........................................................54

✤ Puede fijar la hora y fecha en <System Settings> 
(Config. del sistema). Consulte las páginas 90 y 91.

Nota

11
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Video Mode : Recording

Recording
You can record video and store it in memory.
Refer to the page 108 for recording video using the External Camera
Module.

1. Slide [Mode Selector] down to turn on the CAM.
� The Video Record screen appears.
� You can select Video mode or Previous mode

as the start-up mode in System Settings.
(Refer to page 96)

2. Press [Record/Stop] button to start recording.
� [ � REC] indicator displays on LCD.
� The elapsed and remaining times are

displayed and it starts recording.

3. Press the [Record/Stop] button again to stop
recording.
� It stops recording and the CAM is ready again.

4. Slide [Mode Selector] up to turn off the CAM.

Notes

✤ If the Auto Shut Off is set, the CAM turns off
automatically after 5 minutes. 

✤ Detach the Battery Pack when you finish recording
to prevent unnecessary battery power consumption.

✤ You can check the recording time.

Modalidad de video: Grabación

Grabación
Puede grabar video y almacenarlo en la memoria.
Consulte la página 108 para obtener información sobre la grabación
de video con el módulo de cámara externa.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM.
� Aparece la pantalla <Video Record> (Grabar video).
� Puede seleccionar la modalidad Video o la

modalidad anterior como la modalidad de inicio en
<System Settings> (Config. del sistema).
(Consulte la página 96).

2. Presione el botón [Record/Stop] para comenzar
la grabación.
� Aparece el indicador [ � REC] en la pantalla LCD.
� Aparece el tiempo transcurrido y restante y se

inicia la grabación.

3. Presione el botón [Record/Stop] de nuevo para
detener la grabación.
� Detiene la grabación y la CAM está preparada de

nuevo.

4. Deslice el [Selector de modalidad] hacia arriba
para apagar la CAM.

Notas

✤ Si se define <Auto Shut Off> (Apagado
automático), la CAM se apaga automáticamente
después de 5 minutos.

✤ Saque la batería al terminar de grabar para evitar
un consumo innecesario de la batería.

✤ Es posible comprobar el tiempo de grabación.

1

2

3

BLC

Video Record

00:00 / 10:57

SF   /   720

STBY

BLC

Video Record SF   /   720

00:16 / 10:50 REC

BLC

Video Record

00:16 / 10:41

SF   /   720

STBY

Video Record

00:00 / 10:57 STBY

Elapsed time Remaining time
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Zooming In and Out
Zooming lets you change the size of the subject captured in a scene.

1. Slide [Mode Selector] down to turn on the CAM. 
� You can select Video mode or Previous mode as the start-up

mode in System Settings. (Refer to page 96)

2. Press the [Record/Stop] button to start recording.

Zoom In

Zoom Out

Notes

✤ Frequent use of zooming may result in higher
battery power consumption.

✤ Refer to page 54 about Digital Zoom.

Slide the [ � /� ] switch
up to zoom out.
� The subject appears

farther away when you
zoom out.

Slide the [ � /� ] switch
down to zoom in.
� The subject appears

closer when you zoom in.

BLC

Video Record SF   /   720

00:16 / 10:50 REC

BLC

Video Record SF   /   720

00:16 / 10:50 REC

BLC

Video Record SF   /   720

00:16 / 10:50 REC

Modalidad de video: Grabación

Acercamiento y alejamiento de las imágenes
El uso de la técnica del zoom permite modificar el tamaño del
encuadre de las escenas.

1. Deslice hacia abajo el [Selector de modalidad] para encender
la CAM.
� Puede seleccionar la modalidad Video o la modalidad anterior

como la modalidad de inicio en <System Settings> 
(Config. del sistema). (Consulte la página 96).

2. Presione el botón [Record/Stop] para comenzar la grabación.

Notas

✤ El uso frecuente del zoom puede producir un
consumo más alto de la batería.

✤ Consulte la página 54 sobre <Digital Zoom>
(Zoom Digital).

Deslice el interruptor
[ � /� ] hacia arriba para
alejar el zoom.
� El objeto se aleja al alejar el

zoom.

Deslice el interruptor [ � /� ]
hacia abajo para acercar el
zoom.
� El objeto aparece más cerca

cuando se aplica el zoom.
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Setting the Video In
Video In function works only in Video mode.
Video In setting enables you to record signal from external sources or
External Camera Module and display it on LCD monitor.
Also, you can direct your video or image to external devices to record
or play back.

1. Slide [Mode Selector] down to turn on the
CAM.
� The Video Record screen appears.

2. Press the [Menu] button and slide the 
[ � /� ] switch.
Press the [OK] button after selecting <Video In>.

3. “Choose the type of line-in source”
message appears.
Slide the[ � /� ] switch to select <External
Camera> when using the 
external camera or <Normal> when using
just the camcorder, then press the [OK]
button.
If <External Camera> is selected, “External”
appears on the screen. 
If <Normal> is selected, “Normal” appears on the
screen.

Note

✤ When the External Camera Module is connected, [Record/Stop]
button of the main set does not operate.

Modalidad de video: Grabación

Ajuste de la función Video In <Entrada de video>
La función Video In <Entrada de video> sólo funciona en la
modalidad de video.
Gracias a la función Video In <Entrada de video>, podrá grabar
señales procedentes de fuentes externas o del modulo de cámara
exterior y reproducirlo en la pantalla LCD.

Asimismo, puede dirigir su video o la imagen a
dispositivos externos para grabarlos o reproducirlos.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM.
� Aparece la pantalla Video Record <Grabar video>.

2. Presione el botón [Menu] y deslice el interruptor
[� /� ].
Presione el botón [OK] tras seleccionar Video In
<Entrada de video>.

3. Aparece el mensaje “Seleccione tipo de fuente de
entrada”.
Deslice el interruptor [� /� ] hasta seleccionar
External Camera <Cámara externa> cuando
utilice la cámara externa o <Normal> cuando
utilice sólo la videocámara y, a continuación,
presione el botón [OK].
Si selecciona External Camera <Cámara externa>,
aparecerá “Externa” en la pantalla.
Si selecciona <Normal>, aparecerá “Normal” en la
pantalla.

Nota

✤ Cuando esté conectado el módulo externo de cámara, el botón
[Record/Stop] del equipo principal no está operando.

2

3

3

Video Record

00:16 / 10:41

SF   /   720

STBY

Play

Record

Video In

Settings

Back

Video Record

00:16 / 10:41

SF   /   720

STBY

Play

Record

Video In

Settings

Back
External Camera

Normal

Choose the type of
line-in source.

External

00:16 / 10:41

SF   /   704

STBY
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Playing on the LCD Monitor
You can view playback of video files on the LCD monitor.

1. Slide [Mode Selector] down to turn on the CAM.
� The Video Record screen appears.

2. Press the [Menu] button and slide the
[ � /� ] switch. 
Press the [OK] button after selecting <Play>.

3. Slide the [ � /� ] switch to find the video file
you want to play.
� Each time you slide the [ � /� ] switch, the

frame moves horizontally.
� Each time you press the [+]/ [ - ] button,

another page of 6 frames is displayed.

4. Press [OK] button to play the video file you want.
� Each time you press the [OK] button, play or

pause is selected repeatedly.

5. Press the [OK] button again to pause. 

Note

✤ You can press the [Back] button to go directly to the
first page of 6 frames.

4040
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1

2

3

4

BLC

Video Record

00:16 / 10:41

SF   /   720

STBY

Video Record

00:16 / 10:41

SF   /   720

STBY

Play

Record

Video In

Settings

Back

Video Play 100-0056

00:01 / 00:16

Video Play 100-0056

Modalidad de video: Reproducción 

Reproducción en la pantalla LCD
Puede ver la reproducción de los archivos de video en la pantalla LCD.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM.
� Aparece la pantalla <Video Record> (Grabar

video).

2. Presione el botón [Menu] y deslice el
interruptor [ � /� ]. 
Presione el botón [OK] tras seleccionar <Play>
(Reproducir).

3. Deslice el interruptor [ � /� ] hasta encontrar
el archivo de video que desea reproducir.
� Cada vez que mueva el interruptor [ � /� ], se

desplaza horizontalmente un fotograma.
� Cada vez que presione el botón [+]/[ - ],

aparece una nueva página (6 fotogramas).

4. Presione el botón [OK] para reproducir el
archivo de video que desea.
� Cada vez que presione el botón [OK], se

reproduce o se hace una pausa de forma
repetida.

5. Presione el botón [OK] de nuevo para
interrumpir la grabación. 

Nota

✤ Puede presionar el botón [Back] para ir
directamente a la primera página de los 6
fotogramas
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Video Mode : Playing

1. Press the [OK] button to play the video file.

2. Press the [+] button to increase the volume.
� Each time you press the [+] button, the

volume bar increases and the sound level will
get louder.

� The volume bar disappears after 1~2 seconds.

3. Press the [-] button to decrease the volume.
� Each time you press the [-] button, the

volume bar decreases and the sound level
will get quieter.

� The volume bar disappears after 1~2 seconds.

Notes

✤ You can adjust the volume up to 10 steps.
✤ You can also play the video file on a TV screen by connecting the

CAM to a TV. (Refer to page 112)
✤ You must install the Image Mixer software (see page 117) to

playback video files recorded on  the CAM on your PC.

[OK] Button: Play or pause the video file
[� ] Switch:  In Video Play mode: Press it to move to previous file.

Press and hold it to use RPS function. 
(RPS rate: 2x➝4x➝8x➝16x➝32x➝64x➝128x)

[� ] Switch: In Video Play mode: Press it to move to next file.
Press and hold it to use FPS function. 
(FPS rate: 2x➝4x➝8x➝16x➝32x➝64x➝128x)
In Video Play mode: Press and hold it to play slowly
when paused. Press it to move to the next frame
when paused.

The button and switch you use when playing the video file

Adjusting the Sound 

1

2

00:01 / 00:16

Video Play 100-0056

00:01 / 00:16

Video Play 100-0056

Modalidad de video: Reproducción 

Notas

✤ Puede ajustar el volumen hasta en diez 10 pasos.
✤ También puede reproducir el archivo de video en una pantalla de

TV conectando la CAM a un televisor. (Consulte la página 112).
✤ Debe instalar el software ImageMixer (consulte la página 117) para

reproducir en la PC archivos de video grabados en la CAM.

Botón [OK]: reproduce o interrumpe la reproducción del archivo de video.
Interruptor [� ]: En la modalidad <Video Play> (Reproducir video): se

pulsa para ir al archivo anterior.
Se mantiene pulsado para utilizar la función RPS.  
(Velocidad RPS: 2x➝4x➝8x➝16x➝32x➝64x➝128x)

Interruptor [� ]: En la modalidad <Video Play> (Reproducir video): Se
pulsa para ir al archivo siguiente.Se mantiene
pulsado para utilizar la función FPS. (Velocidad de
FPS: 2x➝4x➝8x➝16x➝32x➝64x➝128x)
Mantenga pulsado este botón para reproducir
lentamente después de presionar el botón de pausa.
Se pulsa para ir al fotograma siguiente después de
presionar el botón de pausa.

Botón e interruptor utilizados al reproducir archivos de video

1. Presione el botón [OK] para reproducir el
archivo de video.

2. Presione el botón [+] para subir el volumen.
� Cada vez que se pulsa el botón [+], la barra de

volumen sube junto con el nivel del sonido.
� La barra de volumen desaparece después de 1 ó 2

segundos.
3. Presione el botón [-] para bajar el volumen.

� Cada vez que se pulsa el botón [-], la barra de
volumen baja junto con el nivel del sonido.

� La barra de volumen desaparece después de 1 ó 2
segundos.

Ajuste del sonido
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Deleting Video files

Video Mode : Selecting File Options

You can delete video files in <File Options>.

1. Slide [Mode Selector] down to turn on the CAM.
� The Video Record screen appears. 

2. Press the [Menu] button and slide the
[ � /� ] switch. 
Press the [OK] button after selecting [Play].

3. Slide the [ � /� ] switch to select the video
file you want to delete.

4. Press the [Menu] button to select <File
Options> and press the [OK] button.
� You can select <File Options> only in Video Play

mode.

5. Slide the [ � /� ] switch to select <Delete>
and press the [OK] button.

6. Slide the [ � /� ] switch to select from the
following. Press the [OK] button.
� Selected: The selected video file is deleted.
� All: All video files are deleted. 
� Cancel: Cancel deleting video files.

Note

✤ Press and hold the [Menu] button in Video Play
mode, you can move to <File Options> directly.
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Modalidad de video: 
Selección de opciones de archivo

Eliminación de archivos de video 
Los archivos de video se pueden borrar en <File Options> (Opciones de archivo).

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM.
� Aparece la pantalla <Video Record> (Grabar video).

2. Presione el botón [Menu] y deslice el interruptor
[ � /� ]. 
Presione el botón [OK] tras seleccionar <Play>
(Reproducir).

3. Deslice el interruptor [ � /� ] hasta seleccionar el
archivo de video que desea borrar.

4. Presione el botón [Menu] hasta seleccionar <File
Options> (Opciones de archivo) y presione el
botón [OK].
� Puede seleccionar File Options <Opciones de

archivo> sólo en la modalidad Video Play
<Reproducir video>.

5. Deslice el interruptor [ � /� ] hasta seleccionar
<Delete> (Borrar) y presione el botón [OK].

6. Deslice el interruptor [ � /� ] hasta seleccionar
uno de los siguientes. Presione el botón [OK].
� <Selected> (Seleccionado): se borra el

archivo de video seleccionado.
� <All> (Todo): se borran todos los archivos de  

video.
� <Cancel> (Cancelar): cancela la supresión de 

archivos de video.

Nota

✤ Mantenga pulsado el botón [Menu] en <Video Play>
(Reproducir video), así podrá ir directamente a <File
Options> (Opciones de archivo).
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Video Mode : Selecting File Options

Locking Video files
You can lock the important video file to prevent accidental deletion.

1. Slide [Mode Selector] down to turn on the CAM.
� The Video Record screen appears.

2. Press the [Menu] button and slide the [ � /� ]
switch. 
Press the [OK] button after selecting <Play>.

3. Slide the [ � /� ] switch to select the video file
you want to lock.

4. Press the [Menu] button to select <File
Options> and press the [OK] button.
� You can select <File Options> only in Video

Play mode. 

5. Slide the [ � /� ] switch to select <Lock> and
press the [OK] button.

6. Slide the [ � /� ] switch to select from the
following and press the [OK] button.
� Selected: The selected video file is locked.
� All: All video files are locked. 
� Cancel: Cancel locking video files.

Notes

✤ Press and hold the [Menu] button in Video Play mode,
you can move to <File Options> directly.

✤ The <      > icon is displayed when the file is locked.

Modalidad de video: 
Selección de opciones de archivo

Bloqueo de archivos de video 
Es posible bloquear archivos de video importantes para evitar el
borrado accidental.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM.
� Aparece la pantalla <Video Record> (Grabar video).

2. Presione el botón [Menu] y deslice el interruptor
[ � /� ]. 
Presione el botón [OK] tras seleccionar <Play>
(Reproducir).

3. Deslice el interruptor [ � /� ] hasta seleccionar el
archivo de video que desea bloquear.

4. Presione el botón [Menu] hasta seleccionar <File
Options> (Opciones de archivo) y presione el
botón [OK].
� Puede seleccionar File Options <Opciones de

archivo> sólo en la modalidad Video Play
<Reproducir video>.

5. Deslice el interruptor [ � /� ] hasta seleccionar
<Lock> (Bloquear) y presione el botón [OK].

6. Deslice el interruptor [ � /� ] para seleccionar
entre los siguientes y presione el botón [OK].
� <Selected> (Seleccionado): se bloquea el

archivo de video seleccionado.
� <All> (Todo): se bloquean todos los archivos de video.
� <Cancel> (Cancelar): cancela el bloqueo de

archivos de video.

Notas

✤ Mantenga pulsado el botón [Menu] en <Video Play>
(Reproducir video), así podrá ir directamente a <File
Options> (Opciones de archivo).

✤ Aparece el icono <      > cuando se bloquea el archivo.
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Video Mode : Selecting File Options

Copying Video files
This allows you to copy files back and forth between the internal and
external memory.
1. Slide [Mode Selector] down to turn on the CAM.

� The Video Record screen appears.

2. Press the [Menu] button and slide the [ � /� ]
switch. 
Press the [OK] button after selecting <Play>.

3. Slide the [ � /� ] switch to select the video
file you want to copy.

4. Press the [Menu] button to select <File
Options> and press the [OK] button.
� You can select <File Options> only in Video

Play mode.

5. Slide the [ � /� ] switch to select <Copy To>
and press the [OK] button.
� If you selected video ‘External’ as the Storage

type, the file is copied to ‘internal’ and vice
versa.

6. Slide the [ � /� ] switch to select from the
following and press the [OK] button.
� Selected: Copy the selected video file.
� All: Copy all video files. 
� Cancel: Cancel copying video files.

Note

✤ Press and hold the [Menu] button in Video Play
mode, you can move to <File Options> directly.
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Modalidad de video: 
Selección de opciones de archivo

Copia de archivos de video 
Esto permite copiar archivos entre la memoria interna y externa.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM.
� Aparece la pantalla <Video Record> (Grabar video).

2. Presione el botón [Menu] y deslice el interruptor
[ � /� ]. 
Presione el botón [OK] tras seleccionar <Play>
(Reproducir).

3. Deslice el interruptor [ � /� ] hasta seleccionar el
archivo de video que desea copiar.

4. Presione el botón [Menu] hasta seleccionar <File
Options> (Opciones de archivo) y presione el
botón [OK].
� Puede seleccionar File Options <Opciones de

archivo> sólo en la modalidad Video Play
<Reproducir video>. 

5. Presione el interruptor [ � /� ] hasta seleccionar
<Copy To> (Copiar en) y presione el botón [OK].
� Si ha seleccionado el tipo de almacenamiento

External (Externo) de vídeo, el archivo se copia en
Internal (Interno) y viceversa.

6. Deslice el interruptor [ � /� ] para seleccionar
entre los siguientes y presione el botón [OK].
� <Selected> (Seleccionado): se copia el archivo

de video seleccionado.
� <All> (Todo): copia todos los archivos de video.
� <Cancel> (Cancelar): cancela la copia de archivos de video.

Nota

✤ Mantenga pulsado el botón [Menu] en <Video Play>
(Reproducir video), así podrá ir directamente a <File
Options> (Opciones de archivo).
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Video Mode : Selecting File Options

Setting the PB(Play Back) Option
You can play all files continuously or play the selected file only.

1. Slide [Mode Selector] down to turn on the CAM.
� The Video Record screen appears.

2. Press the [Menu] button and slide the [ � /� ]
switch. 
Press the [OK] button after selecting <Play>.

3. Slide the [ � /� ] switch to select the video
file you want to set.

4. Press the [Menu] button to select <File
Options> and press the [OK] button.
� You can select <File Options> only in Video

Play mode. 

5. Slide the [� /� ] switch to select <PB
Option> and press the [OK] button.

6. Slide the [� /� ] switch to select from the
following and press the [OK] button.
� Selected: Play the selected video file.
� All: Play all video files. 
� Cancel: Cancel setting PB Option.

Note

✤ Press and hold the [Menu] button in Video Play
mode, you can move to <File Options> directly.
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Modalidad de video: 
Selección de opciones de archivo
Ajuste de la opción PB (Reproducción)
Puede reproducir de forma continua todos los archivos o reproducir
únicamente el archivo seleccionado.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM.
� Aparece la pantalla <Video Record> (Grabar video).

2.Presione el botón [Menu] y deslice el interruptor
[ � /� ]. 
Presione el botón [OK] tras seleccionar <Play>
(Reproducir).

3. Deslice el interruptor [ � /� ] hasta seleccionar el
archivo de video que desea definir.

4. Presione el botón [Menu] hasta seleccionar <File
Options> (Opciones de archivo) y presione el
botón [OK].
� Puede seleccionar File Options <Opciones de

archivo> sólo en la modalidad Video Play
<Reproducir video>. 

5. Presione el interruptor [� /� ] hasta seleccionar
<PB Option> (Opción PB) y presione el botón
[OK].

6. Deslice el interruptor [� /� ] para seleccionar
entre los siguientes y presione el botón [OK].
� <Selected> (Seleccionado): reproduce el

archivo de video seleccionado.
� <All> (Todo): reproduce todos los archivos de  video.
� <Cancel> (Cancelar): cancela el ajuste <PB

Option> (Opción PB).

Nota

✤ Mantenga pulsado el botón [Menu] en <Video Play>
(Reproducir video), así podrá ir directamente a <File
Options> (Opciones de archivo).
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Video Mode : Setting Various Functions

Setting the Video file Size
You can set the video files size. The file storage capacity depends on
the Memory Stick and video file size.

1. Slide [Mode Selector] down to turn on the CAM.
� The Video Record screen appears.

2. Press the [Menu] button and slide the [ � /� ]
switch. 
Press the [OK] button after selecting <Settings>.

3. Slide the [ � /� ] switch to select <Size> and
press the [OK] button.
� 720: Selects 720 pixels.
� 352: Selects 352 pixels.

4. Slide the [ � /� ] switch to select the video
file size and press the [OK] button.

5. Press the [Menu] button to finish setting.
� The selected function icon is displayed.

Notes

✤ If you select <Back> in the menu, the previous menu
appears.

✤ Press and hold the [Menu] button in Video Record
mode, you can move to <Settings> directly.
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Modalidad de video: 
Ajustes de diversas funciones

Ajuste del tamaño del archivo de video
Puede definir el tamaño de los archivos de video. La capacidad de
almacenamiento de archivos depende de la capacidad del Memory
Stick y del archivo de video.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM.
� Aparece la pantalla <Video Record> (Grabar video).

2.Presione el botón [Menu] y deslice el interruptor
[ � /� ]. 
Presione el botón [OK] tras seleccionar
<Settings> (Ajustes).

3. Deslice el interruptor [ � /� ] hasta seleccionar
<Size> (Tamaño) y presione el botón [OK].
� 720: selecciona 720 píxeles.
� 352: selecciona 352 píxeles.

4. Deslice el interruptor [ � /� ] hasta seleccionar
el tamaño de archivo de video y presione el
botón [OK].

5. Presione el botón [Menu] para finalizar el ajuste.
� Aparece el icono de la función seleccionada.

Notas

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.

✤ Mantenga pulsado el botón [Menu] en la modalidad
Video Record <Grabar video>, así podrá ir
directamente a Settings <Ajustes>.
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Video Mode : Setting Various Functions

Setting the Video file Quality
You can set the video files quality. The files storage capacity depends
on the Memory Stick and video file quality.

1. Slide [Mode Selector] down to turn on the CAM.
� The Video Record screen appears.

2. Press the [Menu] button and slide the [ � /� ]
switch. 
Press the [OK] button after selecting <Settings>.

3. Slide the [ � /� ] switch to select <Quality>
and press the [OK] button.
� SF(Super Fine): Selects highest quality.
� F(Fine): Selects high quality.
� N(Normal): Selects normal quality.

4. Slide the [ � /� ] switch to select the video
file quality and press the [OK] button.

5. Press the [Menu] button to finish setting.
� The selected function icon is displayed.

Notes

✤ If you select <Back> in the menu, the previous
menu appears.

✤ If you use the Memory Stick, you can select the
size and quality of 720/Normal, 352/Fine and
352/Normal only.

✤ Press and hold the [Menu] button in Video Record
mode, you can move to <Settings> directly.
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Modalidad de video: 
Ajustes de diversas funciones

Ajuste de la calidad del archivo de video
Puede definir la calidad de los archivos de video. La capacidad de
almacenamiento de los archivos depende de la calidad del Memory
Stick y del archivo de video.

1. Deslice hacia abajo el [Selector de modalidad] para
encender la CAM.
� Aparece la pantalla <Video Record> (Grabar video).

2. Presione el botón [Menu] y deslice el interruptor
[ � /� ]. 
Presione el botón [OK] tras seleccionar <Settings>
(Ajustes).

3. Deslice el interruptor [ � /� ] hasta seleccionar
<Quality> (Calidad) y presione el botón [OK].
� <SF> (Superfino): selecciona la calidad más alta.
� <F> (Fino): selecciona una calidad alta.
� <N> (Normal): selecciona una calidad normal.

4. Deslice el interruptor [ � /� ] hasta seleccionar la
calidad de archivo de video y presione el botón [OK].

5. Presione el botón [Menu] para finalizar el ajuste.
� Aparece el icono de la función seleccionada.

Notas

✤ Si selecciona <Back> (Volver) en el menú,
aparece el menú anterior.

✤ Si utiliza el Memory Stick, puede seleccionar
únicamente el tamaño y la calidad 720/Normal,
352/<Fine> (Fino) y 352/Normal.

✤ Mantenga pulsado el botón [Menu] en la
modalidad Video Record <Grabar video>, así
podrá ir directamente a Settings <Ajustes>.
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Video Mode : Setting Various Functions

Setting the Focus
You can set the focus depending on the subject or environment. In
most situations, it is best to use the AF(Auto Focus).

1. Slide [Mode Selector] down to turn on the CAM.
� The Video Record screen appears.

2. Press the [Menu] button and slide the [ � /� ] switch.
Press the [OK] button after selecting <Settings>.

3. Slide the [ � /� ] switch to select <Focus>
and press the [OK] button.
� AF: Set the focus automatically. When the

CAM turns on, AF is selected by default.
� MF(     ): Set the focus manually.

4. Slide the [ � /� ] switch to select desired
setting and press the [OK] button.

5. Press the [Menu] button to finish setting.
� The selected function icon is displayed.
� If you select the AF, no icon is displayed.

Notes

✤ If you select <Back> in the menu, the previous menu
appears. 

✤ Press and hold the [Menu] button in Video Record
mode, you can move to <Settings> directly.

Adjust the focus using [ +] / [ - ] button to zoom
in or out manually.
� When a picture contains objects that are both

close and far away from the CAM.
� When a person is enveloped in fog or surrounded

by snow.

Manual Focus
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Modalidad de video: 
Ajustes de diversas funciones

Ajuste del enfoque
Puede definir el enfoque dependiendo del objeto o del entorno. En la
mayoría de las situaciones, es mejor utilizar AF (enfoque automático).

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM.
� Aparece la pantalla <Video Record> (Grabar video).

2. Presione el botón [Menu] y deslice el interruptor
[ � /� ]. 
Presione el botón [OK] tras seleccionar
<Settings> (Ajustes).

3. Deslice el interruptor [ � /� ] hasta seleccionar
<Focus> (Enfoque) y presione el botón [OK].
� AF: enfoca automáticamente. Cuando se

enciende la CAM, AF se selecciona por omisión.
� MF(     ): fija el enfoque manual.

4. Deslice el interruptor [ � /� ] hasta seleccionar el
ajuste que desea y presione el botón [OK].

5. Presione el botón [Menu] para finalizar el ajuste.
� Aparece el icono de la función seleccionada.
� Si selecciona <AF>, no aparece ningún icono.

Notas

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.

✤ Mantenga pulsado el botón [Menu] en la modalidad
Video Record <Grabar video>, así podrá ir
directamente a Settings <Ajustes>.

Enfoque utilizando el botón [+] / [ - ] para acercar
o alejar el zoom manualmente.
� Cuando una imagen contenga objetos que estén

cerca y lejos de la CAM.
� Cuando haya una persona entre la niebla o

rodeada de nieve.

Enfoque manual
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Video Mode : Setting Various Functions

Setting the EIS (Electronic Image Stabilizer)
The Electrical Image Stabilizer is a function that compensates for
hand shake and other movements while recording. 
EIS provides more stable video when:
� Recording with zooming
� Recording small objects
� Recording while walking or moving
� Recording through the window in the vehicle

1. Slide [Mode Selector] down to turn on the CAM.
� The Video Record screen appears.

2. Press the [Menu] button and slide the [ � /� ]
switch. 
Press the [OK] button after selecting <Settings>.

3. Slide the [ � /� ] switch to select <EIS> and
press the [OK] button.
� On( ): Set the EIS function.
� Off : Cancel the EIS function.

4. Slide the [ � /� ] switch to select desired
setting and press the [OK] button.

5. Press the [Menu] button to finish setting.
� The selected function icon is displayed.

Notes

✤ If you select <Back> in the menu, the previous
menu appears.

✤ Press and hold the [Menu] button in Video Record
mode, you can move to <Settings> directly.
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Modalidad de video: 
Ajustes de diversas funciones

Notas

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.

✤ Mantenga pulsado el botón [Menu] en la modalidad
Video Record <Grabar video>, así podrá ir
directamente a Settings <Ajustes>.

Ajuste de EIS (Estabilizador electrónico de la imagen)
El estabilizador electrónico de la imagen es una función que
compensa los temblores de la mano y otros movimientos mientras se
graba. EIS proporciona video más estable:

� Al grabar con zoom;
� Al grabar objetos pequeños;
� Al grabar mientras se camina o se está en movimiento;
� Al grabar por la ventana de un coche.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM.
� Aparece la pantalla <Video Record> (Grabar video).

2. Presione el botón [Menu] y deslice el interruptor
[ � /� ]. 
Presione el botón [OK] tras seleccionar
<Settings> (Ajustes).

3. Deslice el interruptor [ � /� ] hasta seleccionar
EIS y presione el botón [OK].
� <On> (Act.)( ): ajusta la función EIS.
� <Off> (Des.): cancela la función EIS.

4. Deslice el interruptor [ � /� ] hasta seleccionar
el ajuste que desea y presione el botón [OK].

5. Presione el botón [Menu] para finalizar el ajuste.
� Aparece el icono de la función seleccionada.
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Setting the White Balance
The White balance may vary depending on the lighting conditions. 
The White Balance is used to preserve natural colors under different
lighting conditions.
1. Slide [Mode Selector] down to turn on the CAM.

� The Video Record screen appears.

2. Press the [Menu] button and slide the [ � /� ] switch.
Press the [OK] button after selecting <Settings>.

3. Slide the [ � /� ] switch to select <White
Balance> and press the [OK] button.
� Auto: The color is adjusted automatically
depending on the condition.
� Hold(      ): Records and Holds (Locks) selected
White Balance setting.
� Outdoor(     ): Records with natural light.
� Indoor(     ): Records with indoor lighting.

4. Slide the [ � /� ] switch to select desired
setting and press the [OK] button.

5. Press the [Menu] button to finish setting.
� The selected function icon is displayed.
� If you select <Auto>, no icon is displayed.

Notes

✤ If you select <Back> in the menu, the previous
menu appears.

✤ Turn the Digital Zoom off for more accurate White
Balance setting.

✤ Press and hold the [Menu] button in Video Record
mode, you can move to <Settings> directly.
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Modalidad de video:
Ajustes de diversas funciones

✤ Si selecciona <Back> (Volver) en el menú, aparece el
menú anterior.

✤ Apague el <Digital Zoom> (Zoom Digital) para un
ajuste de balance de blanco más preciso.

✤ Mantenga pulsado el botón [Menu] en la modalidad
Video Record <Grabar video>, así podrá ir
directamente a Settings <Ajustes>.

Ajuste del balance de blanco
El balance de blanco puede variar dependiendo de las condiciones de
luz. <White Balance> (Balance de blanco) se utiliza para conservar
los colores naturales bajo diferentes condiciones de luz.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM.
� Aparece la pantalla <Video Record> (Grabar video).

2. Presione el botón [Menu] y deslice el interruptor
[ � /� ]. 
Presione el botón [OK] tras seleccionar
<Settings> (Ajustes).

3. Deslice el interruptor [ � /� ] hasta seleccionar
<White Balance> (Balance de blanco) y presione
el botón [OK].
� <Auto> (Autom.): el color se ajusta

automáticamente dependiendo de las
condiciones.

� <Hold> (Mantener) (        ): graba y mantiene
bloqueado el ajuste seleccionado de balance de
blanco.

� <Outdoor> (Exterior) (        ): graba con luz natural.
� <Indoor> (Interior) (        ): graba con luz de interior.

4. Deslice el interruptor [ � /� ] hasta seleccionar el
ajuste que desea y presione el botón [OK].

5. Presione el botón [Menu] para finalizar el ajuste.
� Aparece el icono de la función seleccionada.
� Si selecciona <Auto> (Autom.), no aparece ningún icono.

Notas
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Video Mode : Setting Various Functions

Setting the Program AE (Programmed Auto Exposure)
Program AE allows you to adjust the aperture setting to suit different conditions.

1. Slide [Mode Selector] down to turn on the CAM.
� The Video Record screen appears.

2. Press the [Menu] button and slide the [� /� ] switch.
Press the [OK] button after selecting <Settings>.

3. Slide the [ � /� ] switch to select <Program AE> and
press the [OK] button.
� Auto: Auto balances between the subject and

background to get the best result. 
The shutter speed automatically varies from 1/60 to
1/250 per second depending on the scene.

� Sports(     ): For recording fast-moving people
or objects. It is suitable for sports events 
and recording outside in the car.

� Spotlight(     ): Compensates for a subject
that appears too bright under strong direct light such
as spotlight. It is suitable for concerts and school
performances. 

� Sand/Snow(     ): Use when the light is very
strong such as on the beach or in the snow.

� HS Shutter(     ): Allows fast-moving images 
to be captured one frame at a time.

4. Slide the [ � /� ] switch to select desired setting and
press the [OK] button.

5. Press the [Menu] button to finish setting.
� The selected function icon is displayed.
� If you select <Auto>, no icon is displayed.

Notes

✤ If you select <Back> in the menu, the previous menu appears.
✤ Press and hold the [Menu] button in Video Record mode,

you can move to <Settings> directly.
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Modalidad de video: 
Ajustes de diversas funciones

Notas

✤ Si selecciona <Back> (Volver) en el menú, aparece el
menú anterior.

✤ Mantenga pulsado el botón [Menu] en la modalidad Video
Record <Grabar video>, así podrá ir directamente a
Settings <Ajustes>.

Ajuste del Programa AE (Exposición automática programada)
Permite ajustar la apertura para adaptarla a diferentes condiciones.

1. Deslice hacia abajo el [Selector de modalidad] para
encender la CAM.
� Aparece la pantalla <Video Record> (Grabar video).

2. Presione el botón [Menu] y deslice el interruptor
[ � /� ]. 
Presione el botón [OK] tras seleccionar <Settings>
(Ajustes).

3. Deslice el interruptor [ � /� ] hasta seleccionar
<Program AE> (Programa AE) y presione el botón [OK].
� <Auto> (Autom.): balance automático entre el objeto y el

fondo para obtener el mejor resultado. La velocidad del
obturador se ajusta automáticamente entre 1/60 y 1/250
por segundo, según la escena que se esté grabando.

� <Sports> (Deportes) (       ): para grabación rápida con
movimiento de gente u objetos. Es ideal para
acontecimientos deportivos y grabaciones de exterior en
coche.

� <Spotlight> (Flash) (       ): compensa un objeto que
aparece demasiado brillante bajo la luz directa, como un
foco. Es ideal para conciertos y actuaciones.

� <Sand / Snow> (Arena/Nieve) (       ): se utiliza cuando
la luz es muy fuerte, como en la playa o en la nieve.

� <HS Shutter> (Obturador HS) (       ): permite tomar
imágenes en rápido movimiento por fotogramas.

4. Deslice el interruptor [ � /� ] hasta seleccionar el ajuste
que desea y presione el botón [OK].

5. Presione el botón [Menu] para finalizar el ajuste.
� Aparece el icono de la función seleccionada.
� Si selecciona <Auto> (Autom.), no aparece ningún icono.
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Setting the BLC (Backlight Compensation)
The Backlight Compensation function helps to make the subject
brighter when the subject is in front of a window or the subject is too
dark to distinguish. You can use this function when 
using your the CAM in bright or snowy backgrounds.

1. Slide [Mode Selector] down to turn on the CAM.
� The Video Record screen appears. 

2. Press the [Menu] button and slide the [ � /� ] switch. 
Press the [OK] button after selecting <Settings>.

3. Slide the [ � /� ] switch to select <BLC> and
press the [OK] button.
� On(       ): Set the BLC function.
� Off: Cancel the BLC function.

4. Slide the [ � /� ] switch to select desired
setting and press the [OK] button.

5. Press the [Menu] button to finish setting.
� <     > is displayed.

Notes

✤ If you select <Back> in the menu, the previous
menu appears.

✤ Press and hold the [Menu] button in Video Record
mode, you can move to <Settings> directly.
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Modalidad de video: 
Ajustes de diversas funciones

Notas

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.

✤ Mantenga pulsado el botón [Menu] en la modalidad
Video Record <Grabar video>, así podrá ir
directamente a Settings <Ajustes>.

Ajuste de BLC (Compensación de luz de fondo)
La función de compensación de luz de fondo ayuda a que el objeto
sea más brillante cuando se encuentra frente a una ventana o es  

muy difícil de distinguir por ser demasiado oscuro.
Puede utilizar esta función al utilizar la CAM en
entornos brillantes o nevados.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM.
� Aparece la pantalla <Video Record> (Grabar

video).

2. Presione el botón [Menu] y deslice el interruptor
[ � /� ]. 
Presione el botón [OK] tras seleccionar
<Settings> (Ajustes).

3. Deslice el interruptor [ � /� ] hasta seleccionar
<BLC> y presione el botón [OK].
� <On> (Act.) (          ): fija la función BLC.
� <Off> (Des.): cancela la función BLC.

4. Deslice el interruptor [ � /� ] hasta seleccionar
el ajuste que desea y presione el botón [OK].

5. Presione el botón [Menu] para finalizar el ajuste.
� Aparece <         >.
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Video Mode : Setting Various Functions

Setting the Effect
You can create professional looking effects on your video file.

1. Slide [Mode Selector] down to turn on the CAM.
� The Video Record screen appears.

2. Press the [Menu] button and slide the [ � /� ]
switch. 
Press the [OK] button after selecting <Settings>.

3. Slide the [ � /� ] switch to select <Effect> and press
the [OK] button.
� Off: Cancels the <Effect>.
� Art: Adds artistic effects to your video file.
� Mosaic: A mosaic overlay appears on your video file.
� Sepia: The picture is displayed in sepia color similar

to that of an old photograph.
� Negative: Reverses the colors, creating the look of a

negative.
� Mirror : This mode cuts the picture in half using a

Mirror effect.
� B&W: Changes the images into Black and White.
� Emboss: Embossing effects on your video file.

4. Slide the [ � /� ] switch to select desired setting and
press the [OK] button.

5. Press the [Menu] button to finish setting.
� The Effect icon is displayed in the lower right corner.

Notes

✤ If you select <Back> in the menu, the previous menu appears.
✤ Press and hold the [Menu] button in Video Record mode, you

can move to <Settings> directly.
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Modalidad de video: 
Ajustes de diversas funciones

Ajuste del efecto
Es posible crear efectos de aspecto profesional en su archivo de video.

1. Deslice hacia abajo el [Selector de modalidad] para
encender la CAM.
� Aparece la pantalla <Video Record> (Grabar video).

2. Presione el botón [Menu] y deslice el interruptor
[ � /� ]. 
Presione el botón [OK] tras seleccionar <Settings>
(Ajustes).

3. Deslice el interruptor [ � /� ] hasta seleccionar
<Effect> (Efecto) y presione el botón [OK].
� <Off> (Des.): cancela el efecto.
� <Art> (Arte): añade efectos artísticos en el archivo de

video.
� <Mosaic> (Mosaico): en el video aparece una

presentación en mosaico.
� Sepia: la imagen aparece en color sepia similar a una

fotografía antigua.
� <Negative> (Negativo): invierte los colores, creando

el aspecto en negativo.
� <Mirror> (Espejo): esta modalidad divide la imagen

en dos, empleando un efecto de espejo.
� <B&W> (B/N): cambia la imagen a blanco y negro
� <Emboss> (Relieve): efectos de relieve en el archivo

de video.
4. Deslice el interruptor [ � /� ] hasta seleccionar el

ajuste que desea y presione el botón [OK].
5. Presione el botón [Menu] para finalizar el ajuste.

� Aparece el icono de efecto en la esquina inferior
derecha.

Notas

✤ Si selecciona <Back> (Volver) en el menú, aparece el
menú anterior.

✤ Mantenga pulsado el botón [Menu] en la modalidad Video
Record <Grabar video>, así podrá ir directamente a
Settings <Ajustes>.
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Setting the Digital Zoom
Zooming more than 10x is achieved digitally, up to
100X when combined with optical zoom. The Digital
Zoom processes data to enlarge the center portion of
the image to fill the frame. 
It may produce a less detailed and slightly grainy
picture.

1. Slide [Mode Selector] down to turn on the
CAM.
� The Video Record screen appears. 

2. Press the [Menu] button and slide the [� /� ]
switch.
Press the [OK] button after selecting
<Settings>.

3. Slide the [ � /� ] switch to select <Digital
Zoom> and press the [OK] button.
� On: Sets the Digital Zoom. (X100)
� Off: Cancels the Digital Zoom.

4. Slide the [ � /� ] switch to select desired
setting and press the [OK] button.

5. Press the [Menu] button to finish setting.
� 4 zoom indicators increase after setting the

Digital Zoom.

Notes

✤ If you select <Back> in the menu, the previous menu appears.
✤ Press and hold the [Menu] button in Video Record

mode, you can move to <Settings> directly.
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ESPAÑOLModalidad de video: 
Ajustes de diversas funciones

Ajuste del zoom digital
Un zoom por encima de 10x se obtiene digitalmente
hasta 100x cuando se combina con el zoom óptico.
El zoom digital procesa los datos para ampliar la
parte central de la imagen de forma que llene el
fotograma. Puede producir una imagen con menos
detalles y ligeramente granulosa.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM.
� Aparece la pantalla <Video Record> (Grabar video).

2. Presione el botón [Menu] y deslice el interruptor
[ � /� ]. 
Presione el botón [OK] tras seleccionar
<Settings> (Ajustes).

3. Deslice el interruptor [ � /� ] hasta seleccionar
<Digital Zoom> (Zoom digital) y presione el
botón [OK].
� <On> (Act.): fija el zoom digital. (X100)
� <Off> (Des.): cancela el zoom digital

4. Deslice el interruptor [ � /� ] hasta seleccionar
el ajuste que desea y presione el botón [OK].

5. Presione el botón [Menu] para finalizar el ajuste.
� 4 indicadores de zoom aumentan tras definir el

zoom digital.

Notas

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.

✤ Mantenga pulsado el botón [Menu] en la modalidad
Video Record <Grabar video>, así podrá ir
directamente a Settings <Ajustes>.
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Photo Mode : Capturing

Capturing Images
You can take photos as well as record video files.

1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select Photo
mode and press the [OK] button.
� The CAM is ready for taking pictures.
� [     ] indicator is displayed on LCD.

3. Press [Record /Stop] button to take pictures.

Note

✤ If the battery is low and the battery charge icon blinks, the light will
not operate and the light icon(     ) will not appear in the LCD screen.
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Mode Selection

MP3

Voice Recorder

File Browser

Video

Photo

Capturing...

800Photo Capture

800Photo Capture

Modalidad de foto: Captura

Captura de imágenes
Puede tomar fotos y grabar archivos de video.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo
de nuevo.
� Aparece la pantalla <Mode Selection>

(Selección de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
la modalidad Photo (Foto) y presione el botón
[OK].
� La CAM está lista para tomar imágenes.
� Aparece el indicador [      ] en la pantalla LCD.

3. Presione el botón [Record/Stop] para tomar
imágenes.

Nota

✤ Si la batería está baja y el icono de carga de la batería parpadea, la
luz no funcionará y el icono de luz (     ) no aparecerá en la pantalla
LCD.
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Zooming In and Out
Zooming lets you change the size of the subject captured in a scene.

1. Slide [Mode Selector] down to turn on the CAM and slide it
down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select Photo mode and press the
[OK] button. 
� To take pictures, press the [Record/Stop] button again.

Note

✤ Frequent use of zooming may result in
higher battery power consumption.

ENGLISH ENGLISH
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Slide the [ � /� ] switch
up to zoom out.
� The subject appears farther

away when you zoom out.

Slide the [ � /� ] switch
down to zoom in.
� The subject appears closer 

when you zoom in.

BLC

800Photo Capture

800Photo Capture

800Photo Capture

Video Record

00:16 / 24:32

Zoom In

Zoom Out

Acercamiento y alejamiento de las imágenes

Modalidad de foto: Captura

El uso de la técnica del zoom permite modificar el tamaño del
encuadre de las escenas.

1. Deslice hacia abajo el [Selector de modalidad] para encender la
CAM y deslícelo hacia abajo de nuevo.
� Aparece la pantalla <Mode Selection> (Selección de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar la modalidad
Photo (Foto) y presione el botón [OK].
� Para tomar imágenes, presione de nuevo el botón [Record/Stop].

Nota

✤ El uso frecuente del zoom puede producir un
consumo más alto de la batería.

Deslice el interruptor [ � /� ]
hacia arriba para alejar el
zoom.
� El objeto se aleja al alejar el

zoom.

Deslice el interruptor [ � /� ]
hacia abajo para acercar el 
zoom.
�  El objeto aparece más cerca

cuando se aplica el zoom.
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Photo Mode : Viewing

Viewing Photo files on the LCD Monitor
The LCD monitor allows you to view your photo right after taking them.

1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select Photo
mode and press the [OK] button. 
� The Photo Capture screen appears.

3. Press the [Menu] button and slide the [ � /� ]
switch. 
Press the [OK] button after selecting <View>.

4. Slide the [ � /� ] switch to find the photo you
want to view.
� Each time you slide the [ � /� ] switch, the

frame moves horizontally.
� Each time you press the [+] / [ - ] button,

another page of 6 frames is displayed.  

5. Press [OK] button to view the photo you want.
� The full screen is displayed.

Note

✤ Display time may vary depending on the picture size.
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Modalidad de foto: Visualización

Visualización de archivos de fotos en la pantalla LCD
La pantalla LCD permite ver la foto justo después de tomarla.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo de
nuevo.
� Aparece la pantalla <Mode Selection> (Selección

de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar la
modalidad Photo (Foto) y presione el botón [OK].
� Aparece la pantalla <Photo Capture> (Tomar

foto).

3. Presione el botón [Menu] y deslice el interruptor
[ � /� ]. 
Presione el botón [OK] tras seleccionar <View> (Ver).

4. Deslice el interruptor [ � /� ] hasta encontrar la
foto que desea ver.
� Cada vez que mueva el interruptor [ � /� ],  se

desplaza horizontalmente un fotograma.
� Cada vez que presione el botón [+] / [ - ], aparece

una nueva página (6 fotogramas).

5. Presione el botón [OK] para ver la foto que desea.
� Aparece la pantalla completa.

Nota

✤ El tiempo de visualización puede variar dependiendo
del tamaño de la imagen.
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You can delete photo files in <File Options>.

1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select Photo mode
and press the [OK] button. 
� The Photo Capture screen appears.

3. Press the [Menu] button and slide the [ � /� ]
switch. 
Press the [OK] button after selecting <View>.

4. Slide the [ � /� ] switch to select the photo file
you want to delete.

5. Press the [Menu] button to select <File
Options> and press the [OK] button.
� You can select <File Options> only in Photo

View mode.

6. Slide the [ � /� ] switch to select <Delete> and
press the [OK] button.

7. Slide the [ � /� ] switch to select the following
and press the [OK] button.
� Selected: The selected photo file is deleted.
� All: All photo files are deleted. 
� Cancel: Cancel deleting photo files.

Note

✤ Press and hold the [Menu] button in Photo View
mode, you can move to <File Options> directly.
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Modalidad de foto: 
Selección de opciones de archivo

Eliminación de archivos de fotos
Los archivos de foto se pueden borrar en <File Options> 
(Opciones de archivo).

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo de
nuevo.
� Aparece la pantalla <Mode Selection> (Selección

de modalidad).
2. Deslice el interruptor [ � /� ] hasta seleccionar la

modalidad Photo (Foto) y presione el botón [OK].
� Aparece la pantalla <Photo Capture> (Tomar foto).

3. Presione el botón [Menu] y deslice el interruptor
[ � /� ]. 
Presione el botón [OK] tras seleccionar <View> (Ver).

4. Deslice el interruptor [ � /� ] hasta seleccionar el
archivo de foto que desea borrar.

5. Presione el botón [Menu] hasta seleccionar <File
Options> (Opciones de archivo) y presione el
botón [OK].
� Puede seleccionar File Options <Opciones de

archivo> sólo en la modalidad Photo View <Ver foto>.
6. Deslice el interruptor [ � /� ] hasta seleccionar

<Delete> (Borrar) y presione el botón [OK].
7. Deslice el interruptor [ � /� ] para seleccionar

entre los siguientes y presione el botón [OK].
� <Selected> (Seleccionado): se borra el archivo

de foto seleccionado.
� <All> (Todo): se borran todos los archivos de fotos.
� <Cancel> (Cancelar): cancela la supresión de

archivos de fotos.

Nota

✤ Mantenga pulsado el botón [Menu] en la modalidad
Photo View <Ver foto>, así podrá ir directamente a
File Options <Opciones de archivo>.
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Locking Photo files
You can lock important photo files so they can not be deleted.

1. Slide [Mode Selector] down to turn on the CAM and
slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select Photo mode and
press the [OK] button. 
� The Photo Capture screen appears.

3. Press the [Menu] button and slide the [ � /� ]
switch. 
Press the [OK] button after selecting <View>.

4. Slide the [ � /� ] switch to select the photo file you
want to lock.

5. Press the [Menu] button to select <File Options>
and press the [OK] button.
� You can select <File Options> only in Photo View

mode.

6. Slide the [ � /� ] switch to select <Lock> and press
the [OK] button.

7. Slide the [ � /� ] switch to select from the following
and press the [OK] button.
� Selected: The selected photo file is locked.
� All: All photo files are locked.
� Cancel: Cancel locking photo files.

Notes

✤ Press and hold the [Menu] button in Photo View mode, you
can move to <File Options> directly.

✤ The <      > icon is displayed when the file is locked.
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Modalidad de foto: 
Selección de opciones de archivo

Bloqueo de archivos de fotos
Puede bloquear archivos de fotos importantes para no borrarlos.

1. Deslice hacia abajo el [Selector de modalidad] para
encender la CAM y deslícelo hacia abajo de nuevo.
� Aparece la pantalla <Mode Selection> (Selección de

modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar la
modalidad Photo (Foto) y presione el botón [OK].
� Aparece la pantalla <Photo Capture> (Tomar foto).

3. Presione el botón [Menu] y deslice el interruptor [ � /� ]. 
Presione el botón [OK] tras seleccionar <View> (Ver).

4. Deslice el interruptor [ � /� ] hasta seleccionar el
archivo de foto que desea bloquear.

5. Presione el botón [Menu] hasta seleccionar <File
Options> (Opciones de archivo) y presione el botón
[OK].
� Puede seleccionar File Options <Opciones de archivo>

sólo en la modalidad Photo View <Ver foto>. 

6. Deslice el interruptor [ � /� ] hasta seleccionar
<Lock> (Bloquear) y presione el botón [OK].

7. Deslice el interruptor [ � /� ] para seleccionar entre
los siguientes y presione el botón [OK].
� <Selected> (Seleccionado): se bloquea el archivo de

foto seleccionado.
� <All> (Todo): se bloquean todos los archivos de fotos.
� <Cancel> (Cancelar): cancela el bloqueo de archivos

de foto.

Notas

✤ Mantenga pulsado el botón [Menu] en la modalidad
Photo View <Ver foto>, así podrá ir directamente a File
Options <Opciones de archivo>.

✤ Aparece el icono <      > cuando se bloquea el archivo.
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DPOF (Digital Printing Order Format) creates print information for photos
you select and numbers them on the Memory Stick or Memory Stick Pro. 
You can easily make prints on a DPOF compatible 
printer or order copies.
1. Slide [Mode Selector] down to turn on the CAM

and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select Photo mode
and press the [OK] button. 
� The Photo Capture screen appears.

3. Press the [Menu] button and slide the [ � /� ]
switch. 
Press the [OK] button after selecting <View>.

4. Slide the [ � /� ] switch to select the photo file
you want to print.

5. Press the [Menu] button to select <File Options>
and press the [OK] button.

6. Slide the [ � /� ] switch to select <DPOF> and
press the [OK] button.
� You can select <DPOF> only when you’ve

selected ‘External’ as the storage type. Refer to
page 33.

7. Slide the [ � /� ] switch to select the number of
copies you want to print and press the [OK]
button to set.

Setting DPOF (Digital Print Order Format) Function

Notes

✤ Press and hold the [Menu] button in Photo View mode, you
can move to <File Options> directly.

✤ Refer to page 123 for further details about DPOF function
and printing DPOF files.

✤ You can set up to 30 copies for DPOF printing.
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Modalidad de foto: 
Selección de opciones de archivo

DPOF (Digital Printing Order Format, Formato de orden de impresión digital)
crea información de impresión para fotos y los numera en el Memory Stick o en 

el Memory Stick Pro. Puede fácilmente realizar impresiones 
en una impresora compatible con DPOF o solicitar copias.

1. Deslice hacia abajo el [Selector de modalidad] para
encender la CAM y deslícelo hacia abajo de nuevo.
� Aparece la pantalla <Mode Selection> (Selección de

modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar la
modalidad Photo (Foto) y presione el botón [OK].
� Aparece la pantalla <Photo Capture> (Tomar foto).

3. Presione el botón [Menu] y deslice el interruptor
[� /� ]. 
Presione el botón [OK] tras seleccionar <View> (Ver).

4. Deslice el interruptor [ � /� ] hasta seleccionar el
archivo de foto que desea imprimir.

5. Presione el botón [Menu] hasta seleccionar <File
Options> (Opciones de archivo) y presione el botón
[OK].

6. Deslice el interruptor [ � /� ] hasta seleccionar
<DPOF> y presione el botón [OK].
� Puede seleccionar <DPOF> sólo cuando haya

seleccionado <External> (Externo) como el tipo de
almacenamiento. Consulte la página 33.

7. Deslice el interruptor [ � /� ] para seleccionar el
número de copias que desea imprimir y pulse el
botón [OK] para fijarlo.

Ajuste de la función DPOF (Formato de orden de impresión digital)

Notas

✤ Mantenga pulsado el botón [Menu] en la modalidad
Photo View <Ver foto>, así podrá ir directamente a File
Options <Opciones de archivo>.

✤ Consulte la página 123 para obtener información adicional
sobre la función DPOF y la impresión de archivos DPOF.

✤ Puede definir hasta 30 copias para la impresión de
DPOF.
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Copying Photo files
You can copy photo files to the internal or external memory.

1. Slide [Mode Selector] down to turn on the CAM and
slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select Photo mode and
press the [OK] button. 
� The Photo Capture screen appears.

3. Press the [Menu] button and slide the [ � /� ]
switch. 
Press the [OK] button after selecting <View>.

4. Slide the [ � /� ] switch to select the photo file you
want to copy.

5. Press the [Menu] button to select <File Options>
and press the [OK] button.
� You can select <File Options> only in Photo View mode. 

6. Slide the [ � /� ] switch to select <Copy To> and
press the [OK] button.
� If you selected ‘External’ as the Storage type, the file

is copied to ‘Internal’ and vice versa.

7. Slide the [ � /� ] switch to select from the following
and press the [OK] button.
� Selected: Copy the selected photo file.
� All: Copy all photo files.
� Cancel: Cancel copying photo files.

Note

✤ Press and hold the [Menu] button in Photo View mode, you
can move to <File Options> directly.
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Modalidad de foto: 
Selección de opciones de archivo

Copia de archivos de fotos
Puede copiar archivos de fotos en la memoria interna o externa.

1. Deslice hacia abajo el [Selector de modalidad] para
encender la CAM y deslícelo hacia abajo de nuevo.
� Aparece la pantalla <Mode Selection> (Selección de

modalidad).
2. Deslice el interruptor [ � /� ] hasta seleccionar la

modalidad Photo (Foto) y presione el botón [OK].
� Aparece la pantalla <Photo Capture> (Tomar foto).

3. Presione el botón [Menu] y deslice el interruptor
[ � /� ]. 
Presione el botón [OK] tras seleccionar <View> (Ver).

4. Deslice el interruptor [ � /� ] hasta seleccionar el
archivo de foto que desea copiar.

5. Presione el botón [Menu] hasta seleccionar <File
Options> (Opciones de archivo) y presione el botón
[OK].
� Puede seleccionar File Options <Opciones de archivo>

sólo en la modalidad Photo View <Ver foto>.
6. Deslice el interruptor [ � /� ] hasta seleccionar <Copy

To> (Copiar en) y presione el botón [OK].
� Si ha seleccionado el tipo de almacenamiento External

(Externo), el archivo se copia en Internal (Interno) y
viceversa.

7. Deslice el interruptor [ � /� ] para seleccionar entre los
siguientes y presione el botón [OK].
� <Selected> (Seleccionado): se copia el archivo

de foto seleccionado.
� <All> (Todo): copia todos los archivos de fotos.
� <Cancel> (Cancelar): cancela la copia de

archivos de fotos.

Nota

✤ Mantenga pulsado el botón [Menu] en la modalidad Photo
View <Ver foto>, así podrá ir directamente a File Options
<Opciones de archivo>.
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Setting the Photo file Size
You can set the photo files size. The amount of photo files that can
be stored depends on the Memory Stick capacity and photo file size.

1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select Photo mode
and press the [OK] button. 
� The Photo Capture screen appears.

3. Press the [Menu] button and slide the [ � /� ]
switch. 
Press the [OK] button after selecting <Settings>.

4. Slide the [ � /� ] switch to select <Size> and
press the [OK] button.
� You can select 800x600 or 640x480 size.

5. Slide the [ � /� ] switch to select desired
setting and press the [OK] button.

6. Press the [Menu] button to finish setting.

Notes

✤ If you select <Back> in the menu, the previous menu
appears.

✤ Press and hold the [Menu] button in Photo Capture
mode, you can move to <Settings> directly.
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Modalidad de foto: 
Ajustes de diversas funciones

Ajuste del tamaño del archivo de foto
Puede definir el tamaño de los archivos de fotos. La cantidad de
archivos de fotos que se puede almacenar depende de la capacidad  

del Memory Stick y del tamaño del archivo de foto.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo
de nuevo.
� Aparece la pantalla <Mode Selection> (Selección

de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
la modalidad Photo (Foto) y presione el botón
[OK].
� Aparece la pantalla <Photo Capture> (Tomar foto).

3. Presione el botón [Menu] y deslice el
interruptor [ � /� ]. 
Presione el botón [OK] tras seleccionar
<Settings> (Ajustes).

4. Deslice el interruptor [ � /� ] hasta seleccionar
<Size> (Tamaño) y presione el botón [OK].
� Puede seleccionar el tamaño 800x600 ó

640x480.

5. Deslice el interruptor [ � /� ] hasta seleccionar
el ajuste que desea y presione el botón [OK].

6. Presione el botón [Menu] para finalizar el
ajuste.

Notas

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.

✤ Mantenga pulsado el botón [Menu] en la modalidad
Photo Capture <Tomar foto>, así podrá ir
directamente a Settings <Ajustes>.
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Setting the Light
The Light only works in Photo Mode and allows the user to take
photos where there is insufficient light.

1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select Photo mode
and press the [OK] button. 
� The Photo Capture screen appears.

3. Press the [Menu] button and slide the [ � /� ]
switch. 
Press the [OK] button after selecting <Settings>.

4. Slide the [ � /� ] switch to select <Light> and
press the [OK] button.

5. Slide the [ � /� ] switch to select desired
setting and press the [OK] button.
� Auto: Sets the light automatically.
� On(   ): Turns on the light.
� Off(   ): Turns off the light.

6. Press the [Menu] button to finish setting.
� The selected function icon is displayed.

Notes

✤ If you select <Back> in the menu, the previous menu
appears.

✤ Press and hold the [Menu] button in Photo Capture
mode, you can move to <Settings> directly.

✤ If the battery is low and the battery charge icon blinks,
the light will not operate and light icon is set to off state.
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Modalidad de foto: 
Ajustes de diversas funciones

Ajuste de luz
La luz sólo funciona en la modalidad de foto y permite al usuario

tomar fotos en situaciones de falta de luz.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo de
nuevo.
� Aparece la pantalla <Mode Selection> (Selección

de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
la modalidad [Photo] y presione el botón [OK].
� Aparece la pantalla <Photo Capture> (Tomar foto).

3. Presione el botón [Menu] y deslice el interruptor
[ � /� ]. 
Presione el botón [OK] tras seleccionar
<Settings> (Ajustes).

4. Deslice el interruptor [ � /� ] hasta seleccionar
<Light> (Luz) y presione el botón [OK].

5. Deslice el interruptor [ � /� ] hasta seleccionar
el ajuste que desea y presione el botón [OK].
� <Auto> (Autom.): fija la luz automáticamente.
� <On> (Act.) (      ): enciende la luz.
� <Off> (Des.) (      ): apaga la luz.

6. Presione el botón [Menu] para finalizar el ajuste.
� Aparece el icono de la función seleccionada.

Notas

✤ Si selecciona <Back> (Volver) en el menú, aparece el
menú anterior.

✤ Mantenga pulsado el botón [Menu] en la modalidad
Photo Capture <Tomar foto>, así podrá ir directamente
a Settings <Ajustes>.

✤ Si la batería está baja y aparece el icono de carga de la
batería de forma intermitente, la luz no funcionará y el
icono de luz aparecerá con el estado de apagado.
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Setting the Focus
You can set the focus depending on the subject or the environment. 
In most situations, you can record the best photo using AF(Auto Focus).

1. Slide [Mode Selector] down to turn on the CAM and
slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select Photo mode and
press the [OK] button. 
� The Photo Capture screen appears.

3. Press the [Menu] button and slide the [� /� ] switch. 
Press the [OK] button after selecting <Settings>.

4. Slide the [ � /� ] switch to select <Focus> and
press the [OK] button.
� AF: Sets the focus automatically. When the CAM

turns on, AF is selected by default.
� MF(     ): Sets the focus manually.

5. Slide the [ � /� ] switch to select the desired setting
and press the [OK] button.

6. Press the [Menu] button to finish setting.
� The selected function icon is displayed.
� If you select  AF, no icon is displayed.

Notes

✤ If you select <Back> in the menu, the previous menu appears. 
✤ Press and hold the [Menu] button in Photo Capture mode, you

can move to <Settings> directly.

Adjust the focus using [ + ] / [ - ] button to zoom in
or out manually.
� When a picture has subjects close or distant to the CAM
� When a person is enveloped in fog or surrounded by 

snow

Manual Focus
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Modalidad de foto: 
Ajustes de diversas funciones

Ajuste del enfoque
Puede definir el enfoque dependiendo del objeto o del entorno.
En la mayoría de las situaciones, la mejor forma de tomar fotos es con AF    
(Enfoque automático). 

1. Deslice hacia abajo el [Selector de modalidad] para
encender la CAM y deslícelo hacia abajo de nuevo.
� Aparece la pantalla <Mode Selection> (Selección de

modalidad).
2. Deslice el interruptor [ � /� ] hasta seleccionar la

modalidad [Photo] y presione el botón [OK].
� Aparece la pantalla <Photo Capture> (Tomar foto).

3. Presione el botón [Menu] y deslice el interruptor
[ � /� ]. 
Presione el botón [OK] tras seleccionar <Settings>
(Ajustes).

4. Deslice el interruptor [ � /� ] hasta seleccionar
<Focus> (Enfoque) y presione el botón [OK].
� AF: ajusta el enfoque automáticamente. Cuando se

enciende la CAM, AF se selecciona por omisión.
� MF(       ): fija el enfoque manual.

5. Deslice el interruptor [ � /� ] hasta seleccionar el
ajuste que desea y presione el botón [OK].

6. Presione el botón [Menu] para finalizar el ajuste.
� Aparece el icono de la función seleccionada.
� Si selecciona AF, no aparece ningún icono.

Notas

✤ Si selecciona <Back> (Volver) en el menú, aparece el
menú anterior.

✤ Mantenga pulsado el botón [Menu] en la modalidad Photo
Capture <Tomar foto>, así podrá ir directamente a Settings
<Ajustes>.

Enfoque utilizando el botón [+] / [ - ] para acercar o alejar
el zoom manualmente.
� Cuando una imagen tenga objetos cerca y lejos de la CAM
� Cuando haya una persona entre la niebla o rodeada de nieve.

Enfoque manual
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Setting the EIS (Electronic Image Stabilizer)
The Electrical Image Stabilizer is a function that compensates for
hand shake and other movements while taking pictures. 
Refer to page 49 for further details.

1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select Photo mode
and press the [OK] button. 
� The Photo Capture screen appears.

3. Press the [Menu] button and slide the [ � /� ]
switch. 
Press the [OK] button after selecting <Settings>.

4. Slide the [ � /� ] switch to select <EIS> and
press the [OK] button.
� On( ): Sets the EIS function.
� Off : Cancels the EIS function.

5. Slide the [ � /� ] switch to select the desired
setting and press the [OK] button.

6. Press the [Menu] button to finish setting.
� The icon of selected function is displayed.

Notes

✤ If you select <Back> in the menu, the previous
menu appears.

✤ Press and hold the [Menu] button in Photo Capture
mode, you can move to <Settings> directly.
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800Photo Capture

View

Capture

Settings

Back

Size 800 x 600

White Balance Auto

Focus AF

Light Auto

Photo SettingsPhoto Settings

Size 800 x 600

White Balance Auto

Focus AF

Light Auto

EIS On

Size

White Balance Auto

Focus AF

Light Auto

800 x 600

Photo SettingsPhoto Settings

Size

White Balance Auto

Focus AF

Light Auto

800 x 600

EIS Off

800Photo Capture

Modalidad de foto: 
Ajustes de diversas funciones

Notas

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.

✤ Mantenga pulsado el botón [Menu] en la modalidad
Photo Capture <Tomar foto>, así podrá ir
directamente a Settings <Ajustes>.

Ajuste de EIS (Estabilizador electrónico de la imagen)
El estabilizador electrónico de la imagen es una función que compensa
los temblores de la mano y otros movimientos mientras toma imágenes.

Consulte la página 49 para obtener más detalles.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo
de nuevo.
� Aparece la pantalla <Mode Selection>

(Selección de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
la modalidad [Photo] y presione el botón [OK]. 
� Aparece la pantalla <Photo Capture> (Tomar foto).

3. Presione el botón [Menu] y deslice el
interruptor [ � /� ]. 
Presione el botón [OK] tras seleccionar
<Settings> (Ajustes).

4. Deslice el interruptor [ � /� ] hasta seleccionar
EIS y presione el botón [OK].
� <On> (Act.) (       ): ajusta la función EIS.
� <Off> (Des.): cancela la función EIS.

5. Deslice el interruptor [ � /� ] hasta seleccionar
el ajuste que desee y presione el botón [OK].

6. Presione el botón [Menu] para finalizar el
ajuste.
� Aparece el icono de la función seleccionada.
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Setting the White Balance
The color balance may vary depending on the lighting conditions. 
The White Balance is used to preserve natural colors under different lighting
conditions.

1. Slide [Mode Selector] down to turn on the CAM and
slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select Photo mode and
press the [OK] button. 
� The Photo Capture screen appears.

3. Press the [Menu] button and slide the [ � /� ] switch. 
Press the [OK] button after selecting <Settings>.

4. Slide the [ � /� ] switch to select <White Balance>
and press the [OK] button.
� Auto: The color is adjusted automatically depending

on the condition.
� Hold(      ): Records and holds (Locks) selected White

Balance setting.
� Outdoor(     ): Records with natural light.
� Indoor(     ): Records with the indoor lighting.

5. Slide the [ � /� ] switch to select the desired setting
and press the [OK] button.

6. Press the [Menu] button to finish setting.
� The selected function icon is displayed.
� If you select <Auto>, no icon is displayed.

Notes

✤ If you select <Back> in the menu, the previous menu
appears.

✤ Press and hold the [Menu] button in Photo Capture mode,
you can move to <Settings> directly.
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View

Capture

Settings

Back

Focus

EIS

Size

Light Auto
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AF
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Photo SettingsPhoto Settings

Focus
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EIS
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On

Photo SettingsPhoto Settings
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White Balance Hold

Capturing...
BLC

800Photo Capture

Modalidad de foto: 
Ajustes de diversas funciones

Notas

✤ Si selecciona <Back> (Volver) en el menú, aparece el menú
anterior.

✤ Mantenga pulsado el botón [Menu] en la modalidad Photo
Capture <Tomar foto>, así podrá ir directamente a Settings
<Ajustes>.

Ajuste del balance de blanco
El balance de color puede variar dependiendo de las condiciones de luz. <White
Balance> (Balance de blanco) se utiliza para conserva los colores naturales bajo     
diferentes condiciones de luz.

1. Deslice hacia abajo el [Selector de modalidad] para
encender la CAM y deslícelo hacia abajo de nuevo.
� Aparece la pantalla <Mode Selection> (Selección de

modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar la
modalidad Photo (Foto) y presione el botón [OK].
� Aparece la pantalla <Photo Capture> (Tomar foto).

3. Presione el botón [Menu] y deslice el interruptor
[ � /� ]. 
Presione el botón [OK] tras seleccionar <Settings>
(Ajustes).

4. Deslice el interruptor [ � /� ] hasta seleccionar <White
Balance> (Balance de blanco) y presione el botón [OK].
� <Auto> (Autom.): el color se ajusta automáticamente

dependiendo de las condiciones.
� <Hold> (Mantener) (        ): graba y mantiene

seleccionado (bloquea) el ajuste seleccionado de
balance de blanco.

� <Outdoor> (Exterior) (        ): graba con luz natural.
� <Indoor> (Interior) (        ): graba con luz de interior.

5. Deslice el interruptor [ � /� ] hasta seleccionar el ajuste
que desee y presione el botón [OK].

6. Presione el botón [Menu] para finalizar el ajuste.
� Aparece el icono de la función seleccionada.
� Si selecciona <Auto> (Autom.), no aparece ningún icono.
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Setting the Program AE (Programmed Auto Exposure)
It allows you to adjust the aperture setting to suit different conditions.

1. Slide [Mode Selector] down to turn on the 
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select Photo mode and
press the [OK] button. 
� The Photo Capture screen appears.

3. Press the [Menu] button and slide the [� /� ] switch. 
Press the [OK] button after selecting <Settings>.

4. Slide the [ � /� ] switch to select <Program AE> and
press the [OK] button.
� Auto: Auto balances between the subject and

background to get the best result.  The shutter speed
automatically varies from 1/60 to 1/250 per second
depending on the scene.

� Sports(     ): For fast-moving people or objects. It is 
suitable for sports events or when you are outside in
the car.

� Spotlight(     ): Compensates for a subject that
appears too bright under strong direct light such as
spotlight. It is suitable for concerts and school
performances. 

� Sand/Snow(     ): Use when the light is very strong 
such as on the beach or in the snow.

� HS Shutter(     ): Allows fast-moving images to be  
captured one frame at a time.

5. Slide the [ � /� ] switch to select the desired setting
and press the [OK] button.

6. Press the [Menu] button to finish setting.
� The selected function icon is displayed.
� If you select <Auto>, any icon is not displayed.

Notes

✤ If you select <Back> in the menu, the previous menu appears.
✤ Press and hold the [Menu] button in Photo Capture mode, you can

move to <Settings> directly.
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Capturing...
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Modalidad de foto: 
Ajustes de diversas funciones

Notas

✤ Si selecciona <Back> (Volver> en el menú, aparece el
menú anterior.

✤ Mantenga pulsado el botón [Menu] en la modalidad Photo
Capture <Tomar foto>, así podrá ir directamente a Settings
<Ajustes>.

Ajuste del Programa AE (Exposición automática programada)
Permite ajustar la apertura para adaptarla a diferentes condiciones.

1. Deslice hacia abajo el [Selector de modalidad] para
encender la CAM y deslícelo hacia abajo de nuevo.
� Aparece la pantalla <Mode Selection> (Selección de

modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar la
modalidad Photo (Foto) y presione el botón [OK].
� Aparece la pantalla <Photo Capture> (Tomar foto).

3. Presione el botón [Menu] y deslice el interruptor [ � /� ]. 
Presione el botón [OK] tras seleccionar <Settings> (Ajustes).

4. Deslice el interruptor [ � /� ] hasta seleccionar
Program <AE> (Programa AE) y presione el botón [OK].
� <Auto> (Autom.): balance automático entre el objeto y

el fondo para obtener el mejor resultado.
La velocidad del obturador se ajusta automáticamente
entre 1/60 y 1/250 por segundo, según la escena que se
esté grabando.

� <Sports> (Deportes) (       ): para movimiento de gente
u objetos. es ideal para acontecimientos deportivos o en
exteriores en coche.

� <Spotlight> (Flash) (       ): compensa un objeto que
aparece demasiado brillante bajo la luz directa, como un
foco. Es ideal para conciertos y actuaciones.

� <Sand / Snow> (Arena/Nieve) (        ): se utiliza cuando
la luz es muy fuerte, como en la playa o en la nieve.

� <HS Shutter> (Obturador HS) (        ): permite capturar
imágenes en rápido movimiento por fotogramas.

5. Deslice el interruptor [ � /� ] hasta seleccionar el
ajuste que desea y presione el botón [OK].

6. Presione el botón [Menu] para finalizar el ajuste.
� Aparece el icono de la función seleccionada.
� Si selecciona <Auto> (Autom.), no aparece ningún icono.
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Setting the BLC (Backlight Compensation)
The Backlight Compensation function helps to make the subject
brighter when the subject is in front of a window or the subject is too
dark to distinguish. You can use this function when 
using the CAM in situations with bright backgrounds.

1. Slide [Mode Selector] down to turn on the CAM
and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select Photo mode
and press the [OK] button. 
� The Photo Capture screen appears.

3. Press the [Menu] button and slide the [ � /� ]
switch. 
Press the [OK] button after selecting <Settings>.

4. Slide the [ � /� ] switch to select <BLC> and
press the [OK] button.
� On(        ): Sets the BLC function.
� Off: Cancels the BLC function.

5. Slide the [ � /� ] switch to select the desired
setting and press the [OK] button.

6. Press the [Menu] button to finish setting.
� <       > is displayed.

Notes

✤ If you select <Back> in the menu, the previous menu
appears.

✤ Press and hold the [Menu] button in Photo Capture
mode, you can move to <Settings> directly.
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Modalidad de foto: 
Ajustes de diversas funciones

Notas

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.

✤ Mantenga pulsado el botón [Menu] en la modalidad
Photo Capture <Tomar foto>, así podrá ir
directamente a Settings <Ajustes>.

Ajuste de BLC (Compensación de luz de fondo)
La función de compensación de luz de fondo ayuda a que el objeto
sea más brillante cuando se encuentra delante de una ventana o es  

muy difícil de distinguir por ser demasiado oscuro.      
Puede utilizar esta función al utilizar la CAM en
situaciones con entornos brillantes o nevados.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo
de nuevo.
� Aparece la pantalla <Mode Selection> (Selección

de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
la modalidad [Photo] y presione el botón [OK].
� Aparece la pantalla <Photo Capture> (Tomar foto).

3. Presione el botón [Menu] y deslice el
interruptor [ � /� ]. 
Presione el botón [OK] tras seleccionar
<Settings> (Ajustes).

4. Deslice el interruptor [ � /� ] hasta seleccionar
<BLC> y presione el botón [OK].
� <On> (Act.) (          ): fija la función BLC.
� <Off> (Des.): cancela la función BLC.

5. Deslice el interruptor [ � /� ] hasta seleccionar
el ajuste que desea y presione el botón [OK].

6. Presione el botón [Menu] para finalizar el ajuste.
� Aparece <         >.
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MP3 Mode : Storing Music in the CAM

Copying Music files to the CAM

Notes

✤ Transferring and playing with the Memory Stick operates in the
same way as the internal memory.

✤ Refer to page 120 for installing USB Driver for Windows98SE.
✤ When connecting the CAM to your PC, if the message ‘USB-D07

Capture Device hasn’t passed Windows Logo testing’ appears, do
not be concerned, it is OK to proceed with file transfer.

You can transfer music files from your PC to the internal memory,
Memory Stick or Memory Stick Pro. For copying music files, the CAM
must be connected to your PC with the USB cable. 

1. Connect the CAM to a PC with the
USB cable. (Refer to page 103) 
� Your computer recognizes the

CAM and the symbol for
removable drive will appear in ‘My
Computer’.

2. Double-click the new removable
drive to open.

3. Select the MP3 folder and double-
click to enter.

4. Drag and drop the MP3 file from 
your PC into the MP3 folder under MSAMSUNG. 
� Refer to the folder structure on page 30 for copying MP3 files. 

After completing the data transfer, you must disconnect the cable in
the following way.
1. Select the removable disk icon and click the right mouse button to

select ‘Safely Remove Hardware’.
2. Select ‘Stop’ and disconnect the USB cable when the pop-up

screen disappears.

Disconnecting USB Connection

Modalidad MP3: 
Almacenamiento de música en la CAM

Notas

✤ Transferir y reproducir con el Memory Stick funciona de igual forma
que la memoria interna.

✤ Consulte la página 120 para instalar el controlador USB para
Windows98SE.

✤ Al conectar la CAM a la PC, si aparece el mensaje 'USB-D07 Capture
Device no ha superado la prueba del logotipo de Windows', no se
preocupe, puede continuar con la transferencia de archivos.

Copia de archivos de música en la CAM
Puede transferir archivos de música desde la PC a la memoria
interna, Memory Stick o Memory Stick Pro. Para copiar archivos de
música, la CAM debe estar conectada a la PC con el cable USB.

1. Conecte la CAM a una PC utilizando
el cable USB. (Consulte la página 103).
� Su PC reconoce la CAM y aparecerá

el símbolo de la unidad extraíble en
‘Mi PC’.

2. Haga doble clic en la nueva unidad
extraíble para abrirla.

3. Seleccione la carpeta MP3 y haga
doble clic en ella para entrar.

4. Arrastre y suelte el archivo MP3
desde la PC a la carpeta MP3 situada
bajo MSAMSUNG.

� Consulte la estructura de carpetas de la página 30 para copiar
los archivos MP3.

Tras completar la transferencia de datos, debe desconectar el cable
de la forma siguiente:
1. Seleccione el icono del disco extraíble y haga clic en el botón

derecho del mouse para seleccionar 'Quitar hardware con
seguridad'.

2. Seleccione 'Detener' y desconecte el cable USB cuando
desaparezca la pantalla emergente.

Desconexión de la conexión USB
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1. Connect the earphones to the CAM.
� You can also hear the music from the Built-in

speaker without the earphones.

2. Slide [Mode Selector] down to turn on the CAM
and slide it down again.
� The Mode Selection screen appears.

3. Slide the [ � /� ] switch to select MP3 mode 
and press the [OK] button.

4. Slide the [ � /� ] switch to find the music you
want to hear and press the [OK] button.
� The selected music is played.

5. Press the [OK] button again to stop hearing music.
� Each time you press the [OK] button, play or

pause is selected alternately.

Notes

✤ ‘----’ is displayed depending on the title of MP3 file.
✤ If you slide the MP3/External Camera Hold switch to on, all buttons

except the Power switch and volume +/- button are locked. 
The MP3/External Camera Hold switch operates only in the
MP3/External Camera mode.

✤ In MP3 playback mode, a file name may not be displayed correctly
or an MP3 file may not playback. In this case, rename the file name
using English alphabets only.

✤ Press the [� ] switch
First 2 seconds after start playing - the previous file appears.
2 seconds after start playing - the first scene of the file appears.

✤ Press the [� ] switch
The next file appears.

The use of [ � /� ] switch

3

4

5

Mode Selection

Voice Recorder

File Browser

Video

Photo

MP3

3  black or white.mp3

5  What a wonderful world.mp3

MP3 Play

4  Let it be.mp3

1  hey jude.mp3

2  I believe I can fly.mp3

MP3 Play

2.  I believe I can fly.mp3

4.4 Kbytes

Stereo 44.1KHz 128Kbps

03:19 / 04:32

Modalidad MP3: Reproducción 

Reproducción de archivos de música
Puede escuchar música copiada desde la PC directamente o con el
Memory Stick.

1. Conecte los audífonos a la CAM.
� Puede escuchar música desde el altavoz

incorporado sin los audífonos.
2. Deslice hacia abajo el [Selector de modalidad]

para encender la CAM y deslícelo hacia abajo
de nuevo.
� Aparece la pantalla <Mode Selection>

(Selección de modalidad).
3. Deslice el interruptor [ � /� ] hasta seleccionar

la modalidad MP3 y presione el botón [OK].
4. Deslice el interruptor [ � /� ] hasta encontrar la

música que desea escuchar y presione el botón
[OK].
� Se reproduce la música seleccionada.

5. Presione de nuevo el botón [OK] para dejar de
escuchar música.
� Cada vez que presione el botón [OK], se reproduce

o se hace una pausa de forma alternativa.

Notas

✤ Aparece ‘----’ dependiendo del título del archivo MP3.
✤ Si desliza el interruptor Hold de cámara externa / MP3, se bloquean todos los

botones excepto el interruptor Power y el botón de volumen +/-. El interruptor
Hold de cámara externa / MP3 sólo está operativo en la modalidad de cámara
externa / MP3.

✤ En la modalidad de reproducción de MP3, un nombre de archivo no puede
verse correctamente o no puede reproducirse un archivo MP3. En este caso,
cambie el nombre al archivo sin utilizar acentos ni caracteres especiales.

✤ Presione el interruptor [� ]
En primer lugar por 2 segundos tras iniciar la
reproducción: aparece el archivo anterior.
2 segundos tras iniciar la reproducción: aparece la
primera escena del archivo.

✤ Presione el interruptor [� ]
Aparece el archivo siguiente.

Uso del interruptor [ � /� ]
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1. Connect the earphones to the CAM.
� You can also hear the music from the Built-in

speaker without the earphones.

2. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

3. Slide the [ � /� ] switch to select MP3 mode
and press the [OK] button.
� Press the [Menu] button when the music list

appears.

4. Slide the [ � /� ] switch to select <Play
Options> and press the [OK] button.

5. Slide the [ � /� ] switch to select <Repeat>
and press the [OK] button.
� All : All files are repeated.
� Off: Cancels the Repeat Play function.
� One : One file is repeated.

6. Slide the [ � /� ] switch to select desired
setting and press the [OK] button.

7. Press the [Menu] button to finish setting.

Note

✤ If you select <Back> in the menu, the previous
menu appears.

ENGLISH ESPAÑOL

3

4

5

6

3  black or white.mp3

5  What a wonderful world.mp3

MP3 Play

4  Let it be.mp3

1  hey jude.mp3

2  I believe I can fly.mp3

2  I belive i can fly.mp3

3  black or white.mp3

1  hey jude.mp3

5  What a wonderful world.mp3

MP3 Play

4  Let it be.mp3

File Options

Back

Play Options

MP3 Play

Back

Repeat All

MP3 Play

Back

Repeat One

Modalidad MP3: 
Selección de opciones de reproducción

Ajuste de <Repeat Play> (Repetir reproducción)
Puede reproducir una canción solamente o toda la música de forma repetida.

1. Conecte los audífonos a la CAM.
� Puede escuchar música desde el altavoz

incorporado sin los audífonos.

2. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo
de nuevo.
� Aparece la pantalla <Mode Selection> (Selección

de modalidad).

3. Deslice el interruptor [ � /� ] hasta seleccionar
la modalidad MP3 y presione el botón [OK].
� Presione el botón [Menu] cuando aparezca la

lista de música.

4. Deslice el interruptor [ � /� ] hasta seleccionar
<Play Options> (Opciones de reproducción) y
presione el botón [OK].

5. Deslice el interruptor [ � /� ] hasta seleccionar
<Repeat> (Repetir) y presione el botón [OK].
� <All> (Todo): se repiten todos los archivos.
� <Off> (Des.): cancela la función de repetir

reproducción.
� <One> (Uno): se repite un archivo.

6. Deslice el interruptor [ � /� ] hasta seleccionar
el ajuste que desea y presione el botón [OK].

7. Presione el botón [Menu] para finalizar el
ajuste.

Nota

✤ Si selecciona <Back> (Volver) en el menú,
aparece el menú anterior.
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MP3 Mode : Selecting File Options

Deleting Music files
You can delete the music file you want.

1. Slide [Mode Selector] down to turn on the
CAM and slide it down again. 
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select MP3 mode
and press the [OK] button. 
� Press the [Menu] button when the music list

appears.

3. Slide the [ � /� ] switch to select <File
Options> and press the [OK] button.

4. Slide the [ � /� ] switch to select <Delete>
and press the [OK] button.

5. Slide the [ � /� ] switch to select from the
following and press the [OK] button.
� Selected: The selected music file is deleted.
� All: All music files are deleted. 
� Cancel: Cancels deleting music files.

Note

✤ If you select <Back> in the menu, the previous
menu appears.

ENGLISHESPAÑOL

2

3

4

5

3  black or white.mp3

5  What a wonderful world.mp3

MP3 Play

4  Let it be.mp3

1  hey jude.mp3

2  I believe I can fly.mp3

2  I belive i can fly.mp3

3  black or white.mp3

1  hey jude.mp3

5  What a wonderful world.mp3

MP3 Play

4  Let it be.mp3

File Options

Back

Play Options

Lock

Copy To

Delete

Back

2  I belive i can fly.mp3

3  black or white.mp3

1  hey jude.mp3

5  What a wonderful world.mp3

MP3 Play

4  Let it be.mp3

Lock

Copy To

Delete

Back

MP3 Play

2.  I belive i can fly.mp3

5.6 Mbytes

Stereo 44.1KHz 128Kbps

03:19 / 04:32

Selected

All

Cancel

Choose the file(s) 
to delete

Modalidad MP3: 
Selección de opciones de archivo

Eliminación de archivos de música

Puede borrar el archivo de música que desee.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo
de nuevo.
� Aparece la pantalla <Mode Selection>

(Selección de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
la modalidad MP3 y presione el botón [OK].
� Presione el botón [Menu] cuando aparezca la

lista de música.

3. Deslice el interruptor [ � /� ] hasta seleccionar
<File Options> (Opciones de archivo) y
presione el botón [OK].

4. Deslice el interruptor [ � /� ] hasta seleccionar
<Delete> (Borrar) y presione el botón [OK].

5. Deslice el interruptor [ � /� ] para seleccionar
entre los siguientes y presione el botón [OK].
� <Selected> (Seleccionado): se borra el archivo

de música seleccionado.
� <All> (Todo): se borran todos los archivos de

música.
� <Cancel> (Cancelar): cancela la supresión de

archivos de música.

Nota

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.
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Locking Music files
You can lock important music files so they can not be deleted.
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1. Slide [Mode Selector] down to turn on the
CAM and slide it down again. 
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select MP3 mode
and press the [OK] button. 
� Press the [Menu] button when the music list

appears.

3. Slide the [ � /� ] switch to select <File
Options> and press the [OK] button.

4. Slide the [ � /� ] switch to select <Lock> and
press the [OK] button.

5. Slide the [ � /� ] switch to select from the
following and press the [OK] button.
� Selected: The selected music file is locked.
� All: All music files are locked. 
� Cancel: Cancels locking music files.

Notes

✤ If you select <Back> in the menu, the previous menu
appears.

✤ The <      > icon is displayed when the file is locked.

ESPAÑOL

2

3

4

5

3  black or white.mp3

5  What a wonderful world.mp3

MP3 Play

4  Let it be.mp3

1  hey jude.mp3

2  I believe I can fly.mp3

2  I belive i can fly.mp3

3  black or white.mp3

1  hey jude.mp3

5  What a wonderful world.mp3

MP3 Play

4  Let it be.mp3

File Options

Back

Play Options

Lock

Copy To

Delete

Back

2  I belive i can fly.mp3

3  black or white.mp3

1  hey jude.mp3

5  What a wonderful world.mp3

MP3 Play

4  Let it be.mp3

Lock

Copy To

Delete

Back

MP3 Play

2.  I belive i can fly.mp3

5.6 Mbytes

Stereo 44.1KHz 128Kbps

03:19 / 04:32

Selected

All

Cancel

Choose the file(s) you would
to lock.

Modalidad MP3: 
Selección de opciones de archivo

Bloqueo de archivos de música
Puede bloquear archivos de música importantes para no borrarlos.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo
de nuevo.
� Aparece la pantalla <Mode Selection>

(Selección de modalidad).

2. Deslice el interruptor [ � /� ] hasta
seleccionar la modalidad MP3 y presione el
botón [OK].
� Presione el botón [Menu] cuando aparezca la

lista de música.

3. Deslice el interruptor [ � /� ] hasta
seleccionar <File Options> (Opciones de
archivo)  y presione el botón [OK].

4. Deslice el interruptor [ � /� ] hasta seleccionar
<Lock> (Bloquear)  y presione el botón [OK].

5. Deslice el interruptor [ � /� ] para seleccionar
entre los siguientes y presione el botón [OK].
� <Selected> (Seleccionado): se bloquea el

archivo de música seleccionado.
� <All> (Todo): se bloquean todos los archivos

de música.
� <Cancel> (Cancelar): cancela el bloqueo de

archivos de música.

Notas

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.

✤ Aparece el icono <      > cuando se bloquea el
archivo.
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MP3 Mode : Selecting File Options

Copying Music files
You can copy the music file to the internal or external memory.

1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select MP3 mode
and press the [OK] button. 
� Press the [Menu] button when the music list

appears.

3. Slide the [ � /� ] switch to select <File
Options> and press the [OK] button.

4. Slide the [ � /� ] switch to select <Copy To>
and press the [OK] button.
� If you selected ‘External’ as the Storage type,

the file is copied to ‘Internal’ and vice versa.

5. Slide the [ � /� ] switch to select from the
following and press the [OK] button.
� Selected: Copies the selected music file.
� All: Copies all music files. 
� Cancel: Cancels copying music files.

Note

✤ If you set the Hold function with the MP3/External
Camera Hold switch, you can’t delete, lock 
or copy music files. You can only use Power switch
and volume [+] / [ - ] buttons.

ENGLISHESPAÑOL

2

3

4

5

3  black or white.mp3

5  What a wonderful world.mp3

MP3 Play

4  Let it be.mp3

1  hey jude.mp3

2  I believe I can fly.mp3

2  I belive i can fly.mp3

3  black or white.mp3

1  hey jude.mp3

5  What a wonderful world.mp3

MP3 Play

4  Let it be.mp3

File Options

Back

Play Options

Lock

Copy To

Delete

Back

2  I belive i can fly.mp3

3  black or white.mp3

1  hey jude.mp3

5  What a wonderful world.mp3

MP3 Play

4  Let it be.mp3

Lock

Copy To

Delete

Back

MP3 Play

2.  I belive i can fly.mp3

5.6 Mbytes

Stereo 44.1KHz 128Kbps

03:19 / 04:32

Selected

All

Cancel

Choose the file(s) to copy
to memory stick?

Modalidad MP3: 
Selección de opciones de archivo

Copia de archivos de música
El archivo de música puede copiarse en la memoria interna o externa.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo de
nuevo.
� Aparece la pantalla <Mode Selection> (Selección

de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
la modalidad MP3 y presione el botón [OK].
� Presione el botón [Menu] cuando aparezca la lista

de música.

3. Deslice el interruptor [ � /� ] hasta seleccionar
<File Options> (Opciones de archivo) y presione
el botón [OK].

4. Deslice el interruptor [ � /� ] hasta seleccionar
<Copy To> (Copiar en) y presione el botón [OK].
� Si ha seleccionado el tipo de almacenamiento

External (Externo), el archivo se copia en Internal
(Interno) y viceversa.

5. Deslice el interruptor [ � /� ] para seleccionar
entre los siguientes y presione el botón [OK].
� <Selected> (Seleccionado): copia el archivo de

música seleccionado.
� <All> (Todo): copia todos los archivos de

música.
� <Cancel> (Cancelar): cancela la copia de

archivos de música.

Nota

✤ Si fija la función Hold con el interruptor Hold de
cámara externa / MP3, no puede borrar, bloquear ni
copiar archivos de música. Sólo puede utilizar el
interruptor Power y los botones de volumen [+]/[ - ].
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Voice Recorder Mode : Recording

Recording Voice
You can record voice using the built-in microphone in the CAM.
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1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select Voice
Recorder mode and press the [OK] button.

3. Press the [Record/Stop] button to record
voice.
� The elapsed time and <� REC> is displayed.

The CAM starts recording.

4. Press the [Record/Stop] button to stop
recording voice.
� < � STBY > is displayed and it stops

recording.

ESPAÑOL

2

3

4

Mode Selection

File Browser

Video

Photo

MP3

Voice Recorder

Voice Record

9  2005/01/01 12:18:12 AM

Stereo  8KHz  128Kbps

00:00:16 / 00:24:32 REC

Voice Record

10  

Stereo  8KHz  128Kbps

STBY00:00:16 / 00:24:32

Modalidad de grabador de voz: Grabación

Grabación de voz
Puede grabar voz utilizando el micrófono incorporado en la CAM.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo
de nuevo.
� Aparece la pantalla <Mode Selection>

(Selección de modalidad).

2. Deslice el interruptor [ � /� ] hasta
seleccionar la modalidad Voice Recorder
(Grabador de voz) y presione el botón [OK].

3. Presione el botón [Record/Stop] para grabar voz.
� Aparece el tiempo transcurrido y <� REC>. 

La CAM inicia la grabación.

4. Presione el botón [Record/Stop] para detener
la grabación de voz.
� Aparece < � STBY > y se detiene la grabación.
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Voice Recorder Mode : Playing

Playing Voice files
You can hear the voice file connecting earphones.

1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select Voice
Recorder mode and press the [OK] button.

3. Press the [Menu] button when the Voice
Record screen appears.

4. Slide the [ � /� ] switch to select <Play> and
press the [OK] button.

5. Slide the [ � /� ] switch to select the file you
want to play. 

6. Press the [OK] button to play the recorded
voice.
� Press the [OK] button to pause playing.

Note

✤ Press the [Back] button while recording standby
status to view the file list. 

Play/Pause [      ] button: Play or pause the voice file
Rewind [ ] switch: Rewind the voice file backward

(Press and hold over 2 seconds
during playback.)/ Move to the
previous file

Fast Forward [ ] switch: Wind the voice file forward
(Press and hold over 2
seconds during playback.)
/Move to the next file

The button and switch you use when playing the
recording

ESPAÑOL

2

4

5

6

Voice Record

10  

Stereo  8KHz  128Kbps

STBY00:00:16 / 00:24:32

Voice Record

Stereo  8KHz  128Kbps
Play

Record

Back

STBY00:00:16 / 00:24:32

1  2005/01/01 12:22:00 AM

2  2005/01/02 01:23:00 AM

3  2005/01/03 05:39:00 AM

4  2005/01/07 07:13:00 AM

5  2005/01/07 11:54:00 AM

Voice Play

Voice Play

2  2005/01/02  01:23 AM

5.0 Mbytes

Stereo  8KHz  128Kbps

00:00:12 / 00:05:12

Modalidad de grabador de voz: Reproducción 

Reproducción de archivos de voz
Puede escuchar el archivo de voz conectando los audífonos.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo de
nuevo.
� Aparece la pantalla <Mode Selection> (Selección

de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
la modalidad Voice Recorder (Grabador de voz)
y presione el botón [OK].

3. Presione el botón [Menu] cuando aparezca la
pantalla <Voice Record> (Grabar voz).

4. Deslice el interruptor [ � /� ] hasta seleccionar
<Play> (Reproducir) y presione el botón [OK].

5. Deslice el interruptor [ � /� ] hasta seleccionar
el archivo que desea reproducir.

6. Presione el botón [OK] para reproducir el
archivo grabado.
� Presione el botón [OK] tras interrumpir la grabación.

Nota

✤ Presione el botón [Back] mientras se encuentra en el
estado de espera de grabación para ver la lista de
archivos.

Botón Reproducir/Pausa [         ]: reproduce o  
interrumpe el archivo de voz.
Interruptor Rebobinar [      ]: rebobina el archivo de 
voz (Mantenga pulsado más de 2 segundos durante
la reproducción.)/va al archivo anterior
Interruptor de avance rápido [      ]: hace avanzar el 
archivo de voz (Mantenga pulsado más de 2
segundos durante la reproducción.)/va al archivo
siguiente

Botón e interruptor utilizados al reproducir la
grabación
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Voice Recorder Mode : Selecting File Options

Deleting Voice files
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You can delete voice files you no longer want.

1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select Voice
Recorder mode and press the [OK] button. 

3. Press the [Menu] button when the Voice
Record Screen appears.

4. Slide the [ � /� ] switch to select <Play> and
press the [OK] button.

5. Slide the [ � /� ] switch to select the voice
file you want to delete.

6. Press the [Menu] button to select <File
Options> and press the [OK] button.
� You can select <File Options> only in Voice

Play mode.

7. Slide the [ � /� ] switch to select <Delete>
and press the [OK] button.

8. Slide the [ � /� ] switch to select from the
following and press the [OK] button.
� Selected: The selected voice file is deleted.
� All: All voice files are deleted. 
� Cancel: Cancels deleting voice files.

Note

✤ If you select <Back> in the menu, the previous menu
appears.

ESPAÑOL

4

6

7

8

Voice Record

Stereo  8KHz  128Kbps
Play

Record

Back

STBY00:00:16 / 00:24:32

1  01/01/2005 12:22:00 AM

2  01/01/2005 01:23:00 AM

3  01/02/2005 05:39:00 AM

4  2005/01/07 07:13:00 AM

5  2005/01/07 11:54:00 AM

Voice Play

Play

File Options

Record

Back

1  01/01/2005 12:22:00 AM

2  01/01/2005 01:23:00 AM

3  01/02/2005 05:39:00 AM

4  2005/01/07 07:13:00 AM

5  2005/01/07 11:54:00 AM

Voice Play

Lock

Copy To

Delete

Back

1  04/07/04 12:22 pm

2  04/07/05 1:23 am

3  04/07/05 5:39 pm

4  04/07/09 7:3 am

5  04/07/12 11:54 pm

Voice Play

Play

File Option

Record

Back
Selected

All

Cancel

Choose the file(s) 
to delete

Modalidad de grabador de voz:
Selección de opciones de archivo

Eliminación de archivos de voz
Puede borrar los archivos de voz que ya no desee.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo de
nuevo.
� Aparece la pantalla <Mode Selection> (Selección

de modalidad).
2. Deslice el interruptor [ � /� ] hasta seleccionar

la modalidad Voice Recorder (Grabador de voz)
y presione el botón [OK].

3. Presione el botón [Menu] cuando aparezca la
pantalla <Voice Record> (Grabar voz).

4. Deslice el interruptor [ � /� ] hasta seleccionar
<Play> (Reproducir) y presione el botón [OK].

5. Deslice el interruptor [ � /� ] hasta seleccionar
el archivo de voz que desea borrar.

6. Presione el botón [Menu] hasta seleccionar <File
Options> (Opciones de archivo) y presione el
botón [OK].
� Puede seleccionar File Options <Opciones de

archivo> solo en la modalidad Voice Play
<Reproducir voz>.

7. Deslice el interruptor [ � /� ] hasta seleccionar
<Delete> (Borrar) y presione el botón [OK].

8. Deslice el interruptor [ � /� ] para seleccionar
entre los siguientes y presione el botón [OK].
� <Selected> (Seleccionado): se borra el

archivo de voz seleccionado.
� <All> (Todo): se borran todos los archivos de voz.
� <Cancel> (Cancelar): cancela la supresión de

archivos de voz.

Nota

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.
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Voice Recorder Mode : Selecting File Options

Locking Voice files
You can lock important voice files so they can not be deleted.

1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select Voice
Recorder mode and press the [OK] button. 

3. Press the [Menu] button when the Voice
Record screen appears.

4. Slide the [ � /� ] switch to select <Play> and
press the [OK] button.

5. Slide the [ � /� ] switch to select the voice
file you want to lock.

6. Press the [Menu] button to select <File
Options> and press the [OK] button.
� You can select <File Options> only in Voice

Play mode.

7. Slide the [ � /� ] switch to select <Lock> and
press the [OK] button.

8. Slide the [ � /� ] switch to select from the
following and press the [OK] button.
� Selected: The selected voice file is locked.
� All: All voice files are locked. 
� Cancel: Cancels locking voice files.

Notes

✤ If you select <Back> in the menu, the previous menu
appears.

✤ The <      > icon is displayed when the file is locked.

ENGLISHESPAÑOL

4

6

7

8

Voice Record

Stereo  8KHz  128Kbps
Play

Record

Back

STBY00:00:16 / 00:24:32

1  01/01/2005 12:22:00 AM

2  01/01/2005 01:23:00 AM

3  01/02/2005 05:39:00 AM

4  2005/01/07 07:13:00 AM

5  2005/01/07 11:54:00 AM

Voice Play

Play

File Options

Record

Back

1  01/01/2005 12:22:00 AM

2  01/01/2005 01:23:00 AM

3  01/02/2005 05:39:00 AM

4  2005/01/07 07:13:00 AM

5  2005/01/07 11:54:00 AM

Voice Play

Lock

Copy To

Delete

Back

1  04/07/04 12:22 pm

2  04/07/05 1:23 am

3  04/07/05 5:39 pm

4  04/07/09 7:3 am

5  04/07/12 11:54 pm

Voice Play

Play

File Option

Record

Back
Selected

All

Cancel

Choose the file(s) you would
to lock.

Modalidad de grabador de voz:
Selección de opciones de archivo

Bloqueo de archivos de voz
Puede bloquear archivos de voz importantes para no borrarlos.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo de
nuevo.
� Aparece la pantalla <Mode Selection> (Selección

de modalidad).
2. Deslice el interruptor [ � /� ] hasta seleccionar

la modalidad Voice Recorder (Grabador de voz)
y presione el botón [OK].

3. Presione el botón [Menu] cuando aparezca la
pantalla <Voice Record> (Grabar voz).

4. Deslice el interruptor [ � /� ] hasta seleccionar
<Play> (Reproducir) y presione el botón [OK].

5. Deslice el interruptor [ � /� ] hasta seleccionar
el archivo de voz que desea borrar.

6. Presione el botón [Menu] hasta seleccionar
<File Options> (Opciones de archivo) y presione
el botón [OK].
� Puede seleccionar File Options <Opciones de

archivo> solo en la modalidad Voice Play
<Reproducir voz>.

7. Deslice el interruptor [ � /� ] hasta seleccionar
<Lock> (Bloquear) y presione el botón [OK].

8. Deslice el interruptor [ � /� ] para seleccionar
entre los siguientes y presione el botón [OK].
� <Selected> (Seleccionado): se bloquea el 

archivo de voz seleccionado.
� <All> (Todo): se bloquean todos los archivos de voz.
� <Cancel> (Cancelar): cancela el bloqueo de 

archivos de voz.

Notas

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.

✤ Aparece el icono <      > cuando se bloquea el
archivo.
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Copying Voice files
You can copy the voice file to the internal or external memory.
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1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select Voice
Recorder mode and press the [OK] button. 

3. Press the [Menu] button when the Voice
Record screen appears.

4. Slide the [ � /� ] switch to select <Play> and
press the [OK] button.

5. Slide the [ s/t] switch to select the voice file
you want to copy.

6. Press the [Menu] button to select <File
Options> and press the [OK] button.
� You can select <File Options> only in Voice

Play mode.
7. Slide the [ � /� ] switch to select <Copy To>

and press the [OK] button.
� If you selected ‘External’ as the Storage type,

the file is copied to ‘Internal’ and vice versa.

8. Slide the [ � /� ] switch to select from the
following and press the [OK] button.
� Selected: Copies the selected voice file.
� All: Copies all voice files. 
� Cancel: Cancels copying voice files.

Note

✤ If you select <Back> in the menu, the previous menu
appears.
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Voice Play

Lock

Copy To

Delete

Back
Selected

All

Cancel

Choose the file(s) to copy
to memory stick?

Modalidad de grabador de voz:
Selección de opciones de archivo

Copia de archivos de voz
El archivo de voz puede copiarse en la memoria interna o externa.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo
de nuevo.
� Aparece la pantalla <Mode Selection> (Selección

de modalidad).
2. Deslice el interruptor [ � /� ] hasta seleccionar

la modalidad Voice Recorder (Grabador de voz)
y presione el botón [OK].

3. Presione el botón [Menu] cuando aparezca la
pantalla <Voice Record> (Grabar voz).

4. Deslice el interruptor [ � /� ] hasta seleccionar
<Play> (Reproducir) y presione el botón [OK].

5. Deslice el interruptor [ � /� ] hasta seleccionar
el archivo de voz que desea borrar.

6. Presione el botón [Menu] hasta seleccionar
<File Options> (Opciones de archivo) y
presione el botón [OK].
� Puede seleccionar File Options <Opciones de

archivo> solo en la modalidad Voice Play
<Reproducir voz>.

7. Deslice el interruptor [ � /� ] hasta seleccionar
<Copy To> (Copiar en) y presione el botón [OK].
� Si ha seleccionado el tipo de almacenamiento

External (Externo), el archivo se copia en Internal
(Interno) y viceversa.

8. Deslice el interruptor [ � /� ] para seleccionar
entre los siguientes y presione el botón [OK].
� <Selected> (Seleccionado): copia el archivo de

voz seleccionado.
� <All> (Todo): copia todos los archivos de voz.
� <Cancel> (Cancelar): cancela la copia de

archivos de voz.

Nota

✤ Si selecciona <Back> (Volver) en el menú, aparece el
menú anterior.
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Deleting Files or Folders
You can delete the file(AVI, MP3, JPEG, WAV) or folders you recorded.

1. Slide the [Mode Selector] down to turn on
the CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select File
Browser and press the [OK] button. 

3. Slide the [ � /� ] switch to select the folder
to find the file you want to delete. 
Press the [OK] button.
� Press the [Menu] button if you want to delete

the selected folder.
� Perform these steps repeatedly until the file

you want to delete appears.

4. Press the [Menu] button.
Slide the [ � /� ] switch to select <Delete>
and press the [OK] button.

5. Slide the [ � /� ] button to select the setting
you want. 
Press the [OK] button.
� Selected: The selected file is deleted.
� All: All files are deleted.
� Cancel: Cancels deleting files.

Note

✤ If you select <Back> in the menu, the previous menu
appears.
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Utilización del explorador de archivos

Eliminación de archivos o carpetas
Puede borrar el archivo (AVI, MP3, JPEG, WAV) o las carpetas
grabadas.

1. Deslice el [Selector de modalidad] para
encender la CAM y deslícelo hacia abajo de
nuevo.
� Aparece la pantalla <Mode Selection>

(Selección de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
File Browser (Explorador de archivos) y
presione el botón [OK].

3. Deslice el interruptor [ � /� ] hasta seleccionar
la carpeta para localizar el archivo que desea
borrar.
Presione el botón [OK].
� Presione el botón [Menu] para borrar la carpeta

seleccionada.
� Realice estos pasos de forma repetida hasta

que aparezca el archivo que desea borrar.

4. Pulse el botón [Menu].
Deslice el interruptor [� /� ] hasta seleccionar
Delete <Borrar> y presione el botón [OK].

5. Deslice el botón [ � /� ] hasta seleccionar el
ajuste que desea.
Presione el botón [OK].
� <Selected> (Seleccionado): se borra el

archivo seleccionado.
� <All> (Todo): se borran todos los archivos.
� <Cancel> (Cancelar): cancela la supresión de

archivos.

Nota

✤ Si selecciona <Back> (Volver) en el menú, aparece el
menú anterior.
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Locking Files
You can lock the important files so they can not be deleted.

1. Slide the [Mode Selector] down to turn on
the CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select File
Browser and press the [OK] button. 

3. Slide the [ � /� ] switch to select the file
you want to lock. 
Press the [OK] button.
� Perform these steps repeatedly until the file

you want to lock appears.

4. Press the [Menu] button. 
Slide the [ � /� ] switch to select <Lock>
and press the [OK] button.

5. Slide the [ � /� ] button to select from the
following and press the [OK] button.
� Selected: The selected file is locked.
� All: All files are locked. 
� Cancel: Cancels locking files.

Notes

✤ If you select <Back> in the menu, the previous menu
appears.

✤ You can’t lock folders.
✤ The <      > icon is displayed when the file is locked.
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Utilización del explorador de archivos

Bloqueo de archivos
Puede bloquear archivos importantes para que no sean borrados.

1. Deslice el [Selector de modalidad] para
encender la CAM y deslícelo hacia abajo de
nuevo.
� Aparece la pantalla <Mode Selection> (Selección

de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
File Browser (Explorador de archivos) y
presione el botón [OK]. 

3. Deslice el interruptor [ � /� ] hasta seleccionar
el archivo que desea bloquear.
Presione el botón [OK].
� Realice estos pasos de forma repetida hasta que

aparezca el archivo que desea bloquear.

4. Pulse el botón [Menu].
Deslice el interruptor [� /� ] hasta seleccionar
Lock <Bloquear> y presione el botón [OK].

5. Deslice el botón [ � /� ] para seleccionar entre
los siguientes y presione el botón [OK].
� <Selected> (Seleccionado): se bloquea el

archivo seleccionado.
� <All> (Todo): se bloquean todos los archivos.
� <Cancel> (Cancelar): cancela el bloqueo de

archivos.

Notas

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.

✤ No puede bloquear carpetas.
✤ Aparece el icono <      > cuando se bloquea el

archivo.
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Copying Files or Folders
You can copy the file or folder to the internal or external memory.

1. Slide the [Mode Selector] down to turn on
the CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select File
Browser and press the [OK] button.

3. Slide the [ � /� ] switch to select the folder
to find the file you want to copy. 
Press the [OK] button.
� Press the [Menu] button if you want to copy

the selected folder.
� Perform these steps repeatedly until the file

you want to copy appears.

4. Press the [Menu] button.
Slide the [ � /� ] switch to select <Copy To>
and press the [OK] button.
� If you selected ‘External’ as the Storage type,

the file is copied to ‘Internal’ and vice versa.

5. Slide the [ � /� ] button to select from the
following and press the [OK] button.
� Selected: Copies the selected file.
� All: Copies all files. 
� Cancel: Cancels copying files.

Note

✤ If you select <Back> in the menu, the previous menu
appears.
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Utilización del explorador de archivos

Copia de archivos o carpetas
El archivo o la carpeta pueden copiarse en la memoria interna o externa.

1. Deslice el [Selector de modalidad] para
encender la CAM y deslícelo hacia abajo de
nuevo.
� Aparece la pantalla <Mode Selection> (Selección

de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
File Browser (Explorador de archivos) y
presione el botón [OK].

3. Deslice el interruptor [ � /� ] hasta seleccionar
la carpeta para localizar el archivo que desea
copiar.
Presione el botón [OK].
� Presione el botón [Menu] para copiar la carpeta

seleccionada.
� Realice estos pasos de forma repetida hasta que

aparezca el archivo que desea copiar.

4. Pulse el botón [Menu].
Deslice el interruptor [� /� ] hasta seleccionar
Copy To <Copiar en> y presione el botón [OK].
� Si ha seleccionado el tipo de almacenamiento

<External> (Externo), el archivo se copia en
<Internal> (Interno) y viceversa.

5. Deslice el botón [ � /� ] para seleccionar entre
los siguientes y presione el botón [OK].
� <Selected> (Seleccionado): copia el archivo

seleccionado.
� <All> (Todo): copia todos los archivos.
� <Cancel> (Cancelar): cancela la copia de

archivos.

Nota

✤ Si selecciona <Back> (Volver) en el menú, aparece el
menú anterior.
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Using File Browser

Viewing File Information
You can see the file name, format, size and date. 

1. Slide the [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select File Browser
and press the [OK] button. 

3. Slide the [ � /� ] switch to select the file you
want to see its file information. 
Press the [OK] button. 
� Perform these steps repeatedly until the file

you want to see its file information appears.

4. Press the [Menu] button. 
Slide the [ � /� ] switch to select <File Info>
and press the [OK] button.
� The screen with file name, format, size and

date appears.

5. Press the [OK] button to finish viewing file
information.
� If you select <Close> in the screen, the screen

disappears.
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Utilización del explorador de archivos

Visualización de la información del archivo
Puede ver el nombre de archivo, formato, tamaño y fecha.

1. Deslice el [Selector de modalidad] para
encender la CAM y deslícelo hacia abajo de
nuevo.
� Aparece la pantalla <Mode Selection>

(Selección de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
File Browser (Explorador de archivos) y
presione el botón [OK].

3. Deslice el interruptor [ � /� ] hasta seleccionar
el archivo sobre el que desea ver su
información.
Presione el botón [OK].
� Realice estos pasos de forma repetida hasta

que aparezca el archivo que desea ver.

4. Pulse el botón [Menu].
Deslice el interruptor [� /� ] hasta seleccionar
File Info <Información de archivo> y presione
el botón [OK].
� Aparece la pantalla con el nombre de archivo,

el formato, el archivo y la fecha.

5. Presione el botón [OK] para finalizar la
visualización de la información del archivo.
� Si selecciona <Close> (Cerrar) en la pantalla,

ésta desaparece.
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Notes

✤ If you select <Back> in the menu, the previous
menu appears.

✤ A brighter LCD Monitor setting consumes more
battery power.
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Setting the CAM : Adjusting the LCD Monitor

Adjusting the LCD Brightness
You can adjust the brightness of the LCD monitor to compensate for
ambient lighting conditions.

1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select System
Settings and press the [OK] button.  

3. Slide the [ � /� ] switch to select <Display>
and press the [OK] button. 

4. Slide the [ � /� ] switch to select <LCD
Brightness> and press the [OK] button.
� You can adjust the LCD Brightness from 0%

to 100%. 

5. Slide the [ � /� ] switch to select the
brightness you want. 

6. Press the [Back] button to finish setting.
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✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.

✤ Un ajuste de pantalla LCD más brillante consume
más energía de la batería.

Ajuste de la CAM: Ajuste de la pantalla LCD

Ajuste del brillo de la LCD
Puede ajustar el brillo de la pantalla LCD para compensar las
condiciones de luz ambientales.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo
de nuevo.
� Aparece la pantalla <Mode Selection>

(Selección de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
System Settings (Config. del sistema) y
presione el botón [OK].

3. Deslice el interruptor [ � /� ] hasta seleccionar
<Display> (Pantalla)  y presione el botón [OK]. 

4. Deslice el interruptor [ � /� ] hasta seleccionar
<LCD Bright> (Brillo de LCD) y presione el
botón [OK].
� Puede ajustar el brillo de la pantalla LCD de 0%

a 100%.

5. Deslice el interruptor [ � /� ] hasta seleccionar
el brillo que desea.

6. Presione el botón [Back] para finalizar el ajuste.
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Setting the CAM : Adjusting the LCD Monitor

Adjusting the LCD Color
You can adjust the color of the LCD monitor depending on the situation.
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Note

✤ If you select <Back> in the menu, the previous
menu appears.

1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select System
Settings and press the [OK] button.  

3. Slide the [ � /� ] switch to select <Display>
and press the [OK] button. 

4. Slide the [ � /� ] switch to select <LCD
Color> and press the [OK] button.
� You can adjust the LCD Color from 0% to

100%. 

5. Slide the [ � /� ] switch to select the color
you want. 

6. Press the [Back] button to finish setting.
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Ajuste de la CAM: Ajuste de la pantalla LCD

Nota

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.

Ajuste del color de la LCD
Puede ajustar el color de la pantalla LCD dependiendo de la situación.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo
de nuevo.
� Aparece la pantalla <Mode Selection>

(Selección de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
System Settings (Config. del sistema) y
presione el botón [OK]. 

3. Deslice el interruptor [ � /� ] hasta seleccionar
<Display> (Pantalla)  y presione el botón [OK].

4. Deslice el interruptor [ � /� ] hasta seleccionar
<LCD Color> (Color de LCD)  y presione el
botón [OK].
� Puede ajustar el color de la pantalla LCD de 0%

a 100%.

5. Deslice el interruptor [ � /� ] hasta seleccionar
el color que desea.

6. Presione el botón [Back] para finalizar el ajuste.
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Setting Time
You can adjust the time.
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1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select System
Settings and press the [OK] button.  

3. Slide the [ � /� ] switch to select <Date/Time>
and press the [OK] button.

4. Slide the [ � /� ] switch to select <Set Time>
and press the [OK] button. 

5. Slide the [ � /� ] switch to set the time and
press the [OK] button.
� Slide the [ � /� ] switch to change the setting

and press the [OK] button to confirm selection
and move to the next setting.  

6. Press the [Back] button to finish setting.

Note

✤ If you select <Back> in the menu, the previous
menu appears.
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Ajuste de la CAM: Ajuste de fecha y hora

Ajuste de la hora
Puede ajustar la hora.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo
de nuevo.
� Aparece la pantalla <Mode Selection>

(Selección de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
System Settings (Config. del sistema) y
presione el botón [OK].

3. Deslice el interruptor [ � /� ] hasta seleccionar
<Date/Time> (Fecha/Hora) y presione el botón
[OK].

4. Deslice el interruptor [ � /� ] hasta seleccionar
<Set Time> (Fijar hora) y presione el botón
[OK].

5. Deslice el interruptor [ � /� ] hasta fijar la hora
y presione el botón [OK].
� Deslice el interruptor [ � /� ] para cambiar el

ajuste y presione el botón [OK] para confirmar la
selección y pasar al ajuste siguiente.

6. Presione el botón [Back] para finalizar el ajuste.

Nota

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.
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Setting Date
You can adjust the date.

1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select System
Settings and press the [OK] button.  

3. Slide the [ � /� ] switch to select
<Date/Time> and press the [OK] button.

4. Slide the [ � /� ] switch to select <Set Date>
and press the [OK] button. 

5. Slide the [ � /� ] switch to set the date and
press the [OK] button.
� Slide the [ � /� ] switch to change the setting

and press the [OK] button to confirm selection
and move to the next setting. 

6. Press the [Back] button to finish setting.

Note

✤ If you select <Back> in the menu, the previous
menu appears.
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Ajuste de la CAM: Ajuste de fecha y hora

Ajuste de la fecha
Puede ajustar la fecha.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo
de nuevo.
� Aparece la pantalla <Mode Selection> (Selección

de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
System Settings (Config. del sistema) y
presione el botón [OK].

3. Deslice el interruptor [ � /� ] hasta seleccionar
<Date/Time> (Fecha/Hora) y presione el botón
[OK].

4. Deslice el interruptor [ � /� ] hasta seleccionar
<Set Date> (Fijar fecha) y presione el botón
[OK].

5. Deslice el interruptor [ � /� ] hasta fijar la fecha
y presione el botón [OK].
� Deslice el interruptor [ � /� ] para cambiar el

ajuste y presione el botón [OK] para confirmar la
selección y pasar al ajuste siguiente.

6. Presione el botón [Back] para finalizar el ajuste.

Nota

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.
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Setting Date Format
You can select the date format to display. 

1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select System
Settings and press the [OK] button.  

3. Slide the [ � /� ] switch to select 
<Date/Time> and press the [OK] button.

4. Slide the [ � /� ] switch to select <Date
Format> and press the [OK] button. 

5. Slide the [ � /� ] switch to select the desired
format and press the [OK] button.
� YY/MM/DD: The date is displayed in order as

Year/Month/Date.
� DD/MM/YY: The date is displayed in order as

Date/Month/Year.
� MM/DD/YY: The date is displayed in order as

Month/Date/Year.

6. Press the [Back] button to finish setting.

Note

✤ If you select <Back> in the menu, the previous
menu appears.
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Ajuste del formato de fecha
Puede seleccionar el formato de fecha que va a aparecer.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo
de nuevo.
� Aparece la pantalla <Mode Selection> (Selección

de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
System Settings (Config. del sistema) y
presione el botón [OK].

3. Deslice el interruptor [ � /� ] hasta seleccionar
<Date/Time> (Fecha/Hora) y presione el botón
[OK].

4. Deslice el interruptor [ � /� ] hasta seleccionar
<Date Format> (Formato de fecha) y presione el
botón [OK].

5. Deslice el interruptor [ � /� ] hasta seleccionar
el formato que desee y presione el botón [OK].
� <YY/MM/DD> (AA/MM/DD): la fecha aparece en

el orden Año/Mes/Día.
� <DD/MM/YY> (DD/MM/AA): la fecha aparece en

el orden Día/Mes/Año.
� <MM/DD/YY> (MM/DD/AA): la fecha aparece en

el orden Mes/Día/Año.

6. Presione el botón [Back] para finalizar el ajuste.

Nota

✤ Si selecciona <Back> (Volver) en el menú, aparece el
menú anterior.

00876D SCX105 US+ESP~111  4/28/05 11:03 AM  Page 92



ENGLISH

Setting the CAM : Adjusting Date/Time

9393

Setting Time Format
You can select the time format to display. 

ENGLISH

1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select System
Settings and press the [OK] button.  

3. Slide the [ � /� ] switch to select
<Date/Time> and press the [OK] button.

4. Slide the [ � /� ] switch to select <Time
Format> and press the [OK] button. 

5. Slide the [� /� ] switch to select the desired
format and press the [OK] button.
� 12 Hour: The time is displayed in 12 hour

units.
� 24 Hour: The time is displayed in 24 hour

units. For example, 2:00 PM will
display as 14:00.

6. Press the [Back] button to finish setting.

Note

✤ If you select <Back> in the menu, the previous
menu appears.
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Ajuste del formato de hora
Puede seleccionar el formato de hora que va a aparecer.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo
de nuevo.
� Aparece la pantalla <Mode Selection> (Selección

de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
System Settings (Config. del sistema) y
presione el botón [OK].

3. Deslice el interruptor [ � /� ] hasta seleccionar
<Date/Time> (Fecha/Hora) y presione el botón
[OK].

4. Deslice el interruptor [ � /� ] hasta seleccionar
<Time Format> (Formato de hora) y presione el
botón [OK].

5. Deslice el interruptor [� /� ] hasta seleccionar el
formato que desee y presione el botón [OK].
� <12 Hour> (12 horas): la hora aparece en

formato de 12 horas.
� <24 Hour> (24 horas): la hora aparece en

formato de 24 horas. Por
ejemplo, 2:00 PM
aparecerá como 14:00.

6. Presione el botón [Back] para finalizar el ajuste.

Nota

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.
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Setting the Auto Shut off
To save battery power, you can set the Auto Shut off function.

1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select System
Settings and press the [OK] button.  

3. Slide the [ � /� ] switch to select <System>
and press the [OK] button.

4. Slide the [ � /� ] switch to select <Auto Shut
off> and press the [OK] button. 

5. Slide the [ � /� ] switch to select the desired
setting and press the [OK] button.
� Off: Cancels the Auto Shut off function.
� 5 Minutes: The CAM turns off 5 minutes after

not being used.

6. Press the [Back] button to finish setting.

Notes

✤ If the CAM turns off after 5 minutes, you can use
the CAM again after turning it on.

✤ If you select <Back> in the menu, the previous
menu appears.

✤   The <Auto Shut off> function cannot be operated if
you connect the power adapter to the CAM.
It can be only operated when you insert battery
pack into the CAM.
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Ajuste de apagado automático
Para ahorrar energía de la batería, puede definir la función <Auto
Shut off> (Apagado automático).

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo
de nuevo.
� Aparece la pantalla <Mode Selection>

(Selección de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
System Settings (Config. del sistema) y
presione el botón [OK].

3. Deslice el interruptor [ � /� ] hasta seleccionar
<System> (Sistema) y presione el botón [OK].

4. Deslice el interruptor [ � /� ] hasta seleccionar
<Auto Shut off> (Apagado automático) y
presione el botón [OK].

5. Deslice el interruptor [ � /� ] hasta seleccionar
el ajuste que desea y presione el botón [OK].
� <Off> (Des.): cancela la función de apagado

automático.
� <5 Minutes> (5 minutos): la CAM se apaga 5

minutos después de haber sido utilizada.

6. Presione el botón [Back] para finalizar el ajuste.

Notas

✤ Si la CAM se apaga tras 5 minutos, puede utilizar
de nuevo la CAM despues de encenderla.

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.

✤  La función <Auto Shut off> (Apagado automático)
no está operativa si conecta el adaptador de
alimentación a la CAM.
Sólo se puede accionar cuando inserte la batería
en la CAM.
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Setting the Demo Function
The Demo function allows you to view a demonstration of the
functions that the CAM supports.

ENGLISH

1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select System
Settings and press the [OK] button.  

3. Slide the [ � /� ] switch to select <System>
and press the [OK] button.

4. Slide the [ � /� ] switch to select <Demo>
and press the [OK] button. 

5. Slide the [ � /� ] switch to select the desired
setting and press the [OK] button.
� Off : Cancels the Demo function.
� 5 Minutes : Starts the Demo function in 

5 minutes.
� Play Now: Starts the Demo function now.

6. Press the [Back] button to finish setting.

Notes

✤ If you select <Back> in the menu, the previous
menu appears.

✤ If you set the Demo function, it operates only in
Video Record mode.
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Ajuste de la función Demo
La función Demo permite ver una demostración de las funciones
que tiene la CAM.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo
de nuevo.
� Aparece la pantalla <Mode Selection>

(Selección de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
System Settings (Config. del sistema) y
presione el botón [OK].

3. Deslice el interruptor [ � /� ] hasta seleccionar
<System>  (Sistema) y presione el botón [OK].

4. Deslice el interruptor [ � /� ] hasta seleccionar
<Demo>  (Demostración) y presione el botón
[OK].

5. Deslice el interruptor [ � /� ] hasta seleccionar el
ajuste que desee y presione el botón [OK].
� <Off> (Des.): cancela la función Demo.
� <5 Minutes> (5 minutos): Inicia la función

Demo en 5 minutos.
� <Play Now> (Reproducir ahora): Inicia ahora la

función Demo.

6. Presione el botón [Back] para finalizar el ajuste.

Notas

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.

✤ Si define la función Demo, sólo está operativa en
<Video Record> (Grabar video).
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1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select System
Settings and press the [OK] button.  

3. Slide the [ � /� ] switch to select <System>
and press the [OK] button.

4. Slide the [ � /� ] switch to select <Start-up>
and press the [OK] button. 

5. Slide the [ � /� ] switch to select the desired
setting and press the [OK] button.
� Video Mode: The CAM starts up in Video

Mode.
� Previous Mode: The CAM starts up in the

mode you used last.

6. Press the [Back] button to finish setting.

Note

✤ If you select <Back> in the menu, the previous
menu appears.
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Ajuste de la modalidad de inicio
Puede seleccionar la modalidad de inicio de la CAM.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo
de nuevo.
� Aparece la pantalla <Mode Selection>

(Selección de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
System Settings (Config. del sistema) y
presione el botón [OK].

3. Deslice el interruptor [ � /� ] hasta seleccionar
<System> (Sistema) y presione el botón [OK].

4. Deslice el interruptor [ � /� ] hasta seleccionar
<Start-up> (Inicio) y presione el botón [OK].

5. Deslice el interruptor [ � /� ] hasta seleccionar
el ajuste que desee y presione el botón [OK].
� <Video Mode> (Modalidad de video): La CAM

se inicia en la modalidad de video.
� <Previous Mode> (Modalidad anterior): la

CAM se inicia en la última modalidad utilizada.

6. Presione el botón [Back] para finalizar el ajuste.

Nota

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.
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Setting the File No. Function
You can set the file numbers so that they reset each time Memory
stick is formatted, or so that they are displayed incrementally.

1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select System
Settings and press the [OK] button.  

3. Slide the [ � /� ] switch to select <System>
and press the [OK] button.

4. Slide the [ � /� ] switch to select <File No.>
and press the [OK] button.

5. Slide the [ � /� ] switch to select the desired
setting and press the [OK] button.
� Series: Numbering is continuous between the

Memory Sticks, so that the first file number
assigned on a new Memory Stick is 1 more
than the last file number assigned on the
previous Memory Stick.

� Reset: When the Memory Stick is formatted,
the file number resets to its default value.
(100-0001)

6. Press the [Back] button to finish setting.

Notes

✤ If you select <Back> in the menu, the previous menu
appears.

✤ When you set file number to ‘Series’, each file is
assigned a different number to avoid duplication of
numbers. It is convenient when you want to manage
your files on a PC. 
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Ajuste de la función Nº archivo
Puede definir los números de archivos de forma que se reinicien
cada vez que se formatee el Memory Stick o que aparezcan de  

forma incremental.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo de
nuevo.
� Aparece la pantalla <Mode Selection> (Selección

de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
System Settings (Config. del sistema) y presione
el botón [OK].  

3. Deslice el interruptor [ � /� ] hasta seleccionar
<System> (Sistema) y presione el botón [OK].

4. Deslice el interruptor [ � /� ] hasta seleccionar
<File No. > (Nº archivo) y presione el botón [OK].

5. Deslice el interruptor [ � /� ] hasta seleccionar
el ajuste que desea y presione el botón [OK].
� <Series> (Serie): La numeración es continua

entre los Memory Stick, de forma que el primer
número de archivo asignado en un nuevo
Memory Stick sea 1 más que el último número de
archivo asignado en el Memory Stick anterior.

� <Reset> (Reiniciar): Cuando se formatea el
Memory Stick, se reinicia el número de archivo en
su valor por omisión. (100-0001)

6. Presione el botón [Back] para finalizar el ajuste.

Notas

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.

✤ Cuando se define el número de archivo en <Series>
(Serie), a cada archivo se le asigna un número
diferente para evitar la duplicación de números. 
Es conveniente cuando se desea administrar los
archivos en una PC.
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Setting the Beep Sound
You can set the beep sound on/off. When on, a beep will sound every
time a button is pressed.

1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select System
Settings and press the [OK] button.  

3. Slide the [ � /� ] switch to select <System>
and press the [OK] button.

4. Slide the [ � /� ] switch to select <Beep
Sound> and press the [OK] button. 

5. Slide the [ � /� ] switch to select the desired
sound and press the [OK] button.
� On: Turns the beep sound on.
� Off: Turns the beep sound off.

6. Press the [Back] button to finish setting.

Notes

✤ If you select <Back> in the menu, the previous menu
appears.

✤ When the earphones or Audio/Video cable is
connected to the CAM, the beep sound function does
not operate.
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Ajuste del sonido de la señal sonora
Puede activar o desactivar el sonido de la señal sonora. Cuando está
activado, se emitirá una señal sonora siempre que se presione un botón.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo
de nuevo.
� Aparece la pantalla <Mode Selection>

(Selección de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
System Settings (Config. del sistema) y
presione el botón [OK].  

3. Deslice el interruptor [ � /� ] hasta seleccionar
<System> (Sistema) y presione el botón [OK].

4. Deslice el interruptor [ � /� ] hasta seleccionar
<Beep Sound> (Sonido de pitido) y presione el
botón [OK].

5. Deslice el interruptor [ � /� ] hasta seleccionar
el sonido que desea y presione el botón [OK].
� <On> (Act.): activa el sonido del pitido.
� <Off> (Des.): desactiva el sonido del pitido.

6. Presione el botón [Back] para finalizar el ajuste.

Notas

✤ Si selecciona <Back> (Volver) en el menú, aparece el
menú anterior.

✤ Cuando se conectan los audífonos o el cable de
audio/video a la CAM, la función de sonido de pitido
no está operativa.
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Viewing Version Information
You can view te firmware information.
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1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select System
Settings and press the [OK] button.  

3. Slide the [ � /� ] switch to select <System>
and press the [OK] button.

4. Slide the [ � /� ] switch to select <Version
Info> and press the [OK] button.
� The version of the CAM is displayed. 

5. Press the [OK] button to finish viewing
version information.

Note

✤ If you select <Back> in the menu, the previous menu
appears.
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Mar 07 2005 01:09:26

Ajuste de la CAM: Ajuste del sistema

Visualización de la información de versión
Puede ver la información del firmware.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo
de nuevo.
� Aparece la pantalla <Mode Selection>

(Selección de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
System Settings (Config. del sistema) y
presione el botón [OK].  

3. Deslice el interruptor [ � /� ] hasta seleccionar
<System> (Sistema)  y presione el botón [OK].

4. Deslice el interruptor [ � /� ] hasta seleccionar
<Version Info> (Inf. versión) y presione el
botón [OK].
� Aparece la versión de la CAM.

5. Presione el botón [OK] para finalizar la
visualización de la información de la versión.

Nota

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.
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Selecting the Storage Type
Select the storage type(Internal or Memory Stick, Memory Stick Pro)
before recording or taking pictures.
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Setting the CAM : Setting Memory
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1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select System
Settings and press the [OK] button.  

3. Slide the [ � /� ] switch to select <Memory>
and press the [OK] button.
� If a Memory Stick is not inserted, you cannot select

‘External’.

4. Slide the [ � /� ] switch to select <Storage
Type> and press the [OK] button.

5. Slide the [ � /� ] switch to select the desired
setting and press the [OK] button.
� Internal: The video, photo, mp3 file or voice file

is stored in internal memory.
� External: The video, photo, mp3 file or voice file

is stored in external memory
(Memory stick or Memory stick pro).

Notes

✤ If you select <Back> in the menu, the previous menu
appears.

✤ ‘Internal’ is selected by default.
✤ If you insert the Memory Stick or Memory Stick Pro

when the CAM on, the pop-up screen about the 
memory type selection appears automatically.

ESPAÑOL
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Ajuste de la CAM: Ajuste de la memoria

Selección del tipo de almacenamiento
Seleccione el tipo de almacenamiento (interno) o Memory Stick,
Memory Stick Pro) antes de grabar o tomar imágenes.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo
de nuevo.
� Aparece la pantalla <Mode Selection>

(Selección de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
System Settings (Config. del sistema) y
presione el botón [OK].

3. Deslice el interruptor [ � /� ] hasta seleccionar
<Memory>  (Memoria) y presione el botón [OK].
� Si no se inserta ningún Memory Stick, no podrá

seleccionar <External> (Externa).

4. Deslice el interruptor [ � /� ] hasta seleccionar
<Storage Type> (Tipo de almac.) y presione el
botón [OK].

5. Deslice el interruptor [ � /� ] hasta seleccionar
el ajuste que desea y presione el botón [OK].
� <Internal> (Interna): el archivo de video, foto,

mp3 o voz se almacena en la memoria interna.
� <External> (Externa): el archivo de video, foto,

mp3 o voz se almacena en la memoria externa
(Memory Stick o Memory Stick pro).

Notas

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.

✤ La memoria interna se selecciona automaticamente.
✤ Si introduce el Memory Stick o el Memory Stick Pro

con la CAM encendida, aparece automáticamente
la pantalla de selección del tipo de memoria.
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Formatting the Memory
You can format the internal memory, Memory Stick or Memory Stick
Pro to erase all files. 

1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select System
Settings and press the [OK] button.   

3. Slide the [ � /� ] switch to select <Memory>
and press the [OK] button.

4. Slide the [ � /� ] switch to select <Format>
and press the [OK] button.
� If a Memory Stick is not inserted, you cannot

select ‘External’.

5. Slide the [ � /� ] switch to select the desired
setting and press the [OK] button.
� Internal: Formats the internal memory. If you

select  ‘Internal’, a confirmation message is
displayed.

� External: Formats the external memory. If you
select ‘External’, a confirmation message is
displayed.

6. Press the [OK] button to format.
� Select <Cancel> to cancel formatting.

Note

✤ If you select <Back> in the menu, the previous
menu appears.
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Ajuste de la CAM: Ajuste de la memoria

Formateo de la memoria
Puede formatear la memoria interna, el Memory Stick o el Memory 
Stick Pro para borrar todos los archivos.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo
de nuevo.
� Aparece la pantalla <Mode Selection> (Selección

de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
System Settings (Config. del sistema) y
presione el botón [OK].

3. Deslice el interruptor [ � /� ] hasta seleccionar
<Memory> (Memoria) y presione el botón [OK].

4. Deslice el interruptor [ � /� ] hasta seleccionar
<Format> (Formateo) y presione el botón [OK].
� Si no se inserta ningún Memory Stick, no podrá

seleccionar <External> (Externa).

5. Deslice el interruptor [ � /� ] hasta seleccionar
el ajuste que desea y presione el botón [OK].
� <Internal> (Interna): formatea la memoria

interna. Si selecciona <Internal> (Interna),
aparece el mensaje de confirmación.

� <External> (Externa): formatea la memoria
externa. Si selecciona <External> (Externa),
aparece el mensaje de confirmación.

6. Presione el botón [OK] para formatear.
� Seleccione <Cancel> (Cancelar) para cancelar el

formateo.

Nota

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.
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Viewing Memory Space
You can view usable and total memory space of the CAM. 

1. Slide [Mode Selector] down to turn on the
CAM and slide it down again.
� The Mode Selection screen appears.

2. Slide the [ � /� ] switch to select System
Settings and press the [OK] button.   

3. Slide the [ � /� ] switch to select <Memory>
and press the [OK] button.

4. Slide the [� /� ] switch to select <Memory
Space>.

5. Press the [Back] button to finish setting.

Note

✤ If you select <Back> in the menu, the previous menu appears.
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Storage Type

Memory Space 357MB/493MB

Ajuste de la CAM: Ajuste de la memoria

Visualización de espacio en memoria
Puede ver la memoria utilizable y el espacio total en memoria de la
CAM.

1. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM y deslícelo hacia abajo
de nuevo.
� Aparece la pantalla <Mode Selection>

(Selección de modalidad).

2. Deslice el interruptor [ � /� ] hasta seleccionar
System Settings (Config. del sistema) y
presione el botón [OK].

3. Deslice el interruptor [ � /� ] hasta seleccionar
<Memory> (Memoria) y presione el botón [OK].

4. Deslice el interruptor [� /� ] para seleccionar
<Memory Space> (Espacio en memoria).

5. Presione el botón [Back] para finalizar el
ajuste.

Nota

✤ Si selecciona <Back> (Volver) en el menú, aparece el menú
anterior.
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Transferring Files from the CAM to your computer

1. Connect the CAM to the PC with
the USB cable. 

2. Slide [Mode Selector] down to
turn on the CAM.
� USB menu screen appears

automatically.

3. Slide the [ � /� ] switch to select
<USB 2.0 MassStorage> or <USB
1.1 MassStorage> and press the
[OK] button.
� Your PC doesn't recognize the USB device

automatically. 
You must install the USB Driver manually on
Windows 98SE operating system.

4. Disconnect the USB cable if you finish transferring.

Notes

✤ Select <USB 1.1 MassStorage> when <USB 2.0 MassStorage> does
not work depending on your PC environment.

✤ If you disconnect the USB cable from the PC or the CAM during the
data transfer, the data transfer will stop and the data may be damaged.

✤ If you connect the USB cable to a PC using a USB HUB or with other
device at the same time, it might cause conflict and may not work properly.
If this occurs, remove all other devices and try the connection again.

✤ Install the Windows 98SE Driver on Windows 98SE operating system
using supplied CD. Refer to page 120 for further details.

✤ It takes about 30 minutes if you download or upload a 1GB file via a
USB cable.

✤ When connecting the CAM to your PC, if the message ‘USB-D07
Capture Device hasn’t passed Windows Logo testing’ appears, do not
be concerned, it is OK to proceed with file transfer.

Ajuste de la CAM: 
Utilización de la modalidad USB

Transferencia de archivos desde la CAM a la PC

1. Conecte la CAM a una PC
utilizando el cable USB.

2. Deslice hacia abajo el [Selector de
modalidad] para encender la CAM.
� Aparece automáticamente la

pantalla del menú USB.

3. Deslice el interruptor [ � /� ] hasta
seleccionar USB 2.0 MassStorage
o USB 1.1 MassStorage y presione
el botón [OK].

� El PC no reconoce automáticamente el
dispositivo USB. Puede instalar manualmente el
controlador USB en el sistema operativo
Windows 98SE.

4. Desconecte el cable USB si termina de
transferir.

Notas

✤ Seleccione <USB 1.1 MassStorage> cuando <USB 2.0
MassStorage> no funcione dependiendo del entorno de la PC.

✤ Si desconecta el cable USB de la PC o de la CAM durante la
transferencia de datos, la transferencia de datos se detendrá y puede
que los datos resulten dañados.

✤ Si conecta el cable USB a una PC utilizando el HUB USB o con otro
dispositivo al mismo tiempo, puede causar conflictos y puede que no
funcione correctamente. Si esto ocurre, retire el resto de dispositivos
e intente la conexión de nuevo.

✤ Instale el controlador de Windows 98SE en el sistema operativo
Windows 98SE utilizando el CD que se suministra. Consulte la
página 120 para obtener más detalles.

✤ La carga o descarga de un archivo de 1 GB a través del cable USB
tarda unos 30 minutos.

✤ Al conectar la CAM a la PC, si aparece el mensaje 'USB-D07
Capture Device no ha superado la prueba del logotipo de Windows',
no se preocupe, puede continuar con la transferencia de archivos.

Back

USB Mode

PC-Cam

PictBridge

USB 2.0 MassStorage

USB 1.1 MassStorage
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USB Speed depending on the System 

System Environment

Hi Speed USB is not guaranteed if supplied driver is not installed or on an
OS other than Microsoft Windows and Apple's Mac OS X.
✤ Windows 98SE/ME: Full Speed USB 
✤ Windows 2000: Over Service Pack 4 - Hi Speed USB 
✤ Windows XP: Over Service Pack 1 - Hi Speed USB
✤ Mac OS X: Over 10.3. - Hi Speed USB

ENGLISH

Setting the CAM : Using USB Mode
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Notes

✤ Not all PCs configured with the above environment are guaranteed to
operate properly.

✤ USB connection using an external USB hub or an additional USB
daughterboard is not guaranteed.

✤ If your OS is Windows 2000/XP, log in as the [Administrator (administrator
of the PC)] (or a user with the equivalent privileges) to install the driver.

✤ If the capacity of PC is low, the video file may not play normally or will
often stop. 

✤ If the capacity of PC is low, it may take long time to edit the video file. 

ESPAÑOL

Pentium III, 600MHz

Windows 98SE/ME

128MB

200MB
(For applications only. 

Apart from this, 
1GB or more free space 

800x600 dots 
16-bit color

USB 1.1

CPU

OS

Memory

Free space 
on the hard disk

Display
Resolution

USB

Pentium 4, 2GHz

Windows 2000/XP

512MB or above

2GB or above

1024x768 dots 
24-bit color

USB 2.0 High Speed

Minimum Recommended

G3 500MHz

Mac OS 10.2

128MB

200MB
(For applications only.

Apart from this, 
1GB or more free space

800x600 dots 
16-bit color

USB 1.1

G4 Processor

Mac OS 10.3

512MB or above

2GB or above

1024x768 dots 
24-bit color

USB 2.0 High Speed

Minimum Recommended

Windows Environment Macintosh Environment

Ajuste de la CAM: 
Utilización de la modalidad USB

Notas

✤ No se garantiza que todas las PC configuradas con el entorno anterior
funcionen correctamente.

✤ No se garantiza la conexión USB utilizando un Hub de USB externo o
una tarjeta USB adicional.

✤ Si su sistema operativo es Windows 2000/XP, inicie la sesión como
[Administrador (administrador de la PC)] (o como usuario con privilegios
equivalentes) para instalar el controlador.

✤ Si la capacidad de la PC es baja, es posible que el archivo de video no
se reproduzca con normalidad o se detenga a menudo.

✤ Si la capacidad de la PC es baja, es posible que tarde tiempo la edición
del archivo de video.

Velocidad de USB según el sistema
El USB de alta velocidad no está garantizado si no se instala el controlador
suministrado o se tiene un sistema operativo que no sea Microsoft
Windows y Mac OS X de Apple.
✤ Windows 98SE/ME: USB a toda velocidad
✤ Windows 2000: Superior a Service Pack 4 - USB de alta velocidad
✤ Windows XP: Superior a Service Pack 1- USB de alta velocidad
✤ Mac OS X: Superior a 10.3. - USB de alta velocidad

Entorno del sistema

Pentium III, 600MHz

Windows® 98SE/ME

128 MB

200 MB (Sólo para

aplicaciones. Aparte

de esto, 1 GB o más

de espacio libre.)

800 x 600 puntos,

color de 16 bits

USB 1.1

Procesador:

Sistema operativo

Memoria

Espacio libre

en disco duro

Resolución de

pantalla

USB

Pentium 4, 2 GHz

Windows® 2000/XP

512 MB o superior

2 GB o superior

1024 x 768
puntos, color de

24 bits

USB 2.0 de alta
velocidad

G3 500 MHz

Mac OS 10.2

128 MB

200 MB (Sólo para
aplicaciones. Aparte
de esto, 1 GB o más

de espacio libre.)

800 x 600 puntos,

color de 16 bits

USB 1.1

Procesador G4

Mac OS 10,3

512 MB o superior

2 GB o superior

1024 x 768
puntos, color de

24 bits

USB 2.0 de alta
velocidad

Entorno Windows

Mínimo Recomendado

Entorno Macintosh

Mínimo Recomendado
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Using PC Cam
You can use this the CAM as a PC camera for video chatting, video
conference and other PC camera applications.

1. Connect the CAM to the PC with the USB
cable. 

2. Slide [Mode Selector] down to turn on the
CAM.
� USB mode screen appears automatically.

3. Slide the [ � /� ] switch to select <PC-Cam>
and press the [OK] button.

Notes

✤ This function requires the installation of the supplied USB
Streaming Driver and Software. Refer to page 119 for further
details.

✤ The CAM can be used as a PC Camera for programs such as
Windows Messenger. The use of the PC Cam varies depending
on the Software. Refer to the documentation of the respective
software products.

✤ PC-Cam functions at ‘Full Speed’ when used with Windows ME
or greater.

ENGLISHESPAÑOL

2

3

Back

USB Mode

PC-Cam

PictBridge

USB 2.0 MassStorage

USB 1.1 MassStorage

Back

USB Mode

PC-Cam

PictBridge

USB 2.0 MassStorage

USB 1.1 MassStorage

Ajuste de la CAM: 
Utilización de la modalidad USB

Utilización de PC Cam
Puede utilizar esta CAM como una cámara de PC para chat con
video, videoconferencia y otras aplicaciones de cámara en PC.

1. Conecte la CAM a una PC utilizando el cable
USB.

2. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM.
� Aparece automáticamente la pantalla de la

modalidad USB.

3. Deslice el interruptor [ � /� ] hasta seleccionar
<PC-Cam>  y presione el botón [OK].

Notas

✤ Esta función requiere la instalación del software y el controlador
de USB Streaming. Consulte la página 119 para obtener más
detalles.

✤ La CAM se puede utilizar como una cámara para PC para
programas como Windows Messenger. El uso de PC Cam varía
dependiendo del software. Consulte la documentación de los
respectivos productos de software.

✤ PC Cam funciona a ‘Toda velocidad’ cuando se utiliza con
Windows ME o superior.
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Connecting the CAM to a Printer
By connecting the CAM to printers with PictBridge support (sold
separately), you can send images from the internal memory or external
memory (Memory Stick or Memory Stick Pro) 
directly to the printer with a few simple operations.

1. Connect the CAM to the printer with
PictBridge support with the USB cable. 

2. Slide [Mode Selector] down to turn on the CAM.
� USB mode screen appears automatically.

3. Slide the [ � /� ] switch to select
<PictBridge> and press the [OK] button.

4. Slide the [ � /� ] switch to select <Date> and
press the [OK] button.

5. Slide the [ � /� ] switch to select <On> or
<Off> and press the [OK] button.

6. Slide the [ � /� ] switch to select <Copies>
and press the [OK] button.

7. Slide the [ � /� ] switch to select desired
number and press the [OK] button.
� You can select the number of copy from 1 to 99.

8. Slide the [ � /� ] switch to select <Print> and
press the [OK] button.

Notes

✤ If you select <Back> in the menu, the previous menu
appears.

✤ If you want to select the next or previous photo,
select <Next> or <Previous> using [ � /� ] switch.
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4
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Back

USB Mode

PC-Cam

PictBridge

USB 2.0 MassStorage

USB 1.1 MassStorage

Back

USB Mode
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PictBridge

USB 2.0 MassStorage

USB 1.1 MassStorage
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Copies 1
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Ajuste de la CAM: 
Utilización de la modalidad USB

Conexión de la CAM a una impresora

1. Conecte la CAM a la impresora con PictBridge
utilizando el cable USB. 

2. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM.
� Aparece automáticamente la pantalla de la

modalidad USB.

3. Deslice el interruptor [ � /� ] hasta seleccionar
<PictBridge> y presione el botón [OK].

4. Deslice el interruptor [ � /� ] hasta seleccionar
Date <Fecha> y presione el botón [OK].

5. Deslice el interruptor [ � /� ] hasta seleccionar
<On> <Act.> o <Off> <Des.> y presione el botón
[OK].

6. Deslice el interruptor [ � /� ] hasta seleccionar
<Copies> (Copias) y presione el botón [OK].

7. Deslice el interruptor [ � /� ] hasta seleccionar
el número que desea y presione el botón [OK].
� Puede seleccionar el número de copia de 1 a 99.

8. Deslice el interruptor [ � /� ] hasta seleccionar
<Print> (Imprimir) y presione el botón [OK].

Notas

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.

✤ Para seleccionar la foto anterior o siguiente,
seleccione <Next> (Siguiente) o <Previous>
(Anterior) con el interruptor [ � /� ].

Al conectar la CAM a impresoras con PictBridge (se vende por
separado), puede enviar imágenes desde la memoria interna o la  

memoria externa (Memory Stick o Memory Stick Pro)
directamente a la impresora con unas simples
operaciones.
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Connecting the External Camera Module ........................108

Recording Video Using External Camera Module...........108

Wearing the External Camera Module ..............................109
Connecting the extension cable 
while the set is in the Carrying Case................................109
Mounting the External Camera Module 
on Rubber Mount ..............................................................109
Using the Short and Long Mount Bands ..........................110

Using the External
Camera Module55

Conexión del módulo de Lente externo ...........................108

Grabación de video con el módulo 
de Lente externo..................................................................108

Cómo llevar puesto el módulo 
de Lente externo..................................................................109

Conecte el cable de extensión mientras 
el equipo está en la funda para transporte ......................109
Colocación del módulo de Lente externo 
en la montura de goma.....................................................109
Uso de las bandas de montura cortas y largas................110

Uso del módulo de
Lente externo55
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Using External Camera Module accessory, enjoying
sports activity can be directly recorded. 
Before using, insert batteries in External Camera Module.
First, setup the External Camera in the Video In mode.
(See page 39)

Using the External Camera Module :
Connecting the External Camera Module

1. Connect the extension cable to the AV Input/Output
terminal of the CAM. You can connect the External
Camera Module Controller’s connector to the AV
Input/Output terminal of the CAM.

2. Connect the extension cable to the External
Camera Module Controller’s connector. You may
fix the External Camera using Tripod Receptacle 
or Mounting Band.  

Notes

✤ When the External Camera Module is connected to AV Input/Output of the
Cradle, the [Record Start/Stop] button of the External Camera Module does
not operate.

✤ If you set the Hold function with the MP3/External Camera Hold switch, you
can’t delete, lock or copy music files. You can only use Power switch and
volume [+] / [ - ] buttons.

1. Press the [Power] button on the External
Camera Module.

2. Press the [Record Start/Stop] button on the External Camera
Controller to start recording. 
� LED lamp lights in red.

The elapsed and remaining times are displayed and it starts recording.
3. Press the [Record Start/Stop] button again to stop recording.

� It stops recording and the CAM is ready again.
4. Press the [Power] button again to turn off the External Camera Module.

Notes

✤ When the External Camera Module is connected, [Record/Stop] button
of the main set does not operate.

✤ When recording signal from the External Camera Module, the [Power]
button of the External Camera Module does not operate.

✤ Do not connect the Cradle when the Line Input of the set is in use.

Uso del módulo de Lente externo: 
Conexión del módulo de Lente externo

1. Conecte el cable de extensión a la toma de
entrada/salida de AV de la CAM. Puede conectar
el conector del controlador del modulo de
cámara externa a la toma de entrada/salida de
AV de la CAM.

2. Conecte el cable de extensión al conector del
controlador del módulo de cámara externa. Puede
fijar la cámara accesoria con ayuda del orificio
para tripie o de la banda de fijación.

Notas

✤ Cuando el módulo externo de cámara se conecta a la entrada/salida de AV
del soporte, no está operativo el botón [Record Start/Stop] del módulo
externo de cámara.

✤ Si fija la función Hold con el interruptor Hold de cámara externa/MP3, no
podrá borrar, bloquear ni copiar archivos de música. Sólo o puede utilizar el
interruptor Power y los botones de volumen [+]/[ - ].

Gracias al accesorio del módulo de lente externo, puede
grabar sus actividades deportivas directamente mientras las
practica. Antes de usarlo, introduzca baterías en el módulo de
cámara externa. Primero, configure la lente externa en la
modalidad de Video In <Entrada de video>. 
(Consulte la página 39)
1. Presione el botón [Power] en el módulo de lente

externa.
2. Presione el botón [Record Start/Stop] en el controlador del lente

externo para comenzar la grabación.
� El indicador LED aparece en rojo.

Aparece el tiempo transcurrido y restante y se inicia la grabación.
3. Presione el botón [Record Start/Stop] de nuevo para detener la

grabación.
� Detiene la grabación y la CAM está preparada de nuevo.

4. Presione el botón [Power] de nuevo para apagar el módulo de lente
externo.

Notas

✤ Cuando esté conectado el módulo lente externo, el botón [Record/Stop] del
equipo principal no está operando.

✤ Cuando se graba desde el módulo de cámara externa, el botón [Power] del
módulo no está operando.

✤ No conecte el soporte cuando la entrada de línea al equipo está en uso.

Power button Record Start/Stop

Connecting the External Camera Module to CAM

Recording Video Using the External Camera Module

Conexión del módulo de cámara externa a la CAM

Grabación de video con el módulo de Lente externo

ENGLISH
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Connecting the extension cable while the set is
in the Carrying Case

Mounting the External Camera Module on Rubber Mount

Using the External Camera Module : 
Wearing the External Camera Module

1. Insert the set into the Carrying Case
while its battery faces front side.

2. Open the cable cover strap on the
bottom side of the Carrying Case,
and plug the extension cable’s jack
into the AV Input/Output terminal of
the set.

3. Fix the extension cable by covering
the cable cover strap (non-woven fabric).

1. Insert the velcro strap (velcro
face down) into the small slot
located on the side of the rubber
mount.

2. Pull the lead end along the
bottom through the opposite slot. 

3. Spread the rubber on top of the
mount and insert.

4. Run the Velcro Strap through its
buckle.

5. Run the lead back under the
Rubber mount and fasten the
velcro together.

6. When you press the [Power]
button to start recording, press on side of the Rubber
Mount.

Conecte el cable de extensión mientras el
equipo está en la funda para transporte.

Colocación del módulo de Lente externo en la montura de goma

Uso del módulo de Lente externo: 
Cómo llevar puesto el módulo de Lente externo

1. Introduzca el equipo en la funda
para transporte con la parte de la
batería de frente.

2.  Abra la correa de protección del 
cable situada en la parte inferior de
la funda para transporte y conecte
el enchufe del cable de extensión a
la toma de entrada/salida de AV del
equipo.

3. Fije el cable de extensión y cierre la correa de protección del
cable (material no tejido).

1. Introduzca la correa de velcro
(velcro hacia abajo) en la
pequeña ranura situada en el
lateral de la montura de goma.

2. Estire el extremo del cable por la
parte inferior hasta atravesar la
ranura del otro lado.

3. Extienda la goma por encima de
la montura.

4. Atraviese la correa de velcro por
la hebilla.

5. Lleve el cable hacia atrás debajo
de la montura de goma y junte
las correas de velcro.

6. Cuando presione el botón [Power] para comenzar la grabación,
presione sobre la montura de goma.

1 2 3

1 2 3

4 5 6

Hook

ENGLISH ENGLISH
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Mientras la videocámara está dentro de su bolso o mochila, puede
incorporar el módulo de lente externo situado en la montura de
goma a cualquier sitio con la ayuda de las bandas de montura
cortas y largas.

1.  Atraviese la correa de la banda de
montura larga (o la banda de
montura corta) por las dos ranuras
grandes situadas en la montura de
goma tal y como se indica en la
ilustración.

2.  Atraviese la correa por la hebilla
para ajustar la firmeza.

3.  Abroche la correa.

Notas

✤ Ajuste y acorte el cable de extensión conectado al módulo de
lente externo para evitar accidentes con objetos cercanos.
Si no, el cable de extensión podría desconectarse o provocar un
accidente.

✤ La caída accidental o golpe del módulo de lente externo con
otros objetos puede causar problemas con el dispositivo. 
Cuando utilice el dispositivo, debe colocarlo en la montura de
goma para evitar caídas y golpes.

✤ El contacto directo de la montura de goma con la piel durante un
tiempo prolongado puede producir alergia o irritación en la piel.
Evite un contacto prolongado.

While the camcorder is inside your bag or backpack, you can attach
the External Camera Module mounted on the Rubber Mount to
anywhere with help of the Short and Long Mount Bands.

1. Run the strap of Long Mount Band
(or Short Mount Band) through both
of the large slots on the rubber
mount as illustrated.

2. Run the strap through the buckle to
adjust the tightness.

3. Fasten the strap. 

Notes

✤ Adjust and shorten the extension cable connected to the External
Camera Module to avoid accidental catching of surrounding
objects.
Otherwise, the extension cable may disconnect or cause an
accident.

✤ Dropping the External Camera Module or bumping it to other
objects may cause device failure. When using the device, you
must attach it to the rubber mount, and be careful not to drop or
strike it.

✤ A direct contact of the Rubber Mount with your skin for a long
period of time may cause skin irritation or allergy. Avoid a long term
contact.

Using the External Camera Module : 
Wearing the External Camera Module

Using the Short and Long Mount Bands 

Uso del módulo de Lente externo: 
Cómo llevar puesto el módulo de Lente externo

Uso de las bandas de montura cortas y largas

1
2

3

Rubber Mount
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Notas

✤ Puede detener y reproducir archivos de video utilizando el mismo
botón que se ha utilizado para la reproducción de archivos de video
en la pantalla LCD de la CAM. (Consulte las páginas 40 y 41)

✤ Si conecta el cable Mono AV a la CAM, no se puede reproducir el
archivo de video.

✤ Si conecta la clavija de AV al soporte y a la CAM simultáneamente,
la señal de salida de AV desciende al 50%.
Conecte la clavija de AV a un solo sitio o al otro.

Información diversa: 
Conexión de la CAM a otros dispositivos

Conexión de la CAM a un televisor
Puede conectar la CAM directamente a un equipo de TV para
reproducir archivos de video en un televisor.

1. Conecte el cable de audio/video
a la toma de salida de AV de la
CAM o del soporte.

2. Conecte el cable de audio/video
al terminal de entrada externa
del equipo de TV haciendo
coincidir el cable con los
colores de los terminales.

3. Deslice hacia abajo el [Selector
de modalidad] para encender la
CAM.
� Aparece la pantalla <Video

Record> (Grabar video).

4. Presione el botón [Back] para
reproducir el archivo de video
en la modalidad <Video Record>
(Grabar video).

5. Deslice el interruptor [� /� ] hasta encontrar el archivo de
video que desea reproducir.

6. Presione el botón [OK] para reproducir el archivo de video.

Connecting the CAM to TV
You can connect the CAM to a TV set directly to play video files on
the TV monitor.

Notes

✤ You can stop and play video files using the same button as used
for playing video files on the LCD monitor of the CAM. 
(Refer to pages 40 to 41)

✤ If you connect a Mono AV cable to the CAM, the video file cannot
be played.

✤ If you connect the AV Jack to the cradle and the CAM
simultaneously, AV output signal decreases to 50%. 
Connect the AV Jack to only one or the other.

ENGLISH
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Connecting the CAM to other Devices

1. Connect the Video/Audio cable
to the AV Input/Output Jack of
the CAM or cradle.

2. Connect the Video/Audio cable
to the external input terminal of
your TV set by matching the
cable to the colors of the
terminals.

3. Slide [Mode Selector] down to
turn on the CAM.
� The Video Record screen

appears.

4. Press the [Back] button to play
the video file in Video Record
mode.

5. Slide [� /� ] switch to find the video file you want to play.

6. Press the [OK] button to play the video file.

Line Input
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Información diversa: 
Conexión de la CAM a otros dispositivos

Conexión de la CAM a una videocasetera
Puede conectar la CAM a una videocasetera para copiar los
archivos grabados en la cinta de video.

1. Conecte el cable de
audio/video a la toma de
salida de AV de la CAM o del
soporte.

2. Conecte el cable de
audio/video al terminal de
entrada externa de la
videocasetera haciendo
coincidir los colores de las
terminales.

3. Conecte el cable de
audio/video a la salida de
línea de video y a la entrada
de línea de TV.

4. Seleccione la ‘Entrada’ en el
televisor, videocasetera o
control remoto del televisor.

Miscellaneous Information: 
Connecting the CAM with other Devices
ENGLISH ENGLISH
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Note

✤ If TV set has no Line Input, you cannot view the output screen of 
the CAM.

Connecting the CAM to a VCR
You can connect the CAM to VCR to copy the recorded files to the
video tape.

1. Connect the Video/Audio
cable to the AV Input/Output
Jack of the CAM or cradle.

2. Connect the Video/Audio
cable to the external
input terminal of your VCR
set by matching the 
colors of the terminals.

3. Connect the Video/Audio
cable to the Video line
Output and TV line Input.

4. Select the ‘Input’ on the TV,
VCR or the remote control
of TV.

1 2 3 4 5

6 7 8 9 10

ALARM IN ALARM OUT ALARM RESET GND TRIGGER OUT
TAPE END OUT SERIES OUT GND SERIES IN 1 SHOT REC IN

1 2 3 4 5 6 7 8 9 101 2 3 4 5 6 7 8 9 10

INOUT

OUT IN
Line Input

Line Output

Line Input

Nota

✤ Si el equipo de TV no tiene entrada de línea, no puede ver la
pantalla de salida de la CAM.
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You can copy your recorded files to a regular blank video tape.
Connect the CAM to a VCR using the Audio/Video cable before
recording. 

Notes

✤ Refer to operating instructions of your TV or VCR for detailed
information on connecting external devices.

✤ You can stop and play video files using the same button as used for
playing video files on the LCD monitor of the CAM. (Refer to page 40)

Copying Video files to a VCR Tape

1. Insert a blank video tape
and select ‘Line Input’ on
the VCR.

2. Slide [Mode Selector] down
to turn on the CAM and slide
it down again.
� The Mode Selection screen

appears.

3. Select <Play> in the Video
mode to find the desired
video file with the [ � /� ]
switch. (Refer to page 40)

4. Slide the [ � /� ] switch to
find the video file you want
to copy and press the [OK]
button.

5. Press the [Record/Stop]
button on the VCR to start
recording.

ESPAÑOL

1 2 3 4 5

6 7 8 9 10

ALARM IN ALARM OUT ALARM RESET GND TRIGGER OUT
TAPE END OUT SERIES OUT GND SERIES IN 1 SHOT REC IN

1 2 3 4 5 6 7 8 9 101 2 3 4 5 6 7 8 9 10

INOUT

OUT IN
Line Input

Line Output

Line Input

Información diversa: 
Conexión de la CAM a otros dispositivos

Puede copiar los archivos grabados en una cinta de video vacía.
Conecte la CAM a una videocasetera utilizando el cable de
audio/video antes de grabar.

Notas

✤ Consulte las instrucciones de funcionamiento del televisor o de la
videocasetera para obtener información detallada sobre la conexión
de dispositivos externos.

✤ Puede detener y reproducir archivos de video utilizando el mismo
botón que se ha utilizado para la reproducción de archivos de video
en la pantalla LCD de la CAM. (Consulte la página 40).

Copia de archivos de video en una cinta de video

1. Inserte la cinta de video vacía y
seleccione la ‘Entrada de Línea’
en la videocasetera.

2. Deslice hacia abajo el [Selector
de modalidad] para encender la
CAM y deslícelo hacia abajo de
nuevo.
� Aparece la pantalla <Mode

Selection> (Selección de
modalidad).

3. Seleccione <Play> (Reproducir)
en la modalidad  Video (Video)
para localizar el archivo de
video que desea con el
interruptor  [ � /� ]. 
(Consulte la página 40).

4. Deslice el interruptor [ � /� ]
hasta encontrar el archivo de
video que desea copiar y
presione el botón [OK].

5. Presione el botón [Record/Stop]
en la videocasetera para
comenzar la grabación.
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Note

✤ The quality of an input signal recorded through the Line In input
terminal cannot be guaranteed unless it comes from a digital
device (DVD, DVC, etc.).

Miscellaneous Information: 
Connecting the CAM to other Devices

Recording unscramble contents from other
digital devices
You can connect other external digital devices to CAM to record
unscrambled contents.

1. Connect the AV input/output
cable to the AV input/output
Jack of the CAM or Cradle.

2. Connect the Audio/Videocable
to the external output terminal
of your digital devices
(DVD,DVC, etc.) by matching
the  cable to the colors of the
terminals. 

3. Slide [Mode Selector] down to
turn on the CAM. 
� The Video Record screen

appears.

4. Press the [Menu] button and
slide the [ � /� ] switch. Press
the [OK] button after selecting
<Video In>. 

5. Slide the [ � /� ] switch to
select <Normal> and press the [OK] button.

6. Play back the other digital devices.

7. Press the [Record/Stop] button to start recording.

8. To stop recording, press the [Record/Stop] button again.

Nota

✤ La calidad de una señal de entrada grabada a través de la toma de
entrada a la línea no puede garantizarse a menos que proceda de
un dispositivo digital (DVD, DVC, etc.).

Información diversa: 
Conexión de la CAM a otros dispositivos

Grabación de contenidos codificados desde otros
dispositivos.
Puede conectar a la CAM otros dispositivos digitales externos para
grabar contenidos codificados.

1. Conecte el cable de
entrada/salida de AV a la toma
de entrada/salida de AV de la
CAM o del soporte.

2. Conecte el cable de video/audio
al terminal de salida externo de
los dispositivos digitales (DVD,
DVC, etc.) haciendo coincidir el
cable con los colores de los
terminales.

3. Deslice hacia abajo el [Selector de
modalidad] para encender la CAM.
� Aparece la pantalla Video

Record <Grabar video>.
4. Presione el botón [Menu] y

deslice el interruptor [� /� ].
Presione el botón [OK] tras
seleccionar Video In <Entrada
de video>.

5. Deslice el interruptor [� /� ] hasta seleccionar <Normal> y
presione el botón [OK].

6. Reproduzca los otros dispositivos digitales.
7. Presione el botón [Record/Stop] para comenzar la grabación.
8. Presione el botón [Record/Stop] de nuevo para detener la

grabación.

ENGLISHESPAÑOL
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1. Inserte la CAM en el soporte.

2. Conecte el cable USB que se
facilita al puerto USB del
soporte.

3. Deslice hacia abajo el [Selector
de modalidad] para encender la
CAM y deslícelo hacia abajo de
nuevo.
� Aparece la pantalla <Mode

Selection> (Selección de
modalidad).

4. Conecte el otro lado del cable USB al puerto USB de la PC.

ENGLISH Miscellaneous Information: 
Connecting the CAM to other Devices
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Connecting the CAM to a PC using the USB cable
You can connect the CAM to a PC that supports USB connections. 
Use the provided USB cable for connection to a PC.

1. Insert the CAM into the cradle.

2. Connect the provided USB cable
to USB port of the cradle.

3. Slide [Mode Selector] down to
turn on the CAM and slide it
down again.
� The Mode Selection screen

appears.

4. Connect the other side of the
USB cable to the USB port of
your PC.

ESPAÑOLInformación diversa: 
Conexión de la CAM a otros dispositivos

Conexión de la CAM a una PC utilizando el cable USB
Puede conectar la CAM a una PC que admita conexiones USB.
Utilice el cable USB que se suministra para la conexión a la PC.
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Installing Image Mixer
You can edit the video files and use the PC Camera function with this
program.

1. Quit all files and folders currently
open on your computer.

2. Insert the program CD into the 
CD-ROM drive. 
� The Setup screen appears 

automatically.
� Open the CD-ROM Drive in ‘My

Computer’ and double-click
<Iminst.exe>.

3. Click <ImageMixer>

4. Select the language.

5. Follow the steps on the screen.
� You can use the Image Mixer after restarting your PC.

Windows

ENGLISHESPAÑOLInformación diversa: 
Instalación de programas

Instalación de ImageMixer
Puede editar los archivos de video y utilizar la función PC Camera
con este programa.

1. Salga de todos los archivos y
carpetas actualmente abiertos en la
PC.

2. Inserte el CD del programa en la
unidad de CD-ROM.
� Aparece automáticamente la pantalla

de configuración.
� Abra la unidad de CD-ROM en 

‘Mi PC’ y haga doble clic en
<Iminst.exe>.

3.   Haga clic en <ImageMixer>.

4.   Seleccione el idioma.

5. Siga los pasos que aparecen en pantalla.
� Puede utilizar ImageMixer tras reiniciar la PC.

Windows
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1. Quit all files and folders currently
open on your computer.

2. Insert the program CD into the 
CD-ROM drive.
� The Setup screen appears

automatically.
� If not, double-click the CD-ROM icon

on the Desktop, and double-click
<Iminstall>.

3. Click <ImageMixer>. 

4. Select the language.

5. Follow the steps on-screen.
� You can use ImageMixer after restarting your PC.

Macintosh

Notes

✤ If Image Mixer appears to not be installed, re-install it again but you
should first attempt to uninstall it. Uninstalling ‘Image Mixer’ should
be done via the  ‘Control Panel’ on your PC.

✤ If you play the MPEG4 video file, the ratio of the screen may not
match.

✤ If you click "ImageMixer", all softwares in the program CD are
installed automatically.

✤ It is necessary to install ImageMixer for playback the CAM recorded
video files on your PC.

ESPAÑOLInformación diversa: 
Instalación de programas

1. Salga de todos los archivos y
carpetas actualmente abiertos en la
PC.

2. Inserte el CD del programa en la
unidad de CD-ROM.
� Aparece automáticamente la pantalla

de configuración.
� Si no aparece, haga doble clic en el

icono del CD-ROM del escritorio y
haga doble clic en <Iminstall>.

3. Haga clic en <ImageMixer>.

4. Seleccione el idioma.

5. Siga los pasos que aparecen en pantalla.
� Puede utilizar ImageMixer tras reiniciar la PC.

Macintosh

Notas

✤ Si parece que ImageMixer no se ha instalado, vuelva a instalarlo
de nuevo, pero debe intentar desinstalarlo antes. 
La desinstalación de ‘ImageMixer’ debe realizarse a través del
‘Panel de Control’ de la PC.

✤ Si reproduce el archivo de video MPEG4, es posible que la
relación de altura/anchura de la pantalla no coincida.

✤ Si hace clic en ‘ImageMixer’, se instalan automáticamente todos
los programas existentes en el CD de software.

✤ Es necesario instalar ImageMixer para que la CAM reproduzca los
archivos de video grabados en la PC.
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ENGLISH Miscellaneous Information:
Installing Programs

1. Close all windows currently opened and 
insert the provided software CD into the 
CD-ROM drive.

2. Place the CAM on the cradle and connect 
the USB cable to the USB port of the cradle.
USB Mode screen appears.

3. Slide the [ � /� ] switch to select <PC-Cam> 
and press the [OK] button.

4. Follow the instructions displayed on the screen 
to finish setup.

Windows

Installing software for using PC-Cam

ENGLISHESPAÑOLInformación diversa: 
Instalación de programas

1. Close all windows currently opened and 
insert the provided software CD into the 
CD-ROM drive.

2. Place the CAM on the cradle and connect 
the USB cable to the USB port of the cradle.
USB Mode screen appears.

3. Slide the [ � /� ] switch to select <PC-Cam> 
and press the [OK] button.

4. Follow the instructions displayed on the
screen 
to finish setup.

Windows

Instalación de software para utilizar PC Cam

2

3

Back

USB Mode

PC-Cam

PictBridge

USB 2.0 MassStorage

USB 1.1 MassStorage
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Installing Windows98SE Driver 
(For Windows98SE only)
To use the CAM as a removable drive on Windows98SE, you may
need to install the Windows98SE Driver.

1. Close all windows currently opened and 
insert the provided software CD into the 
CD-ROM drive.

2. Place the CAM on the cradle and connect the 
USB cable to the USB port of the cradle.
USB Mode screen appears.

3. Slide the [ � /� ] switch to select 
<USB 2.0 Mass Storage> or <USB 1.1 Mass
Storage> and press the [OK] button.

4. Installation process automatically begins.

Información diversa: 
Instalación de programas

Instalación del controlador de Windows98SE
(sólo para Windows98SE)
Para utilizar la CAM como una unidad extraíble en Windows98SE,
es posible que tenga que instalar el controlador de Windows98SE.

1. Close all windows currently opened and 
insert the provided software CD into the 
CD-ROM drive.

2. Place the CAM on the cradle and connect the 
USB cable to the USB port of the cradle.
USB Mode screen appears.

3. Slide the [ � /� ] switch to select 
<USB 2.0 Mass Storage> or <USB 1.1 Mass
Storage> and press the [OK] button.

4. Installation process automatically begins.

2

Back

USB Mode

PC-Cam

PictBridge

USB 2.0 MassStorage

USB 1.1 MassStorage
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ENGLISHESPAÑOLMiscellaneous Information: 
Connecting the CAM with other Devices

After completing the data transfer, you must disconnect the cable in 
the following way.

1. Select the removable disk icon on your computer screen and click
the right mouse button to select  ‘Safely Remove Hardware’.

2. Select ‘Stop’ and disconnect the USB cable when the pop-up
screen disappears.

Disconnecting USB Connection

Notes

✤ If you disconnect the USB cable from the PC or the CAM during
the data transfer, the data transfer will stop and the data may be
damaged.

✤ If you connect the USB cable to a PC using a USB HUB or with
other device at the same time, it might cause conflict and may not
work properly. If this occurs, remove all other devices and try the
connection again.

✤ The CAM may operates abnormally in the recommended system
environment depending on the assembling of PC. 
For example, the video file is played abnormally.  

✤ Once you select the USB 2.0 MassStorage, USB 1.1 MassStorage,
PC-Cam or PictBridge, you cannot select the modes. Disconnect
the USB cable or turn on the CAM again to select the modes.

✤ If you disconnect the USB cable, the message ‘Now refresh file list’
appears for 1 second.

✤ PCs used via a USB hub or with a USB card are not guaranteed to
work in all circumstances.

Información diversa: 
Conexión de la CAM a otros dispositivos

Tras completar la transferencia de datos, debe desconectar el cable
de la forma siguiente:
1. Seleccione el icono del disco extraíble en la PC y haga clic en el

botón derecho del mouse para seleccionar ‘Quitar Hardware con
Seguridad’.

2. Seleccione 'Detener' y desconecte el cable USB cuando
desaparezca la pantalla emergente.

Desconexión del USB

Notas

✤ Si desconecta el cable USB de la PC o de la CAM durante la
transferencia de datos, la transferencia de datos se detendrá y
puede que los datos resulten dañados.

✤ Si conecta el cable USB a una PC utilizando el HUB USB o con
otro dispositivo al mismo tiempo, puede causar conflictos y puede
que no funcione correctamente. Si esto ocurre, retire el resto de
dispositivos e intente la conexión de nuevo.

✤ Es posible que la CAM no funcione de forma normal en el entorno
de sistema recomendado dependiendo del montaje de la PC.
Por ejemplo, el archivo de video se reproduce de forma anormal. 

✤ Una vez que seleccione <USB 2.0 MassStorage>, <USB 1.1
MassStorage>, <PC-Cam> o <PictBridge>, no puede seleccionar
las modalidades. Desconecte el cable USB o encienda la CAM de
nuevo para seleccionar la modalidad.

✤ Si desconecta el cable USB, aparece por un segundo el mensaje
‘Actualizar la lista ahora’.

✤ No se garantiza que funcionen en todas las circunstancias las PC
utilizadas a través del Hub de USB o con una tarjeta USB.
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With the PictBridge Support, you can control the
printer directly through the CAM in order to print
out stored pictures.
For direct printing of your stored pictures using the
PictBridge function, you must connect the CAM to
a PictBridge printer using a USB cable.

1. Connect the CAM to the PictBridge printer with
the USB cable. 

2. Slide [Mode Selector] down to turn on the CAM.
� USB menu screen appears automatically.

3. Slide the [ � /� ] switch to select <PictBridge>
and press the [OK] button.

4. Slide the [ � /� ] switch to select <Copies> and
press the [OK] button.

5. Slide the [ � /� ] switch to select desired
number and press the [OK] button.
� You can select the number of copies from 1 to 99.

6. Slide the [ � /� ] switch to select <Print> and
press the [OK] button.

Printing with PictBridge Function

Notes

✤ If you select <Back> in the menu, the previous menu
appears.

✤ If you want to select the next or previous photo, select
<Next> or <Previous> using [ � /� ] switch.

✤ For further details about printing photos, refer to the
User's manual of the printer.

ESPAÑOL

Back

USB Mode

PC-Cam

PictBridge

USB 2.0 MassStorage

USB 1.1 MassStorage

Print

Next Photo

Previous Photo

Date Off

Copies 5

PictBridge 100-0056

Print

Next Photo

Previous Photo

Date Off

Copies 5

PictBridge 100-0056

Información diversa: 
Impresión de fotos

1. Conecte la CAM a una impresora PictBridge
utilizando el cable USB.

2. Deslice hacia abajo el [Selector de modalidad]
para encender la CAM.
� Aparece automáticamente la pantalla de la

modalidad USB.

3. Deslice el interruptor [ � /� ] hasta seleccionar
<PictBridge> y presione el botón [OK].

4. Deslice el interruptor [ � /� ] hasta seleccionar
<Copies> (Copias) y presione el botón [OK].

5. Deslice el interruptor [ � /� ] hasta seleccionar
el número que desea y presione el botón [OK].
� Puede seleccionar el número de copia de 1 a 99.

6. Deslice el interruptor [ � /� ] hasta seleccionar
<Print> (Imprimir) y presione el botón [OK].

Con el soporte PictBridge, puede controlar la
impresora directamente a través de la CAM para
imprimir imágenes almacenadas.
Para la impresión directa de imágenes
almacenadas utilizando la función PictBridge,
debe conectar la CAM a una impresora
PictBridge utilizando un cable USB.

Impresión con la función PictBridge

Notas

✤ Si selecciona <Back> (Volver) en el menú, aparece
el menú anterior.

✤ Para seleccionar la foto anterior o siguiente,
seleccione <Next> (Siguiente) o <Previous>
(Anterior) con el interruptor [ � /� ].

✤ Para obtener más detalles sobre la impresión de
fotos, consulte el manual del usuario de la impresora.
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Printing Photos

Printing Photos with DPOF Files
DPOF (Digital Printing Order Format) creates print information for
photos you select and numbers them
on the Memory Stick or Memory Stick Pro. You can easily make
prints on a DPOF compatible printer or order copies.

Note

✤ For further details about printing photos, refer to the User's manual
of the printer.

1. Set the print information for the photo you want to print. 
(Refer to page 61)

2. Remove the Memory Stick from the CAM and insert it into the
photo printer.

3. Follow the steps of the printer to print out photos.

Printing DPOF files of the Memory Stick

ENGLISHESPAÑOLInformación diversa: 
Impresión de fotos

Impresión de fotos con los archivos DPOF
DPOF (Digital Printing Order Format, Formato de orden de impresión
digital) crea información de impresión para fotos y los numera en el
Memory Stick o en el Memory Stick Pro. Puede fácilmente realizar
impresiones en una impresora compatible con DPOF o solicitar
copias.

Nota

✤ Para obtener más detalles sobre la impresión de fotos, consulte el
manual del usuario de la impresora.

1. Defina la información de impresión de la foto que desee imprimir.
(Consulte la página 61).

2. Retire el Memory Stick de la CAM e insértelo en la impresora
fotográfica.

3. Siga los pasos de la impresora para imprimir las fotos.

Impresión de archivos DPOF del Memory Stick
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✤ For the safekeeping of the CAM, follow these steps.
� Turn the CAM off.
� Remove the Battery Pack (refer to page 20).
� Remove the Memory Stick (refer to page 34).

✤ To prevent any damage to the LCD monitor, do not apply excessive force on
its moving parts.

✤ Do not drop or in anyway shock the CAM.

✤ For prolonged use of the CAM, avoid using it in places subject to excessive
humidity or dust.

✤ Do not leave the CAM in places subject to:
� Excessive humidity, steam, soot or dust.
� Excessive shock or vibration.
� Extremely high (over 50°C or 122°F) or extremely low (under 0°C or 32°F)

temperatures.
� Strong electromagnetic fields.
� Direct sunlight or in a closed car on a hot day.

✤ For the safe use of the battery pack, follow these.
� To conserve battery power, be sure to turn off the CAM power when not in use.
� Battery consumption may vary depending on the condition of use. Recording with

many starts and stops, frequent zooming, and recording in low temperatures will
shorten actual recording times.

� Dispose of used battery packs promptly. Do not dispose of them in fire.
� The battery pack will become warm during charging and use. This is not a

malfunction.
� The battery pack has a limited service life. If the period of use becomes noticeably

shorter with a normal charge, the battery pack is at the end of its service life.
Replace it with a new battery pack.

✤ For the safe use of the Memory Stick and the Memory Stick Pro, follow these.
� The Memory Stick should be stored away from heaters and other heat sources.

Avoid storing Memory Sticks under direct sunlight and avoid electromagnetic fields.
� Do not power off any devices while transferring data, as this may destroy the data.
� Back up your image data often to a hard disk or other permanent storage media.
� Format the Memory Stick periodically.
� When formatting the Memory Stick or Memory Stick Pro, format in the CAM. If you

format it on PC, use the ‘Memory Stick Formatter’ in the supplied software CD.

Maintenance : 
Cleaning and Maintaining the CAM

ESPAÑOLMantenimiento: 
Limpieza y mantenimiento de la CAM

Después de utilizar la CAM
✤ Para una conservación correcta de la CAM, siga estos pasos.
� Apague la CAM.
� Retire la batería (consulte la página 20).
� Retire el Memory Stick (consulte la página 34).
✤ Para evitar daños en la pantalla LCD, no aplique fuerza excesiva en sus

partes móviles.

✤ No deje caer ni golpee la CAM.

✤ Para el uso prolongado de la CAM, evite utilizar lugares expuestos a una
humedad excesiva o al polvo.

✤ No deje la CAM en lugares expuestos a:
� Humedad, vapor, hollín o polvo excesivos.
� Descarga o vibración excesivas.
� Temperaturas extremadamente altas (por encima de 50°C o 122°F) o

extremadamente bajas (por debajo de 0°C o 32°F).
� Campos electromagnéticos potentes.
� Luz solar directa o en vehículos cerrados en días calurosos.
✤ Para el uso seguro de la batería, siga estas recomendaciones.
� Para conservar la alimentación de la batería, asegúrese de apagar la CAM

cuando no se utilice.
� El consumo de la batería puede variar dependiendo de las condiciones de uso.

Las grabaciones con muchas interrupciones, uso frecuente del zoom y con
temperaturas bajas acortarán los tiempos de grabación normales.

� Deshágase de las baterías utilizadas cuanto antes. No las arroje al fuego.
� La batería puede calentarse durante su recarga y uso. Este hecho es normal y no

se trata de ningún defecto.
� La batería tiene una vida de servicio limitada. Si el tiempo de uso se va

reduciendo de forma notoria con una carga normal, es indicio de que la batería
está llegando al final de su vida de servicio. Sustitúyala por una nueva batería.

✤ Para el uso seguro del Memory Stick y del Memory Stick Pro, siga estas
recomendaciones.

� El Memory Stick debe mantenerse lejos de calefactores y otros generadores de
calor. Evite dejar los Memory Stick bajo la luz directa del sol y evite campos
electromagnéticos.

� No apague ningún dispositivo mientras transfiere datos, ya que podría destruirlos.
� Haga una copia de las imágenes en un disco duro o en otro soporte de

almacenamiento permanente.
� Formatee el Memory Stick periódicamente.
� Cuando formatee el Memory Stick o el Memory Stick Pro, hágalo en la CAM. 

Si formatea en la PC, utilice el ‘Memory Stick Formatter’ en el CD de software que
se suministra.
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ENGLISH Maintenance : 
Cleaning and Maintaining the CAM

Cleaning the Body
✤ To Clean the Exterior of the CAM
� To clean the exterior, use a soft dry cloth. Wipe the body gently. 

Do not apply excessive force when cleaning, gently rub the
surface.

� The LCD monitor surface should not be pressed. Use a soft dry
cloth to clean the surface.

� To clean the lens, use an optional air blower to blow out dirt and
other small objects. Do not wipe the lens with cloth or your fingers.
If necessary, use lens cleaning paper.

� Do not use thinner, alcohol or benzene for cleaning. Otherwise, the
finish may be damaged.

� Cleaning should be done only after the battery pack has been
removed, and other power sources have been disconnected.

Using the Built-in Rechargeable Battery
The CAM incorporates a rechargeable lithium cell that maintains the
date and other settings even when the AC adaptor and the battery
are removed. The rechargeable lithium cell is automatically
recharged when the CAM is used. 

✤ If The CAM is not used at all, the cell runs down in 5 days. In this
case, connect the AC adaptor to the CAM and turn on the power
switch. Then leave it for 24 hours. 
After that, set the date and other settings again. 

Charging the Built-in Rechargeable Battery

ENGLISHESPAÑOLMantenimiento: 
Limpieza y mantenimiento de la CAM

Limpieza de la carcasa
✤ Limpieza exterior de la CAM
� Para limpiar el exterior, utilice un paño seco suave. Limpie la

carcasa con suavidad.
No aplique fuerza excesiva al limpiar, frote con suavidad la
superficie.

� No debe presionarse la superficie de la pantalla LCD. Utilice un
paño seco suave para limpiar la superficie.

� Para limpiar el objetivo, utilice un ventilador opcional para eliminar
la suciedad y otros objetos pequeños. No limpie el objetivo con un
paño ni con los dedos. Si es necesario, utilice papel para limpieza
de objetivos.

� No utilice disolventes, alcohol ni benceno para la limpieza. 
Si lo hace, podría dañar el acabado.

� La limpieza sólo debe hacerse tras retirar la batería y desconectar
las fuentes de alimentación.

Utilización de la batería recargable incorporada
La CAM incorpora una pila de litio recargable que mantiene la fecha
y otros ajustes incluso cuando el adaptador de CA y la batería no
están conectados. La pila de litio recargable se carga
automáticamente al utilizar la CAM.

✤ Si deja de utilizarse la CAM, la pila se agota después de 5 días.
En este caso, conecte el adaptador de CA a la CAM y encienda el
interruptor de encendido. Luego, déjelo cargar por 24 horas.
Después de hacerlo, fije de nuevo la fecha y otros ajustes.

Carga de la batería recargable incorporada
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ESPAÑOLESPAÑOLENGLISH Maintenance : 
Cleaning and Maintaining the CAM

Mantenimiento: 
Limpieza y mantenimiento de la CAM

Regarding the Battery
� Battery pack performance decreases when the surrounding temperature is

10°C (50°F) or below, and the battery life becomes shorter. In that case, do
one of the following so that the durability of the battery life can be extended
for a longer period of time.
- Put the battery pack in a pocket to warm it up, and insert it in your Sports

Camcorder immediately prior to use.
- Use a large capacity battery pack (Optional).

� Be sure to set the switch to OFF when not recording or playing back. 
The battery power is also consumed in standby mode and play back pause.

� Have your battery packs ready for two or three times the expected recording
time, and make trial recordings before make the actual recording.

� Do not expose the battery pack to water. The battery pack is not water
resistant.

� Keep the battery out of reach of children. If it is swallowed, seek medical
assistance immediately. 

� Wipe the battery with a clean dry cloth to ensure proper contact.

� Do not pick up the battery using metal tools as this may cause a short circuit.

� Do not short the battery or dispose of the battery in fire. 
Do not disassemble the battery. The battery could explode or catch fire.

� Use only recommended batteries and accessories. Use of batteries not
expressly recommended for this equipment may cause an explosion or
leakage, resulting in fire, injury or damage to the surroundings.

� Install the battery according to the instructions. Improperly installed batteries
can cause damage to the camcorder.

� When you do not use for a long time, remove the battery pack and batteries.
Otherwise, the battery may leak. To avoid damage to the product, be sure to
remove the battery when no charge remains.

� Remove the batteries from the external lens during extended periods of 
non-use. To prevent damage to the remote lens, immediately remove spent
or expired batteries from the external lens as they may breakdown or leak.

� Change the batteries if the lamp of external camera doesn't turn on or blinks
when you powered.

� Never use new batteries together with batteries that have been used in other
devices.

Información sobre la batería
� El rendimiento de la batería desciende cuando la temperatura ambiente sea

igual o inferior a los 10°C (50°F), y acorta la vida de la batería. En ese caso,
lleve a cabo una de las acciones que se incluyen a continuación con el fin
de alargar la vida útil de la batería.
- Coloque la batería en el bolsillo para calentarla e insértela

inmediatamente en la videocámara deportiva antes de utilizarla.
- Utilice una batería de mayor capacidad (Opcional).

� Asegúrese de apagarla cuando no grabe ni reproduzca. La energía de la
batería también se consume en la modalidad Standby y en pausa.

� Tenga baterías preparadas para el doble o el triple del tiempo de grabación
esperado y realice pruebas de grabación antes de hacer la grabación real.

� No exponga la batería al agua.
La batería no es resistente al agua.

� Mantenga la batería fuera del alcance de los niños. Si se traga, busque
asistencia médica inmediatamente.

� Limpie la batería con un paño seco limpio para un contacto correcto.
� No sujete la batería con herramientas metálicas ya que podría causar

cortocircuitos.
� No provoque cortocircuitos ni tire la batería al fuego.

No desmonte la batería. La batería podría explotar o incendiarse.
� Utilice únicamente las baterías y accesorios recomendados.

El uso de baterías no expresamente recomendadas para este equipo podría
causar explosión o fugas, incendiándose o provocando daños físicos o
personales alrededor.

� Instale la batería según las instrucciones.
Las baterías incorrectamente instaladas pueden causar daños en la
videocámara.

� Cuando no se utilice durante mucho tiempo, quite la batería y las pilas.
De lo contrario, la batería podría sufrir fugas. Para evitar daños en el
producto, asegúrese de quitar la batería cuando no le quede ninguna carga.

� Retire las pilas del objetivo externo durante períodos prolongados de
inactividad. Para evitar daños en el objetivo remoto, retire inmediatamente
las pilas agotadas o gastadas del objetivo externo ya que podría romperse o
sufrir fugas.

� Cambie las pilas si la lámpara de la cámara externa no se enciende o
parpadea al encenderse.

� Nunca utilice pilas nuevas junto con pilas utilizadas en otros dispositivos.

126126
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Maintenance : 
Cleaning and Maintaining the CAM

Using the CAM Abroad
✤ Each country or region has its own electric and color systems.
✤ Before using the CAM abroad, check the following items:

✤ You can use the CAM in any country or area with the supplied AC
Power Adapter where the power input range is 
100V ~ 240V, 50/60Hz.

✤ Use a commercially available AC plug adapter if necessary,
depending on the design of the local wall outlets.

Power Sources

✤ You can view your video files using the built-in LCD monitor.
However, to view your recordings on a television set or to copy it to
a video cassette recorder (VCR), the television set or the VCR
must comply with NTSC-compatible and have the appropriate
Audio / Video ports. Otherwise, you may need to use a separate
Video Format Transcoder (NTSC-PAL format Converter).

Color System

PAL-Compatible Countries / Regions
Australia, Austria, Belgium, Bulgaria, China, CIS, Czech Republic,
Denmark, Egypt, Finland, France, Germany, Greece, Great Britain,
Holland, Hong Kong, Hungary, India, Iran, Iraq, Kuwait, Libya,
Malaysia, Mauritius, Norway, Romania, Saudi Arabia, Singapore,
Slovak Republic, Spain, Sweden, Switzerland, Syria, Thailand,
Tunisia, etc.

NTSC-Compatible Countries / Regions
Bahamas, Canada, Central America, Japan, Mexico, Philippines,
Korea, Taiwan, United States of America, etc.

ESPAÑOLMantenimiento: 
Limpieza y mantenimiento de la CAM

Utilización de la CAM en el extranjero
✤ Los sistemas de electricidad y de color pueden variar de un país a otro.
✤ Antes de usar la CAM en el extranjero, compruebe lo siguiente:

✤ Esta CAM se puede utilizar en cualquier país o región con el
adaptador de CA que se suministra con ella, siempre que el rango
de entrada de corriente sea de 100V a 240V, 50/60 Hz.

✤ Si es necesario, utilice una clavija adaptadora de CA, dependiendo
del tipo de enchufe del lugar.

Fuentes de alimentación

✤ Puede ver sus archivos de video utilizando la pantalla LCD
incorporada.
Sin embargo, para ver las grabaciones en un televisor o para
copiar en una videocasetera, el televisor o la videocasetera deben
ser compatibles con NTSC y tener los puertos de Audio/Video
apropiados. De no ser así, posiblemente necesitará un adaptador
de formato de video (conversor de formato NTSC-PAL).

Sistema de color

Países/regiones con sistemas de color compatibles con PAL:
Alemania, Arabia Saudita, Australia, Austria, Bélgica, Bulgaria, CEI,
China, Dinamarca, Egipto, España, Finlandia, Francia, Gran
Bretaña, Grecia, Holanda, Hong Kong, Hungría, India, Irak, Irán,
Kuwait, Libia, Malasia, Mauricio, Noruega, República Checa,
República de Eslovaquia, Rumania, Singapur, Siria, Suecia, Suiza,
Tailandia, Túnez, etc.

Países/regiones con sistemas de color compatibles con NTSC:
América Central, Bahamas, Canadá, Corea, Estados Unidos,
Filipinas, Japón, México, Taiwán, etc.

ENGLISH
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La alimentación no se ha conectado
correctamente.
La batería está muerta.
La batería está demasiado fría.
No se ha fijado <Date/Time>(FECHA/HORA).

El enfoque se ha colocado en modalidad manual.
La grabación se ha realizado en un lugar oscuro.
El objetivo se ha cubierto con condensación.

El Memory Stick está en una posición incorrecta.
Algo se ha atrancado en el Memory Stick.

Síntoma Posibles causas Medida

Conecte correctamente el adaptador de CA, página 24
Sustituya la batería muerta.
Caliente la batería o trasládese a un lugar más cálido.

Defina <Date/Time> (FECHA/HORA), páginas 90 y 91

Coloque el enfoque en AUTO.
Utilice un lugar estroboscópico o iluminado.
Limpie el objetivo y compruebe el enfoque.

Inserte el Memory Stick correctamente, página 34.
Despeje la ranura del Memory Stick.

No se suministra
alimentación.

La fecha y la hora son
erróneos.

El enfoque no se ajusta
automáticamente.

El Memory Stick no se
cargará correctamente.

ENGLISH

Troubleshooting

Self Diagnosis Display

ENGLISHESPAÑOL

✤ If these instructions do not solve your problem, contact your nearest Samsung dealer or
authorized service centre/personnel.

The power is not connected properly
The battery is dead
The battery is too cold

The Date/Time is not set

Focus is set to manual mode
Recording was done in a dark place
Lens is covered with condensation

Memory stick is in wrong position
Something is stuck in the Memory Stick slot

Symptom Possible Causes Measure

Connect the AC adapter properly, page 24
Replace the dead battery pack 
Warm up the battery or move to warmer place

Set the Date/Time, pages 90~91

Set focus to AUTO 
Use strobe or lit the place
Clear the lens and check the focus 

Insert the Memory Stick properly, page 34
Clear the Memory Stick slot

Not enough free space for
saving files
The file is corrupted
The paper is insufficient.

The paper is caught in the
printer.
Ink is low.
The file is wrong.
The error is occurred while
transferring data.
Battery is low.

The hold key is locked.
The memory card is
corrupted.
Format the memory card.
Failed to write.

Failed to read.
The format is not supported.

Memory Stick is protected to
write.
The video file is corrupted.

Not enough free
space
Corrupted file
Paper error

Printer error

Ink error
Wrong error
USB transfer
error
Low battery

Holding the key
Card error

Not formatted
Write error

Read error
Not supported
format
Write protected

MPEG decoding
error

Check the space of internal memory or the
Memory Stick.
Delete the corrupted file.
Check the paper in the printer. 
If there is no paper, insert the paper.
Check that paper is caught in the printer.
Pull out the caught paper.
Check if the ink or toner is low.
Check that the file is JPEG.
Disconnect the USB cable and connect it
again.
Charge the battery pack or connect the AC
Adapter.
Unlock the hold key and operate the CAM.
Format the Memory Stick or replace it with
new one.
Format the Memory Stick.
Check the memory space or format the
memory.
Delete the file.
The AVI or JPEG file that is not supported.
Check the supported file on the page 30.  
Unlock the Memory Stick.

Delete the corrupted file.

Informs that… ActionDisplay

No power is supplied

Date/Time is wrong

Focus does not adjust
automatically

The Memory Stick will
not load properly

No hay espacio suficiente
para guardar archivos.

El archivo está dañado.

Papel insuficiente.

Papel atascado en la
impresora.
Tinta baja.
El archivo es erróneo.

El error se produce al
transferir datos.

Batería baja.

Tecla Hold bloqueada.
La tarjeta de memoria está
dañada.
La tarjeta de memoria
necesita formatearse.
Fallo al escribir.

Fallo al leer.

Formato no admitido.

El Memory Stick está
protegido contra escritura.
El archivo de video está
dañado.

Not enough free
space
Corrupted file

Paper error

Printer error

Ink error
Wrong error
USB transfer
error
Low battery

Holding the key
Card error

Not formatted

Write error

Read error
Not supported
format
Write protected

MPEG decoding
error

Compruebe el espacio de la memoria interna o
del Memory Stick.

Borre el archivo dañado.
Compruebe el papel en la impresora. Si no hay 
papel, inserte papel.
Compruebe si el papel se ha atascado en la
impresora. Retire el papel atascado.
Compruebe si la tinta o el tóner están bajos.
Compruebe que el archivo sea JPEG.

Desconecte el cable USB y conéctelo de nuevo.

Cargue la batería o conecte el adaptador de CA.

Desbloquee la tecla Hold y utilice la CAM.
Formatee el Memory Stick o cámbielo por uno
nuevo.

Formatee el Memory Stick.

Compruebe el espacio en memoria o formatee la
memoria
Borre el archivo.
No se admite el archivo AVI o JPEG. Compruebe
los archivos admitidos en la página 30.

Desbloquee el Memory Stick.

Borre el archivo dañado.

Indica que... SoluciónDisplay

Solución de problemas

Pantalla de autodiagnósticos

✤ Si las siguientes instrucciones no le permiten solucionar el problema, póngase en
contacto con el distribuidor más cercano o con el centro de servicio técnico o personal
autorizado de Samsung.
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Troubleshooting

White balance adjustment is required

Digital special effect is applied

Memory Stick is protected
File is locked

Ambient is too bright
Ambient temperature is too low

Prolonged use of LCD monitor

The Photo Mode is selected

The Video Mode is selected

Not enough free memory space is
remained
Memory card is formatted by different
devices

Light is forced to cancel
Light is not available for recording

The ‘Photo Mode’ is selected

To save power consumption, the LCD
screen and Camera s power turns off
if there is no button operation for a
certain period of time (depending on
operation mode), which is not a
malfunctioning

Battery is exhausted

Symptom Possible Causes Measure

Set proper white balance, page 67

Turn off the digital special effects, page 54

Remove the protection tab of Memory Stick
Remove the lock on the file, page 84

Adjust the brightness and angle of LCD 
Low temperatures might produce a dark
LCD display
This is not a malfunction

Close the LCD monitor to turn if off, 
or turn your device off to cool down

Select ‘Video Mode’ and select ‘Play’

Select ‘Photo Mode’ and select ‘View’

Delete files from the Memory Stick 
Format the Memory Stick on the CAM

Select different Light mode, page 64

Select ‘Video Mode’

Operating any button will turn the camera
on
Pressing the button once again will
operate its function

Battery Replacement

Color balance of
picture is not natural

Digital zoom does not
work

Files stored in the
Memory Stick cannot
be deleted

Images on the LCD
monitor appear dark

Rear of the LCD
monitor is hot

Play, rewind and fast
forwarding do not
work

Memory Stick cannot 
be played back 
(Photo mode)

No picture is taken
when is fully pressed

Built-in Light will not
come on

Cannot Record a
video

LCD screen turns off

External Camera
Module does not
operate

Solución de problemas

Hay que realizar el ajuste de balance
de blanco.

Se aplica el efecto especial digital. 

El Memory Stick está protegido.
Archivo bloqueado.

El ambiente es demasiado brillante.
La temperatura ambiental es
demasiado baja.

Uso prolongado de la pantalla LCD.

Se ha seleccionado <Photo Mode>
(Modalidad Foto).

Se ha seleccionado <Video Mode>
(Modalidad Video).

No queda suficiente espacio
disponible en la memoria.
La tarjeta de memoria se ha
formateado en dispositivos diferentes.

La luz se ha bloqueado para que no
funcione.
La luz no está disponible para grabar.

Se ha seleccionado Photo Mode
<Modalidad Foto>.

Para reducir el consumo de energía,
la pantalla LCD y la cámara se
apagan si no se utiliza ningún botón
durante cierto tiempo (depende de la
modalidad de funcionamiento), y esto
no representa ninguna avería.

La batería está agotada.

Síntoma Posibles causas Medida

Defina el balance de blanco correcto,
página 67.

Desactive los efectos especiales digitales,
página 54.

Retire la pestaña de protección del

Memory Stick. Desactive el bloqueo del

archivo, página 84.

Ajuste el brillo y el ángulo de la pantalla LCD.
Las bajas temperaturas pueden oscurecer
la pantalla LCD.
Este hecho es normal y no se trata de
ningún defecto.
Cierre la pantalla LCD para apagarla, 
o apague el dispositivo para enfriarla.

Seleccione <Video Mode> (Modalidad
Video) y seleccione <Play> (Reproducir).

Seleccione <Photo Mode> (Modalidad
Foto) y seleccione <View> (Ver).

Borre archivos del Memory Stick.
Formatee el Memory Stick en la CAM

Seleccione una modalidad diferente de
luz, página 64.

Seleccione ‘Video Mode <Modalidad
Video>’

El accionamiento de cualquier botón
encenderá la cámara. Si se pulsa de
nuevo el botón, su función estará
operativa.

Cambio de batería.

El balance de color
de la imagen no es
natural.
El zoom digital no
funciona.
Los archivos
almacenados en el
Memory Stick no se
pueden borrar.
Las imágenes de la
pantalla LCD
aparecen oscuras.

La parte posterior de
la pantalla LCD está
caliente.
Reproducir, rebobinar
y avance rápido no
funciona.
El Memory Stick no
se puede reproducir
(Modalidad Foto)
No se captura 
ninguna imagen al
presionar totalmente.

La luz incorporada no
se enciende.

No se puede grabar
el video.

Se apaga la pantalla
LCD

El módulo de cámara
externa no está
operativo
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Using the Menu
ENGLISHESPAÑOL

Video

5. Back

1. Play 
Options

Repeat

Back

All
Off
One

2. File Options

3. Back

Program AE

Auto
Sports
Spotlight
Sand/Snow
HS Shutter

Effect

Off
Art
Mosaic
Sepia
Negative
Mirror
B&W
Emboss

BLC
Off
On

Digital Zoom

Back

Off
On

5. Back

Program AE

Auto
Sports
Spotlight
Sand/Snow
HS Shutter

BLC

Off
On

Back

Photo MP3

Delete

Selected
All
Cancel

Lock

Selected
All
Cancel

Copy To

Selected
All
Cancel

Back

White Balance

Auto
Hold
Outdoor
Indoor

1. Record

2. Video In

3. Play

4. File Options

Delete

Selected
All
Cancel

Lock

Selected
All
Cancel

Copy To

Selected
All
Cancel

PB Option

Selected
All
Cancel

5. Settings

Size

720
352

Quality

Super Fine
Fine
Normal

Focus

AF
MF

EIS

On
Off

Back

White Balance
Auto
Hold
Outdoor
Indoor

1. Capture

2. View

3. File Options

Lock
Selected
All
Cancel

Copy To
Selected
All
Cancel

DPOF

Back

4. Settings

Size
800✕600
640✕480

Light
Auto
On
Off

Focus

AF
MF

EIS

On
Off

Delete

Selected
All
Cancel

External
Camera
Normal

Video

5. Back

1. Play 
Options

Repeat

Back

All
Off
One

2. File Options

3. Back

Program AE

Auto
Sports
Spotlight
Sand/Snow
HS Shutter

Effect

Off
Art
Mosaic
Sepia
Negative
Mirror
B&W
Emboss

BLC
Off
On

Digital Zoom

Back

Off
On

5. Back

Program AE

Auto
Sports
Spotlight
Sand/Snow
HS Shutter

BLC

Off
On

Back

Photo MP3

Delete

Selected
All
Cancel

Lock

Selected
All
Cancel

Copy To

Selected
All
Cancel

Back

White Balance

Auto
Hold
Outdoor
Indoor

1. Record

2. Video In

3. Play

4. File Options

Delete

Selected
All
Cancel

Lock

Selected
All
Cancel

Copy To

Selected
All
Cancel

PB Option

Selected
All
Cancel

5. Settings

Size

720
352

Quality

Super Fine
Fine
Normal

Focus

AF
MF

EIS

On
Off

Back

White Balance
Auto
Hold
Outdoor
Indoor

1. Capture

2. View

3. File Options

Lock
Selected
All
Cancel

Copy To
Selected
All
Cancel

DPOF

Back

4. Settings

Size
800✕600
640✕480

Light
Auto
On
Off

Focus

AF
MF

EIS

On
Off

Delete

Selected
All
Cancel

External
Camera
Normal

Uso de menús
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Using the Menu

1. Record

2. Play

3. File Options

Delete

Selected
All
Cancel

Lock

Selected
All
Cancel

Copy To

Selected
All
Cancel

Back

4. Back

1. Delete

Selected

All
Cancel

2. Lock

Selected

All

Cancel

3. Copy To

Selected

All

Cancel

4. File Info

Close

5. Back

Voice 
Recorder

File 
Browser

System 
Settings

USB
Mode

1. Display

...

LCD
Brightness

0%

100%

...

LCD Colour

Back

2. Date/Time

Set Time

Set Date

Date Format

Back

YY/MM/DD
DD/MM/YY
MM/DD/YY

Time Format

12 Hour
24 Hour

3. System

Auto Shut
off

Version Info

Back

Off
5 Minutes

Demo

Off
5 Minutes
Play Now

Start-up

Video Mode
Previous
Mode

File No.

Series
Reset

Beep Sound

On
Off

0%

100%

...

1. Record

2. Play

3. File Options

Delete

Selected
All
Cancel

Lock

Selected
All
Cancel

Copy To

Selected
All
Cancel

Back

4. Back

1. Delete

Selected

All
Cancel

2. Lock

Selected

All

Cancel

3. Copy To

Selected

All

Cancel

4. File Info

Close

5. Back

Voice 
Recorder

File 
Browser

System 
Settings

USB
Mode

1. Display

...

LCD
Brightness

0%

100%

...

LCD Colour

Back

2. Date/Time

Set Time

Set Date

Date Format

Back

YY/MM/DD
DD/MM/YY
MM/DD/YY

Time Format

12 Hour
24 Hour

3. System

Auto Shut
off

Version Info

Back

Off
5 Minutes

Demo

Off
5 Minutes
Play Now

Start-up

Video Mode
Previous
Mode

File No.

Series
Reset

Beep Sound

On
Off

0%

100%

...

Uso de menús

Close Close

4. Memory

5. Back

Storage Type

Internal
External

Format

Internal
External

000MB/000MB

Back

Memory Space

4. Memory

5. Back

Storage Type

Internal
External

Format

Internal
External

000MB/000MB

Back

Memory Space

1. USB 2.0
MassStorage

2. USB 1.1
MassStorage

3. PC-Cam

4. PictBridge
Date/Copies/
Print
Next Photo/
Previous Photo/
Back

1. USB 2.0
MassStorage

2. USB 1.1
MassStorage

3. PC-Cam

4. PictBridge
Date/Copies/
Print
Next Photo/
Previous Photo/
Back
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Specifications
ENGLISHESPAÑOL

Model Name

the CAM System

Video Recording System

Photo System

MP3

Voice

Memory

Recording/Playing time

CCD Pixel

Zoom Ratio

Focal Length

Minimum Illumination

LCD Monitor

Cradle Connectors

USB

The CAM Connector

AV Input/Output

DC Power In Connector

General

Operating Temperature

Operating Humidity

Power Source

Power Consumption

Dimension(WxHxD)

Weight

Built-in Microphone

SC-X105L/X110L

MPEG4 AVI Format

JPEG (DPOF, Exif 2.2)

Stereo Playing

WAVE file record/play (8KHz Sampling, 16 bit, Stereo)

Internal memory - 512MB (SC-X105L) / 1GB (SC-X110L)

Memory Stick

Memory Stick Pro

Refer to page 31

1/6 inch CCD, 680K(Maximum)

x10(Optical), x100(Digital)

f=2.4~24mm, F1.8~2.4

3.0 Lux

2.0” Trans Reflective, 210K

Mini-B type (USB 2.0 High Speed)

Special 22Pin Connector

Video (1.0Vp_p), Audio (-7.5dBm 47KΩ, Input:mono/Output:stereo)

Special 22Pin Connector

0°C~40°C (32°F~104°F)

10%~80%

3.8V (Li-Polymer Battery pack), 4.8V (AC Adapter)

3.0W (LCD ON)

2.32˝x 3.65˝ x 1.04˝

0.3307lb (Including the Lithium Polymer Battery Pack)

Omni-directional Stereo condenser microphone

Nombre del modelo

Sistema de CAM

Sistema de grabación de video

Sistema fotográfico

MP3

Voz

Memoria

Tiempo de grabación/reproducción

Píxeles de CCD

Índice de Zoom

Longitud focal

Iluminación mínima

Pantalla LCD

Conectores de soporte

USB

Conector de CAM

Entrada/Salida CA

Conector de entrada de CC

Generales

Temperatura de funcionamiento

Humedad en funcionamiento

Fuente de alimentación

Consumo eléctrico

Dimensiones (An. x Al. x P.)

Peso

Micrófono incorporado

SC-X105L/X110L

Formato MPEG4 AVI

JPEG (DPOF, Exif 2.2)

Reproducción en estéreo

Grabación/reproducción de archivos WAVE (Muestreo a 8 KHz, 16 bits, Estéreo)

memoria interna - 512MB (SC-X105L) / 1GB (SC-X110L)

Memory Stick

Memory Stick Pro

Consulte la página 31.

CCD de 1/6 pulg., 680 K (Máximo)

x10 (Óptico), x100 (Digital)

f=2.4~24mm, F1.8~2.4

3.0 Lux

2,0 pulg. Trans Reflective, 210 K

Tipo Mini-B (USB 2.0 Alta velocidad)

Conector especial de 22 patillas

Video (1,0 Vp_p), Audio (-7,5 dBm 47 KΩ, 

Entrada: mono / Salida: estéreo)

Conector especial de 22 patillas

0°C~40°C (32°F~104°F)

10%~80%

3,8 V (Batería de polímero de litio), 4,8 V (Adaptador de CA)

3,0 W (LCD ENC.)

58,8mm x 92,7mm x 26,3mm

150 g. (Incluida la batería de polímero de litio)

Micrófono estéreo omnidireccional de condensador

Especificaciones técnicas
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Specifications
Model Name SC-X105L/X110L

The CAM Connectors

Common connector

Cradle Connector

DC Power In Connector

AC Adapter

Power Requirement

DC Output

Dimensions

Weight

ø 3.5 Stereo 

Video (1.0p_p, 75   ), Audio (-7.5dBm 47K   , Stereo)

Special 22Pin Connector

Special 22Pin Connector

AC 100~240V, 50/60Hz

DC 4.8V, 1.0A

2.76˝ x 1.18˝ x 1.65˝

0.18lb (Including DC cable)

Earphone

AV input/output

•  These technical specifications and design may be changed without notice.

XC-L1N (External Camera Module)

1/4 inch CMOS, 320K(Maximum)

640x480 (VGA)

Auto

Auto

Fixed

f=4.0mm, F2.6

Video (1.0Vp_p), Audio (-7.5dBm 47K   , Mono)

0°C~40°C (32°F~104°F)

20%~80%

1.5V x 2 (Alkaline AAA Battery)

0.9W

3.36˝x 1.08˝ x 1.06˝

0.2317lb (Without the Alkaline AAA Battery)

Omni-directional condenser microphone

Alkaline Battery : Maximum 60minutes

Nikel Hydrogen Rechargeable Battery : 
Maximum 100 minutes (not included)

Model Name

the External CMOS Camera

CMOS Pixel

Video Resolution

Exposure

White Balance

Focus Type

Focal Length

Connector

AV Output

General

Operating Temperature

Operating Humidity

Power Source

Power Consumption

Dimension(LxHxD)

Weight

Built-in Microphone

Battery Using Time

Nombre del modelo SC-X105L/X110L

Conectores de la CAM

Conector común

Conector de soporte

Conector de entrada de CC

Adaptador de CA

Requisitos de alimentación

Salida de CC

Dimensiones

Peso

ø 3,5 Estéreo

Video (1,0p_p, 75Ω), Audio (-7,5 dBm 47 KΩ, Estereo)

Conector especial de 22 patillas

Conector especial de 22 patillas

100~240 V de CA, 50/60 Hz

4,8 V de CA, 1,0 A

70mm x30mm x 42mm

80 g (Incluido el cable de CC)

Audífono

Entrada/Salida CA

XC- L1N (Módulo de cámara externa)

CMOS de 1/4 pulg., 320 K (Máximo)

640x480 (VGA)

Auto

Auto

Fijado

f=4.0mm, F2.6

Video (1,0 Vp_p), Audio (-7,5 dBm 47 K, Mono)

0°~40°C (32°F~104°F)

20%~80%

1.5V x 2 (Baterías alcalinas tamaño AAA)

0.9W

85mmx 27mm x 26mm

105g (Sin baterías alcalinas AAA)

Micrófono omnidireccional de condensador

Baterías alcalinas: 60 minutos máximo

Baterías recargables de hidrógeno-níquel: 
100 minutos máximo (no incluido).

Nombre del modelo

la cámara CMOS externa

Píxel CMOS

Resolución de video

Exposición

Balance de blanco

Tipo de enfoque

Longitud focal

Conector

Salida AV

Generales

Temperatura de funcionamiento

Humedad en funcionamiento

Fuente de alimentación

Consumo eléctrico

Dimensiones (L X AL X AN)

Peso

Micrófono incorporado

Tiempo de batería

Especificaciones técnicas

•  Estas especificaciones técnicas y el diseño están sujetos a cambios sin 
previo aviso.
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Index
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- A -

AF .....................................48, 65
Auto Shut off ...........................94

- B -

Beep Sound ............................98
BLC...................................52, 69

- C -

Capturing ................................56
Cleaning and Maintaining the
CAM ......................................124

- D -

Date.........................................91 
Demo.......................................95
Digital Zoom............................54
Display button .........................28
DPOF..............................61, 123

- E -

Effect ......................................53
EIS ....................................49, 66
External Camera 
Module ..........................108~110

- F -

File Browser............................83
Focus ................................48, 65
Format...................................101
Function button .......................27

- I -

Image Mixer ..........................117

- L -

LCD Brightness.......................88
LCD Color ...............................89
Light ........................................64
Lithium Polymer 
Battery pack............................13

- M -

Memory Space .....................102
Memory Stick ..........................34
Memory type ...........................33
Menu button............................14
MF.....................................48, 65

Índice alfabético
- A -

AF ....................................48, 65
Auto Shut off (Apagado
automático) ............................94

- B -
Beep Sound 
(Sonido de pitido) ..................98
BLC ..................................52, 69

- C -
Capturing (Captura) ..............56
Cleaning and Maintaining the
CAM (Limpieza y mantenimiento 
de la CAM) ..........................124

- D -
Date (Fecha) ..........................91 
Demo......................................95
Digital Zoom (Zoom Digital) ..54
Display button 
(Botón Display) ......................28
DPOF ............................61, 123

- E -
Effect (Efecto) ........................53
EIS....................................49, 66
Módulo externo de 
cámara .........................108~110

- F -
File Browser (Explorador de 
archivos) ................................83
Focus (Enfoque) ..............48, 65
Format (Formato) ................101
Function button (Botón de
funciones) ..............................27

- I -
Image Mixer..........................117

- L -
LCD Brightness 
(Brillo de LCD)........................88
LCD Colour (Color de LCD) ..89
Light (Luz)  ............................64
Lithium Polymer Battery pack
(Batería de polímero 
de litio) ....................................13

- M -
Memory Space (Espacio en
memoria) ..............................102
Memory Stick ........................34
Memory type 
(Tipo de memoria)..................33
Menu button (Botón Menu) ....14
MF ....................................48, 65
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Index
- O -

OSD.........................................17

- P -

PB Option................................45
PictBridge..............................122
Power switch...........................14
Program AE ......................51, 68

- R -

Repeat Play ............................74

- S -

Start-up Mode .........................96
Storage type..........................100

- T -

Time ........................................90
Troubleshooting ....................128

- U -

USB Cable ..............................13
USB mode.............................103

- Y -

Version Information.................99

- W -

White Balance...................50, 67

- Z -

Zooming In and Out..........38, 57

Índice alfabético
- O -

OSD ......................................17

- P -
PB Option (Opción PB) ........45
PictBridge ............................122
Power switch (Interruptor de 
encendido) ............................14
Programa AE ..................51, 68

- R -
Repeat Play (Cómo repetir la 
reproducción) ........................74

- S -
Start-up Mode (Modalidad de
inicio)......................................96
Storage type (Tipo de 
almacenamiento) ................100

- T -
Time (Tiempo) ......................90
Troubleshooting (Solución de 
problemas) ..........................128

- U -
USB Cable (Cable USB) ......13
USB mode 
(Modalidad USB) ................103

- Y -
Version Information (Información
de versión) ............................99

- W -
White Balance (Balance de
blanco) ............................50, 67

- Z -
Zooming In and Out
(Acercamiento y alejamiento de
las imágenes) ..................38, 57
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THE CAMCORDER IS MANUFACTURED BY:

*Samsung Electronics’ Internet Home Page

United States http://www.samsungusa.com
United Kingdom http://www.samsungelectronics.co.uk
France http://www.samsung.fr
Australia http://www.samsung.com/au
Germany http://www.samsung.de
Sweden http://www.samsung.se
Poland http://www.samsung.com/pl
Canada http://www.samsungcanada.com
Panama http://www.samsung-panama.com
Italia http://www.samsung.it
Spain http://www.samsung.es

ELECTRONICS ELECTRONICS

VIDEOCÁMARA FABRICADA POR:

*Página Web en Internet de Samsung Electronics

United States http://www.samsungusa.com
United Kingdom http://www.samsungelectronics.co.uk
France http://www.samsung.fr
Australia http://www.samsung.com/au
Germany http://www.samsung.de
Sweden http://www.samsung.se
Poland http://www.samsung.com/pl
Canada http://www.samsungcanada.com
Panama http://www.samsung-panama.com
Italia http://www.samsung.it
Spain http://www.samsung.es
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